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Chapter 1

1Introduction

StorNext is data management software that enables customers to 
complete projects faster and confidently store more data at a lower cost. 
Used in the world's most demanding environments, StorNext is the 
standard for high performance shared workflow operations and multitier 
archives. StorNext consists of two components: StorNext File System 
(SNFS), a high performance data sharing software, and StorNext Storage 
Manager (SNSM), the intelligent, policy-based data mover.

About StorNext File 
System 1

StorNext File System streamlines processes and facilitates faster job 
completion by enabling multiple business applications to work from a 
single, consolidated data set. Using SNFS, applications running on 
different operating systems (Windows, Linux, UNIX, HPUX, AIX, and 
Mac OS X) can simultaneously access and modify files on a common, 
high-speed SAN storage pool. This centralized storage solution 
eliminates slow LAN-based file transfers between workstations and 
dramatically reduces delays caused by single-client failures. With SNFS, 
any server can access files and pick up processing requirements of a 
failed system to continue operations.

About StorNext Storage 
Manager 1

StorNext Storage Manager enhances the StorNext solution by reducing 
the cost of long term data retention, without sacrificing accessibility. 
SNSM sits on top of SNFS and utilizes intelligent data movers to 
transparently locate data on multiple tiers of storage. This enables 
customers to store more files at a lower cost, without having to 
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Chapter 1  Introduction
reconfigure applications to retrieve data from disparate locations. 
Instead, applications continue to access files normally and SNSM 
automatically handles data access – regardless of where the file resides. 
As data movement occurs, SNSM also performs a variety of data 
protection services to guarantee that data is safeguarded both on site and 
off site.

About Distributed LAN 
Clients 1

StorNext supports distributed LAN clients. Unlike a traditional StorNext 
SAN client, a distributed LAN client does not connect directly to 
StorNext via fibre channel or iSCSI, but rather across a LAN through a 
gateway system called a distributed LAN server. The distributed LAN 
server is itself a directly connected StorNext client, but it processes 
requests from distributed LAN clients in addition to running 
applications. Any number of distributed LAN clients can connect to 
multiple distributed LAN servers. 

Besides the obvious cost-savings benefit of using distributed LAN clients, 
there will be performance improvements as well. 

Distributed LAN clients must be licensed in the same way as StorNext 
SAN clients. When you request your permanent StorNext license, you 
will need to specify the number of distributed LAN clients you plan to 
use. Naturally, you can always purchase additional distributed LAN 
client licenses as your needs expand. For more information about 
StorNext licensing, see Entering the StorNext License on page 37.

StorNext provides distributed LAN client information via the status 
monitors on the StorNext home page, SNSM home page, and SNFS home 
page. More detailed information is available through the Clients Report 
and the Distributed LAN Client Performance Report. For more 
information about StorNext reports, see StorNext Reports on page 264.

Before you can fully use distributed LAN clients, you must first configure 
a distributed LAN server and distributed LAN clients as described in the 
StorNext Installation Guide.
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Purpose of This Guide
Purpose of This Guide

This guide is intended to assist StorNext users perform day-to-day tasks 
with the software. This guide also describes how to generate reports. 
Quantum recommends using the graphical user interface to accomplish 
tasks, but an appendix provides alternative procedures for users who 
wish to perform those tasks via the command line interface.

How This Guide is Organized

This guide contains the following chapters:

• Chapter 1, Introduction

• Chapter 2, StorNext GUI Overview

• Chapter 3, SNFS-Only GUI Overview

• Chapter 4, Common StorNext Tasks

• Chapter 5, Backing Up StorNext

• Chapter 6, Managing the File System

• Chapter 7, Managing Libraries

• Chapter 8, Managing Drives and Disks

• Chapter 9, Managing Media

• Chapter 10, Managing Storage Disks

• Chapter 11, Data Migration Management

• Chapter 12, StorNext Reports

• Chapter 13, Service Management

• Chapter 14, Customer Assistance

• Appendix A, HA Failover

• Appendix B, Using The Command Line Interface
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• Appendix C, RAS Messages

Notes, Cautions, and Warnings

The following table describes important information about Notes, 
Cautions, and Warnings used throughout this guide.

Description Definition Consequences

Note: Indicates important 
information that helps 
you make better use of 
the software.

No hazardous or 
damaging consequences.

Caution: Advises you to take or 
avoid a specified action.

Failure to take or avoid 
this action could result 
in loss of data.

Warning: Advises you to take or 
avoid a specified action.

Failure to take or avoid 
this action could result 
in physical harm to the 
user or hardware.
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Document Conventions

This guide uses the following document conventions to help you 
recognize different types of information.

Conventions Examples

For all UNIX-based 
commands, the # prompt is 
implied, although it is not 
shown.

TSM_control stop 
is the same as 
# TSM_control stop

For all UNIX-based 
commands, words in italic are 
variables and should be 
replaced with user-defined 
values.

cvaffinity <filename>

where <filename> is a 
variable and should be 
replaced with a user-defined 
value.
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2StorNext GUI Overview

This section describes how to access and navigate through the StorNext 
GUI, which includes both SNFS and SNSM. If you purchased SNFS only, 
refer to SNFS-Only GUI Overview.

This chapter includes the following topics:

• Accessing the StorNext GUI 

• The StorNext Home Page

• The SNFS and SNSM Home Pages

• The Configuration Wizard

Accessing the StorNext GUI

The StorNext GUI is browser-based and can be remotely accessed from 
any machine with access to the StorNext server. 

Note: StorNext supports internationalization for the name space of 
the file system. This support is fully UTF-8 compliant. It is up 
to the individual client to set the proper UTF-8 locale.
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Use this procedure to access the StorNext GUI.

1 Open a Web browser.

2 In the browser’s Address field, type the full address of the machine 
and its port number, and then press Enter. For example: http://
<machine name>:<port number>. Use the name of the machine and 
port number you copied when you installed the StorNext software. 

After you enter the machine name and port number, the following 
window appears:

Figure 1  StorNext Login 
Window

3 In the User ID field, type admin and press TAB.

4 In the Password field, type admin and click OK.

The initial StorNext GUI appears. A message asks you to start non-
running components.

5 Click OK to start the StorNext components. The StorNext GUI 
launches.

Note: StorNext-supported browsers are:
• Internet Explorer 5.5, 6 and 7
• Netscape 7.x
• Mozilla 1.0 and later
• FireFox 1.5 and later or 2.0 and later

To ensure proper browser operation, all monitors must be set to 
display at a minimum resolution of 1073 x 768. If you use a popup 
blocker, be sure to enable pop-ups in order to ensure that the StorNext 
Configuration Wizard functions properly.

Note: Typically, the port number is 81. If port 81 is in use, use the 
next unused port number. (I.e., 82, 83, etc.)
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The following illustration shows the main components of the 
StorNext Home Page.

Figure 2  StorNext Home Page

Component
Navigation

Link to 
Quantum 

Drop-down 
Menu Options

Refresh 
Buttons

Monitor Refresh 
Rate Options

System 
Monitors

Application 
Link

StorNext System Status StorNext Server Status
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The StorNext Home Page

On the home page you will find the following:

• Link to the Quantum Home Page - Click the link for information 
about Quantum

• System Monitors

• StorNext Home Page Drop-Down Menus

• StorNext System Status

• StorNext Server Status

• Home and Help Links

• Application Link

System Monitors 2 The StorNext Home Page displays three system monitors that are used to 
monitor the state of the StorNext system: 

• The File System Monitor

• The Library Monitor

• The Storage Disk Monitor 

Use these monitors to view current statistics of managed or unmanaged 
file systems and configured libraries and/or drives, including file system, 
library, and drive information. 

The File System Monitor and Library Monitor have a Refresh button that 
allows you to manually update (refresh) the information shown in the 
monitor. You can also select a rate from the Refresh Rate list to 
automatically refresh at the selected interval: 

• No Refresh

•  30 seconds

•  1 minute

•  2 minutes

•  5 minutes

• 10 minutes
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The File System Monitor 2

The File System Monitor enables you to view statistics on each configured 
file system. When you open a browser to access StorNext, the File System 
Monitor appears at the top of the browser window.

Figure 3  File System Monitor

The File System Monitor provides the following information:

• Refresh: Click this button to manually refresh the File System 
Monitor.

• Refresh Rate: Set the File System Monitor to automatically refresh 
with this drop down menu. Options range from No Refresh to every 
10 Minutes. 

• State: A green checkbox indicates the file system is mounted and 
active, a red “x” indicates the file system is not active or not mounted

• File System: The name of the file system. (You might see more than 
one file system being monitored, depending upon how your 
StorNext system is configured). This pane is scrollable to 
accommodate numerous file systems. 

• Total Space (GB): Total space (in GB) for the file system

• Used Space (GB): Currently used space (in GB) for the file system

• Free Space (GB): Amount of free space (in GB) for the file system

• Total Files: Number of files on the file system

• #Store Candidates: Number of files selected for storage to secondary 
media

• #Trunc Candidates: Number of files that have been stored and meet 
the criteria to become a truncation candidate 
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• # SAN Clients: The number of StorNext SAN clients (connected via 
fibre channel or iSCSI) for which you are licensed

• # LAN Clients: The number of StorNext distributed LAN clients for 
which you are licensed. For more information about distributed LAN 
clients, see About Distributed LAN Clients on page 2.

• Status: The status shows the system status (usage) in percent in 
addition to low and high watermark settings. The low watermark 
specifies the level of used disk space that is acceptable to end 
overflow processing. The high watermark specifies the level of used 
disk space that initiates overflow processing. In the above example, 
the system usage is less than 10% with 75% set as the low watermark 
and 85% set as the high watermark. (High and low watermarks do 
not apply to non-managed file systems.)

The Library Monitor 2

The Library Monitor enables you to view library and drive information 
on each library. When you open a browser to access StorNext, the Library 
Monitor appears below the File System Monitor.

Figure 4  Library Monitor

The Library Monitor provides the following information:

• Refresh: Click this button to manually refresh the Library Monitor

Note: The #Store Candidates and # Trunc Candidates fields show 
“N/A” for a non-managed file system. For a managed file 
system, if these fields show “refresh,” click the Refresh button 
to retrieve current information for these fields.

Note: Overflow processing occurs when the system processes 
beyond the set watermark limitations.
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• Refresh Rate: Set the Library Monitor refresh rate with this drop 
down menu. Options range from No Refresh to every 10 Minutes.

• State: A green checkbox indicates the library is online, a red “x” 
indicates the library is offline

• Library Name: Displays the name of the library

• Library Type: Indicates the library type: SCSI, Vault, or Network

• Number of Drives: Specifies the number of drives that are 
configured for the library

• Capacity: Total number of media slots in the library

• Fill Level: Number of media in the archive

• Drive Name: Name (or label) of configured drive (or drives) for the 
library

• Status: Indicates if the drive is free, in use, failed, delayed, or 
cleaning.

• Mounted Media: Media ID of the media currently mounted in the 
drive

• Compression: Indicates whether compression is enabled

The Storage Disk Monitor 2

The Storage Disk monitor allows you to view configured storage disk 
information. When you open a browser to access StorNext, the Storage 
Disk Monitor appears below the Library Monitor.

Figure 5  Storage Disk Monitor

The Storage Disk Monitor provides the following information:

• State: A green checkbox indicates the storage disk is online, a red “x” 
indicates the storage disk is offline or online-pending. The online-
pending state is for storage disks that are deduplication enabled. A 
deduplication-enabled storage disk is put into an online-pending 
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state during blockpool verification because this process could take a 
long time to complete, depending on the blockpool size. Storage 
disks in the online-pending state are not used for store operations.

• Storage Disk Name: Name of the storage disk

• Deduplication: Indicates if deduplication is enabled for the storage 
disk. (This field appears only on 32 bit and 64 bit Linux systems.)

• Space (GB): Total amount of space (in gigabytes) on the storage disk. 
This amount includes space reserved by StorNext. 

• Used Space (GB): Space (in gigabytes) used on the storage disk

• Copy #: The copy number that may be stored on that media

• # Files: Total number of files on the storage disk

• % Savings: If deduplication is enabled, this field indicates the 
amount of savings achieved through deduplication. (This field 
appears only on 32 bit and 64 bit Linux systems.)

StorNext Home Page 
Drop-Down Menus 2

The following drop-down menu options located in the grey bar near the 
top of the home page provide access to StorNext configuration, 
administration, and reporting options:

• Config Menu Options

• Admin Menu Options

• Reports Menu Options

• Service Menu Options

• Help Menu Options

Config Menu Options 2

The following Config menu options launch the Configuration Wizard 
and let you perform individual Configuration Wizard tasks:

• Config Wizard: Launches the configuration wizard
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• Enter License: Enter StorNext license information

• Add File System: Add a file system to your environment

• Add Library: Add a library or vault

• Add Tape Drive: Add tape drive

• Add Media: Add media

• Add Storage Disk: Add a storage disk

• Add Storage Policy: Add a storage policy and a directory relation 
point to a file system

• E-Mail Notification: Configure e-mail notifications for System Status 
Tickets, Backup information, and Policy Class alerts

• Add Affinity: Add an affinity to a file system

Admin Menu Options 2

The following Admin menu options enable you to control StorNext’s 
day-to-day operations:

• Access StorNext Logs: Access logs of StorNext operations

• User Access Control: Control user access to StorNext tasks

• Download Client Software: Download SNFS client software. (This 
procedure is described in the StorNext Installation Guide.)

• Library Operator Interface: Enter or eject media from the Library 
Operator Interface

• Remove/Move Media: Remove media from a library or move media 
from one library to another

• Run Backup: Run a backup of StorNext software

• Schedule Events: Schedule file system events including Clean Info, 
Clean Versions, Full Backup, Partial Backup, and Rebuild Policy

• Start/Stop StorNext: Start or stop the StorNext components

Note: For more information about the StorNext Configuration 
Wizard, see Chapter 11, Data Migration Management.
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Reports Menu Options 2

The following Reports menu options allow you to view StorNext reports:

• SNFS: View the following SNFS reports:

• Affinities: View the existing affinities for a selected directory in 
the file system. 

• File Systems: View file system statistics including active clients, 
space, size, disks, and stripe groups.

• Stripe Groups: View statistics for the stripe group, such as space, 
affinities, and current statuses.

• Clients: View statistics for StorNext clients, including the 
number of SAN clients and distributed LAN clients, and client 
performance.

• LAN Client Performance: View information about distributed 
LAN clients and servers, including read and write speed.

• Backups: View a report of StorNext backups

• Drives: View tape drive information

• Files: View file information

• Libraries: View libraries information

• Library Space: View information about used library space

• Media: View media information

• Media Classes: View media classes information

• Policy Classes: View policy class information

• Relations: View directory/policy class relationship information

• Requests: View request information

• Scheduler: View scheduler information

• Storage Disk: View storage disk information

Note: Detailed descriptions of the Report menu options are located 
in Chapter 12, StorNext Reports.
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Service Menu Options 2

The following Service menu options help you monitor and capture 
system status information:

• Health Check: Perform one or more health checks on StorNext and 
view recent health check results

• State Capture: Obtain and preserve detailed information about the 
current StorNext system state

• System Status: View tickets indicating faults as reports by the 
StorNext system

Help Menu Options 2

The following Help menu options provide access to StorNext 
documentation, Quantum contact information, and detailed information 
about the version of StorNext you are using:

• Online Help: Provides a listing of StorNext online help topics that 
can be viewed in a separate browser window. (You can access this 
same topics list by clicking the Help icon in the upper right corner of 
the screen.)

• Documentation: Provides access to the StorNext documentation set. 
(Clicking Help in the upper right corner of the screen displays this 
same page.)

• Support: Allows you to access Quantum and Technical Support 
information

• About: Provides detailed information about your version of StorNext 
and the system on which it is running

StorNext System Status 2 The StorNext System Status button located at the bottom center of the 
StorNext Home Page appears only when there are open service tickets. 
This same information is always available by selecting System Status 
from the Service menu.

Click the System Status button to view a list of tickets indicating faults 
reported by the system. The Service - System Status screen appears.
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Figure 6  Service - System 
Status screen

StorNext Server Status 2 The StorNext Server Status button is located at the bottom right of the 
StorNext Home Page. This button displays one of three statuses for the 
file systems residing on the server:

• Active: All configured file systems are active

• Warning: One or more of the configured file systems have not been 
mounted or started

• Stopped: The storage manager or the file system manager is stopped

Clicking the StorNext Server Status button displays the Start/Stop screen, 
which enables you to either start or stop StorNext. For more information 
about starting or stopping StorNext, see Starting and Stopping StorNext 
Components on page 51.

Home and Help Links 2 In the upper right corner of the screen are Home and Help links. Clicking 
Home returns you immediately to the StorNext home page regardless of 
your current location.

Clicking Help displays a list of current StorNext documentation in pdf 
format. You can open a particular guide or document by clicking its link.
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Application Link 2 The StorNext application link is located at the bottom left of the StorNext 
Home Page. Click this link to view information about StorNext.

Figure 7  Application Link

The SNFS and SNSM Home Pages

The Navigation Pane on the left side of the screen contains links to the 
SNFS and SNSM home pages along with a Home button to return to the 
main StorNext Home Page.

• The SNFS Home Page - In SNFS mode, you perform file system-
specific tasks. The SNFS Home Page contains several drop-down 
menus: Config, Admin, and Reports. 

• The SNSM Home Page - In SNSM mode, you perform 
administrative storage manager tasks. The SNSM Home Page 
contains several drop-down menus: File, Media, Admin, and 
Reports. 
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The SNFS Home Page 2 The SNFS Home Page contains the following components:

• Drop-down menus that enable you to perform file system-specific 
administration tasks

• A file system monitor

• System and server status indicators

Figure 8  SNFS Home Page

SNFS Home Page Drop-
Down Menus 2

Use the drop-down menus on the SNFS home page as you would from 
the StorNext Home Page when performing file system-specific 
administration tasks. 

• The SNFS Config Menu

• The SNFS Admin Menu

• The SNFS Reports Menu

Note: The figure shows the SNFS Home Page as it appears when it is 
part of the full StorNext application. The interface for the 
SNFS standalone application looks slightly different, but has 
many of the same major features.
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• The SNFS Help Menu

The SNFS Config Menu 2

The following options on the SNFS Config menu allow you to add and 
modify file system configuration files:

• File Systems: Add or delete a file system

• Globals: Modify global settings

• Affinities: Add, modify, or delete an affinity from file systems

• Disks: Add or delete a disk to a file system

• Stripe Groups: Add, modify, or delete a stripe group from a file 
system

The SNFS Admin Menu 2

The following options on the SNFS Admin menu help you manage day-
to-day operations of the active file systems:

• Make File System: Make a file system

• Start/Stop File System: Start or stop a file system

• Mount/Unmount: Mount or unmount a file system

• Label Disk Devices: Label disk drives

Note: You must unmount and stop the file system before using most 
of the options listed in this section. See Chapter 4, Common 
StorNext Tasks for more information.

Caution: Deleting a disk or stripe group requires a remake of the file 
system and destroys all data on the file system when the 
task is run.

Caution: Making a file system or making/labeling disk devices 
destroys all data on the disk on which the task is run.
StorNext User’s Guide 20



Chapter 2  StorNext GUI Overview
The SNFS and SNSM Home Pages
• Set Affinities: Create a directory in the file system to the affinity

• Metadata Dump: Generate a Metadata dump of a file system

• Check File System: Run a check on your file system before 
expanding the file system or migrating a stripe group.

• Expand File System: Add new stripe groups to your file system.

• Move Stripe Group: Move data or metadata from one source stripe 
group to one or more destination stripe groups.

The SNFS Reports Menu 2

The options on the SNFS Reports menu allow you to view all SNFS 
reports. These are the same reports described in Reports Menu Options 
on page 15.

The SNFS Help Menu 2

The options on the SNFS Help menu provide access to StorNext 
documentation, Quantum contact information, and detailed information 
about the version of StorNext you are using. The SNFS Help menu 
options are the same as the ones described in Help Menu Options on 
page 16.

The SNSM Home Page 2 The SNSM Home Page contains a Library Monitor and these drop-down 
menu options: 

• The SNSM File Menu

• The SNSM Media Menu

• The SNSM Admin Menu

• The SNSM Reports Menu

• The SNSM Help Menu

SNSM Home Page Drop-
Down Menus 2

Use the drop-down menus on this home page as you would from the 
StorNext Home Page when performing Storage Manager-specific 
administration tasks.
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Figure 9  SNSM Menu

The SNSM File Menu 2

The following SNSM File menu options allow you to manage file data 
and directories:

• Store: Store files to a storage medium

• Version: Show the version(s) of files stored on storage medium

• Recover File: Recover deleted files

• Recover Directory: Recursively recover deleted directories

• Retrieve File: Retrieve truncated files from a storage medium

• Retrieve Directory: Recursively retrieve truncated directories from a 
storage medium

• Free Disk Blocks: Truncate files

• Move: Move files from one media to another

• Attributes: Change file attributes
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The SNSM Media Menu 2

The following SNSM Media menu options help you manage media and 
libraries:

• Library: Perform media movement tasks within a library (Manual 
Move, Mount, and Dismount)

• Add: Add media to a policy class

• Remove: Remove media from StorNext

• Move Blank: Associate blank media with a policy class

• Transcribe: Transcribe (copy) media

• Attributes: Change the media’s state or attributes

• Reclassify: Reclassify a media to a new media class

• Clean: Clean a media by policy class, file system, or media identifier

The SNSM Admin Menu 2

The following SNSM Admin menu options allow you to perform 
administration tasks:

• Library: Perform library tasks such as Config Library, Audit Library, 
Library State, and Cancel Eject

• Drive: Perform drive tasks such as Config Drive, Change Drive State, 
and Clean Drive

• Storage Disk: Perform storage disks tasks such as Config Storage 
Disk, Change Storage Disk State, and Clean Storage Disk

• Disk Space: Perform an immediate file system storage or truncation 
policy

• Policy Class: Add, modify, or delete a policy class

• Backup: Configure backup procedure parameters

• Relation: Add or remove directory relation points to a policy class

• Water Mark Parameter: Set water mark parameters (for more 
information about watermarks, see Status—page 11)

• Config Drive Pool: Add, modify, or delete drive pools

• Cancel Request: Cancel requested operations
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The SNSM Reports Menu 2

The options on the SNSM Reports menu allow you to view all SNFS 
reports. These are the same reports described in Reports Menu Options 
on page 15.

The SNSM Help Menu 2

The options on the SNSM Help menu provide access to StorNext 
documentation, Quantum contact information, and detailed information 
about the version of StorNext you are using. The SNSM Help menu 
options are the same as the ones described in Help Menu Options on 
page 16.

The Configuration Wizard

StorNext includes a Configuration Wizard that guides you through the 
process of setting up your StorNext system. The wizard includes tasks 
you would typically perform when you are first configuring your system. 

The Configuration Wizard appears automatically when you launch 
StorNext for the first time. If you do not finish performing all the tasks, 
the wizard reappears whenever you return to the StorNext home page so 
you can resume completing tasks where you left off. For example, if you 
complete tasks 1 through 5, the next time the StorNext wizard appears 
you will be ready to complete task 6. 

If you have not completed all the wizard tasks and do not want the 
wizard to appear the next time you access the StorNext home page, select 
the Don’t Show CW Again option. 
StorNext User’s Guide 24



Chapter 2  StorNext GUI Overview
The Configuration Wizard
Figure 10  StorNext 
Configuration Wizard

You can display the Configuration Wizard at any time by selecting 
Configuration Wizard from the StorNext home page’s Config menu. If 
you have completed all of the tasks, each task will be marked as 
Complete. If you have not completed all tasks, the ones you finished will 
be marked Complete and the wizard will be ready for you to begin the 
next uncompleted task.

You can perform any of the Configuration Wizard’s tasks separately 
rather than through the wizard. Each of these tasks is selectable from the 
StorNext home page’s Config menu. 

The initial Configuration Wizard screen has a Reset button that allows 
you to start at the beginning of the wizard. 
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Figure 11  Config Menu Options

Each of the Configuration Wizard’s tasks are described in detail 
elsewhere in this guide:

• Step 1: Enter License (See Entering the StorNext License on page 37)

• Step 2: Add File System (See Adding a File System on page 78)

• Step 3: Add Library (See Adding a Library on page 164)

• Step 4: Add Tape Drive (See Adding a Tape Drive on page 183)

• Step 5: Add Media (See Adding Media to a Configured Library on 
page 201)

• Step 6: Add Storage Disks (See Adding a Storage Disk on page 234)

• Step 7: Add Storage Policy (See Adding Media to a Policy Class on 
page 262)

• Step 8: Email Notification (See Setting Up E-mail Notification on 
page 64)
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The SNFS GUI is browser-based and can be accessed remotely from any 
machine with access to the local network and the SNFS server. This 
chapter describes how to access and navigate through the SNFS-only 
GUI. If you purchased StorNext, refer to StorNext GUI Overview on 
page 6.

This chapter includes the following topics:

• Accessing the SNFS GUI 

• The SNFS Home Page

• The SNFS Configuration Wizard

Accessing the SNFS GUI

Use the following procedure to access the SNFS GUI.

1 Open a Web browser.
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2 In the browser’s Address field, type the full address of the machine 
and its port number, and then press Enter. For example: http://
<machine name>:<port number>. Use the name of the machine and 
port number you copied when you installed the StorNext software.

After you enter the machine name and port number, the following 
screen appears.

Figure 12  StorNext File System 
Login Window

3 In the User ID field, type admin and press TAB.

4 In the Password field, type admin and click OK.

The initial StorNext GUI appears. 

Note: Supported browsers are:
• Internet Explorer 5.5, 6 and 7
• Netscape 7.x
• Mozilla 1.0 and later
• FireFox 1.5 and later, or 2.0 and later

To ensure proper browser operation, all monitors must be set to 
display at a minimum resolution of 1074 x 768. 

Note: Typically, the port number is 81. If port 81 is in use, use the 
next unused port number. (I.e., 82, 83, etc.)

Note: For information on changing your password or setting up 
additional users, refer to the StorNext Installation Guide.
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The SNFS Home Page

The SNFS home page contains the following components:

• A link to the Quantum Home Page

• The File System Monitor

• Drop-down Menus and Options

• Shortcut Menu Options

• Home and Help Links

• StorNext Server Status

Figure 13  SNFS Home Page

The File System Monitor3 The File System Monitor enables you to view statistics on each configured 
file system. When you open a browser to access StorNext, the File System 
Monitor appears at the top of the browser window.

                        Link to
                       Quantum                 Menus      FS Monitor       Help

                    StorNext Server Status

Shortcut
Menu 
Options
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The File System Monitor has a Refresh button that allows you to 
manually update (refresh) the information shown in the monitor. You can 
also select a rate from the Refresh Rate list to automatically refresh at the 
selected interval: 

• No Refresh

•  30 seconds

•  1 minute

•  2 minutes

•  5 minutes

• 10 minutes

Figure 14  File System Monitor

The File System Monitor provides the following information:

• Refresh: Click this button to manually refresh the File System 
Monitor.

• Refresh Rate: Set the File System Monitor to automatically refresh 
with this drop down menu. Options range from No Refresh to every 
10 Minutes. 

• State: A green checkbox indicates the file system is mounted and 
started, a red “x” indicates the file system is not active or not 
mounted

• File System: The name of the file system (you may see more than one 
file system being monitored, depending upon how your StorNext 
system is configured). This pane is scrollable to accommodate 
numerous file systems. 

• Total Space (GB): Total space (in GB) for the file system

• Used Space (GB): Currently used space (in GB) for the file system

• Free Space (GB): Amount of free space (in GB) for the file system

• Total Files: Number of files on the file system
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• #Store Candidates: Number of files selected for storage to secondary 
media. This field does not apply to SNFS-only configurations.

• #Trunc Candidates: Number of files that haves been stored and 
meets the criteria to become a truncation candidate 

• # Clients: The number of StorNext clients (connected via fibre 
channel or iSCSI) for which you are licensed

• # Distributed LAN Clients: The number of StorNext distributed 
LAN clients for which you are licensed. For more information about 
distributed LAN clients, see About Distributed LAN Clients on 
page 2.

• Status: The status shows the system status (usage) in percentage.

Drop-down Menus and 
Options 3

The following drop-down menus are located in the grey bar towards the 
top of the home page and are used to access SNFS configuration, 
administration, and reporting options:

• The Config Menu

• The Admin Menu

• The Reports Menu 

• The Help Menu

Figure 15  File System Menus

The Config Menu 3

The following Config menu options enable you to add and modify file 
systems:

• File Systems: Add or delete a file system

• Globals: Modify global settings

• Disks: Add or delete a disk to a file system
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• Stripe Groups: Add, modify, or delete a stripe group from a file 
system

• Affinities: Add, modify, or delete an affinity from file systems

The Admin Menu 3

The following Admin menu options enable you to control day-to-day 
operations of active file systems:

• Make File System: Make a file system

• Start/Stop File System: Start or stop a file system

• Mount/Unmount: Mount or unmount a file system

• Label Disk Devices: Label disk drives

• Set Affinities: Create a relation point in the file system to the affinity

The Reports Menu 3

The following Reports menu options let you view file system reports:

• Affinities: View the Affinities report

• File Systems: View the File Systems report

• Stripe Groups: View the Stripe Groups report

Note: Detailed descriptions of the Config menu options are located 
in Chapter 6, Managing the File System.

Caution: Making a file system or making/labeling disk devices 
destroys all data on the disk on which the task is run.

Note: Detailed descriptions of the Admin menu options are located 
in Chapter 6, Managing the File System.

Note: Detailed descriptions of the Report menu options are located 
in Chapter 12, StorNext Reports.
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The Help Menu 3

The Help menu provides you with access to StorNext reference material 
such as this user’s guide, the installation guide, and other useful 
documents.

Shortcut Menu Options 3 The SNFS Shortcut Menu on the left side of the SNFS home page contains 
options that let you perform the following Configuration and 
Administrative tasks: 

• Config

• Configuration Wizard: Launch the Configuration Wizard. For 
more information about the Configuration Wizard, see The SNFS 
Configuration Wizard on page 35.

• Add Affinity: Add an affinity and directory to a file system. For 
more information about adding an affinity, see Adding an 
Affinity on page 116.

• Add File System: Add a file system. For more information about 
adding a file system, see Adding a File System on page 78.

• Enter License: Enter your StorNext license information. For more 
information about entering a license, see Entering the StorNext 
License on page 37.

• User Access Control: Add, modify, or delete the level of user 
access. For more information about user access control, see 
Controlling User Access on page 45.

• Admin

• Access StorNext Logs: View logs for SNFS, the Server System, 
and the StorNext Web Server. For more information about 
accessing logs, see Accessing StorNext Logs on page 53.

• Download Client Software: Download the SNFS client software 
for a specific operating system. For more information about 
downloading client software, see the StorNext Installation Guide.

• Start/Stop StorNext: Start or Stop StorNext Software. For more 
information about starting and stopping StorNext, see StorNext 
Server Status on page 34.
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Home and Help Links 3 In the upper right corner of the screen are Home and Help links. Clicking 
Home returns you immediately to the StorNext home page regardless of 
your current location.

Clicking Help displays a list of current StorNext documentation in pdf 
format. You can open a particular guide or document by clicking its link.

StorNext Server Status 3 The StorNext Server Status button is located at the bottom right of the 
SNFS Home Page. This button displays one of three statuses for the file 
systems residing on the server:

• Active: All configured file systems are active

• Warning: One or more of the configured file systems have not been 
mounted or started

• Stopped: The storage manager or the file system manager is stopped

When you click the Server Status button, the Start/Stop SNFS screen 
appears.

Figure 16  Start/Stop SNFS 
Screen

1 On the Start/Stop SNFS screen, select Start or Stop to manually start 
or stop the StorNext File System. 

2 Select Enable or Disable to enable or disable the feature that 
automatically starts SNFS upon reboot. Your selection will be 
reflected the next time you reboot.
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3 Do one of the following:

• Click Cancel to exit the Start/Stop SNFS screen without saving

• Click Next to save your changes and proceed. The Complete 
Start/Stop SNFS screen appears.

Figure 17  Complete Start/Stop 
SNFS Screen

4 On the Complete Start/Stop SNFS screen, do one of the following:

• Click Cancel to exit the Complete Start/Stop SNFS screen 
without saving

• Click Back to return to the Start/Stop SNFS screen

• Click Next to proceed. A status window appears

5 If you clicked Next, click Close when the status window displays 
Success. 

The SNFS Configuration Wizard

SNFS includes a Configuration Wizard that guides you through the steps 
necessary to obtain a StorNext license and create a file system. You can 
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complete these steps at any time, and the wizard will resume at the 
remaining step you if you do not finish completing both tasks. If desired, 
you can select the option Don’t Show CW Again to prevent the wizard 
from automatically appearing the next time you launch StorNext.

Alternatively, you can complete the two tasks without launching the 
Configuration Wizard by clicking the shortcuts Enter License or Add File 
System. 

Access the Configuration Wizard by clicking the Configuration Wizard 
shortcut on the home page. The first screen of the Configuration Wizard 
appears.

Figure 18  SNFS Configuration 
Wizard Screen

For more information about completing the two Configuration Wizard 
tasks, see Entering the StorNext License on page 37, andAdding a File 
System on page 78. 
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4Common StorNext Tasks

This chapter provides instructions on performing the following StorNext 
and SNFS tasks:

• Entering the StorNext License

• Controlling User Access

• Starting and Stopping StorNext Components

• Accessing StorNext Logs

• Scheduling StorNext Events

• Setting Up E-mail Notification

• Cancelling SNSM Requests

Entering the StorNext License

Use the Enter License wizard to enter a permanent license string. You can 
also proceed using the 30-day temporary license that comes with 
StorNext. You must have a permanent or temporary license to configure 
or use StorNext.
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To obtain a permanent license, you must contact the Quantum Technical 
Assistance Center at licenses@Quantum.com and give them the following 
information:

• The serial number from your product CD or box.

• The number of StorNext SAN clients and distributed LAN clients you 
want to support.

• The StorNext server identification number. You can find this number 
on the Configuration Wizard’s Enter License String screen.

Alternatively, you can obtain a license by going to www.Quantum.com/
swlicense and providing the required information.

After the Quantum Technical Assistance Center receives the above 
information, a representative will send you a license string. Enter this 
license screen on the Enter License String screen to use StorNext with 
your permanent license.

If you use the temporary license, allow sufficient time for the Quantum 
Technical Assistance Center to receive your information and send your 
license string before the 30-day limit expires.

1 From the StorNext home page, choose Enter License from the Config 
menu. The Enter License - Introduction screen appears.

Note: If you use the temporary license, be sure to obtain a permanent 
license from Quantum before the 30-day temporary license 
expires.
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Figure 19  Enter License 
Introduction Screen

2 Click Next to continue. The Quantum license agreement appears. 
You must accept the license agreement in order to continue with the 
licensing process.
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Figure 20  Quantum License 
Agreement
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3 Read the license agreement and then click Accept. The Enter License 
Strings screen appears. This screen summarizes the information you 
must send to licenses@Quantum.com in order to receive the license 
string you enter on this screen. 

Figure 21  Enter License 
Strings Screen

4 If you want to proceed using a temporary license for SAN clients or 
distributed LAN clients, select the option Generate 30 day temporary 
license. To enter a permanent license, proceed to step 8—page 43. 
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5 After selecting Generate 30 day temporary license, click Next to 
continue. The Complete Enter License screen appears.

Figure 22  Complete Enter 
License Screen (Temporary)

6 On the Complete Enter License screen, click Next to complete the 
task, or Back to make changes. When you click Next, a message 
reminds you to contact the Quantum Technical Assistance Center 
within 30 days to receive your permanent license string. 

Figure 23  License Reminder
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7 Click OK to close the message box. 

8 In order to receive your permanent StorNext license you must email 
to licenses@quantum.com the following information, as listed on the 
Enter License Strings screen (figure 21 on page 41):

• The StorNext serial number from the StorNext box or CD.

• The total number of StorNext SAN clients (if any) you want to 
license for your system. This is the total number of client 
machines that are connected to a StorNext server through a fibre 
channel or iSCSI interface. 

• The StorNext server ID displayed on the screen. (In the figure, the 
ID is 15F268AFA2.)

• The total number of distributed LAN clients (if any) you want to 
license for your system. This is the total number of distributed 
LAN clients connected to StorNext via a distributed LAN server. 
For more information about distributed LAN clients, see About 
Distributed LAN Clients on page 2. 

9 Quantum will email you a license string for SAN clients. If you are 
using distributed LAN clients, they will also send you a separate 
license string for distributed LAN client usage. When you receive the 
license strings, copy and paste them into the License String field on 
the Enter License Strings screen (figure 21 on page 41). 

Click Next to continue. The Complete Enter License screen appears. 
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Figure 24  Complete Enter 
License Screen (Permanent)

10 Review the information on the screen, and then click Next to 
continue, or Back to make changes. 

11 After the status screen informs you that the operation was completed 
successfully, click Finish.

Entering a License 
String in the .dat File 4

Alternatively, when you receive your license string via email, you can 
copy and paste the license string into the /usr/adic/DSM/config/license.dat 
file instead of using the Enter License Strings screen. Updating this file 
enables StorNext to automatically detect the license string when the 
Configuration Wizard runs.

Here is an example of a StorNext license file with the license string 
entered (below License Authorization String). This is an example only. 
Do not enter the license screen shown.
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Figure 25  License String 
Example

Controlling User Access

This section describes the following User Access Control options:

• Changing the Admin Password

• Adding a New User

• Modifying an Existing User

• Deleting an Existing User
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Changing the Admin 
Password 4

Use this procedure to change the admin password. 

1 From the StorNext Home Page choose User Access Control from the 
Admin menu. The User Access Control screen appears. 

Figure 26  User Access Control 
Screen
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2 From the User Access Control screen, select Admin in the User List 
and click Modify. The Modify User “admin” screen appears.

Figure 27  <Modify User Screen

3 Enter your new password.

4 Confirm the new password by entering it again, and then click OK.

5 Click OK when the Status Screen displays Success.
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Adding a New User 4 Use this procedure to add a new StorNext user.

1 From the User Access Control screen, click Add. The Add New User 
Screen appears.

Figure 28   Add New User 
Screen
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2 In the Enter User Name field, type the name the new user will enter 
at the User ID field when he or she logs on to StorNext.

3 In the Enter Password field, type the password the new user will 
enter when logging on to StorNext.

4 In the Re-enter Password field, retype the password you entered at 
the previous field.

5 Select the type of access the user will have:

• Admin Defaults: Enables access to the entire StorNext system 
including SNFS Advanced Functions, SNSM Advanced 
Functions, StorNext Home Functions, and StorNext Reports

• Operator Defaults: Enables access to most of the StorNext Home 
Functions and StorNext Reports

• General User Defaults: Enables access to most of the StorNext 
Reports

Each of the above selections auto-populates the screen to correspond 
with your selection, but you can customize access by clicking on 
specific items for the user.

6 To simplify assigning access permissions, you can click Select All or 
Deselect All for each category. For example, to grant permission to 
most StorNext reports, click Select All and then deselect the reports 
for which you do not want to grant permission.

7 When you are satisfied with the permissions you have assigned, click 
OK.

8 Click OK when the Status screen displays Success. The User Access 
Control screen shows the new user you just added.

9 Click Cancel to close the window.
StorNext User’s Guide 49



Chapter 4  Common StorNext Tasks
Controlling User Access
Modifying an Existing 
User 4

Use this procedure to modify an existing user’s StorNext access.

1 From the User Access Control screen, select a name (other than 
“admin”) from the User List and click Modify. The Modify User 
screen appears with the user’s name displayed in the header.

Figure 29  Modify User Screen
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2 Change the user’s password or modify permissions as described in 
Adding a New User, and then click OK.

3 Click Close when the Status screen displays Success.

Deleting an Existing 
User 4

Use this procedure to delete an existing StorNext user.

1 From the User Access Control screen, select a name from the User 
List and click Delete.

2 When asked to confirm that you want to delete the user, click OK to 
proceed or Cancel to abort.

3 If you click OK, click Close when the Status screen displays Success.

Starting and Stopping StorNext Components

There are two ways to start or stop the StorNext applications, SNFS and 
SNSM:

• By using the Admin menu’s Start/Stop StorNext option

• By clicking the Server Status button located at the lower right corner 
of the StorNext home page 

The following procedure describes to start/stop StorNext components 
using either of these methods.

Note: If there is only one administrator, you can modify only the 
password. A sole administrator has full access 
permissions, and you cannot modify these permissions.

Note: If there is only one administrator, you will not be allowed 
to delete the administrator. 
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1 From the StorNext Home Page select Start/Stop StorNext from the 
Admin menu. Alternatively, click the Server Status button in the 
lower right corner of the screen. (This button displays the server’s 
current status, such as Active.) The Start/Stop StorNext screen 
appears.

Figure 30  Start/Stop StorNext 
Screen

2 Select either the Start or Stop option.

3 Select the items you want to start or stop:

• All Components

• StorNext File System

• StorNext Storage Manager

Note: The current status (Started, Stopped, or Warning) is 
shown next to each StorNext application. A Warning 
status indicates one of your configured file systems is 
either not mounted or has not been started.
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4 Select either Enable or Disable to enable or disable the feature that 
automatically starts StorNext at boot time. (Your selection on this 
screen will be reflected during the next reboot.)

5 Click Next. The Complete Start/Stop StorNext Task screen appears

Figure 31  Complete Start/Stop 
StorNext Task Screen

6 Click Next. A status screen appears.

7 Click Finish when the status screen shows Success. The StorNext 
Server Status in the lower right corner of the screen now displays 
Stopped, Warning or Active, depending on your action.

Accessing StorNext Logs

You can access and view any of the following types of logs:
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• SNFS Logs: Logs about each configured file system

• StorNext Database Logs: Logs that track changes to the internal 
database

• SNSM - File Manager Logs: Logs that track storage errors, etc. of the 
Storage Manager

• SNSM - Library Manager Logs: Logs that track library events and 
status

• Server System Logs: Logs that record system messages

• StorNext Web Server Logs: Various logs related to the web server

Use the following procedure to access the StorNext log files. The process 
is the same regardless of the type of log you are viewing.

1 From the StorNext home page, select Access StorNext Logs from the 
Admin menu. The Select Log screen appears.

Figure 32  Select Log Screen
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2 Select the type of log you wish to view, and then click Next. The 
Select File screen appears.

Figure 33  Select File Screen

3 Select the log file you wish to view, and then click one of the 
following:

• Delete: Delete the selected log file

• Mail: E-mail the selected log file to Quantum support

• Show: Show the selected log file in a separate window

4 If you clicked Show, the selected log file appears in a separate 
window. Click one of the following to navigate around the displayed 
log file:

• Next Page to view the log’s next page

• Previous Page to view the previous page

• Top to move to the beginning of the log

• End to move to the end of the log
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• Cancel to close the window

Figure 34  Log File Example

5 When you are finished viewing logs, click Cancel to close the Select 
File window.

Scheduling StorNext Events

StorNext events are tasks that are scheduled to run automatically based 
on a specified schedule. The following events can be scheduled:

• Clean Info: This scheduled background and removes from StorNext 
knowledge of media.

• Clean Versions: This scheduled event cleans old, inactive versions of 
files.
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• Full Backup: By default, a full backup is run once a week to back up 
the entire database, configuration files, and the file system metadata 
dump file.

• Partial Backup: By default, a partial backup is run on all other days 
of the week that the full backup is not run. This backup includes 
database journals, configuration files, and file system journal files.

• Rebuild Policy: This scheduled event rebuilds the internal candidate 
lists (for storing, truncation, and relocation) by scanning the file 
system for files that need to be stored.

Each of these events initially has a default schedule, but you can 
configure the schedules to suit your system needs.

Viewing a Schedule 4 The procedure for viewing an event's existing schedule is the same 
regardless of the event type.

1 From the StorNext Home Page, select Schedule Events from the 
Admin menu. The Feature Schedules screen appears.

2 Select an event type:

• Clean Info

• Clean Versions

• Full Backup

• Partial Backup

• Rebuild Policy

3 Click Configure. The Feature Schedules screen displays the selected 
event type and any existing schedules.

4 Click Close when you are finished viewing the schedule. (You can 
also click Back to return to the previous screen.)

Note: The Scheduler does not dynamically update when dates and 
times are changed significantly from the current setting. You 
must reboot the system for the Scheduler to pick up the 
changes.
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Adding a New Schedule 4 Use the following procedure to schedule StorNext events. The procedure 
for adding a new schedule for an event is the same regardless of the event 
type.

1 From the StorNext Home Page, select Schedule Events from the 
Admin menu. The Feature Schedules screen appears.

Figure 35  Feature Schedules 
Screen

2 Select the type of event you want to schedule:

• Clean Info

• Clean Versions

• Full Backup

• Partial Backup

• Rebuild Policy
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3 Click Configure. The Feature Schedules screen displays the selected 
event type and any existing schedules.

Figure 36  Feature Schedules 
Screen 2
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4 Click Add. The Add Feature Schedules screen appears.

Figure 37  Add Feature 
Schedules Screen

5 In the Name field, enter a name for the new schedule.

6 Select either Days of the Week or Days of the Month. 

• If you selected Days of the Week, select the days on which you 
want the event to run. To select multiple days, hold down the 
CTRL key when you select subsequent days.

• If you selected Days of the Month, select the calendar dates on 
which you want the event to run. To select multiple dates, hold 
down the CTRL key when you select subsequent dates.

7 At the Run Time field, specify the time of day you want the event to 
begin.

8 At the Start Window field, specify the window in which you want 
the StorNext Scheduler to start the event. The Scheduler attempts to 
begin the event within the specified Start Window time (e.g, 30 
minutes). If the event cannot begin at that time, the Scheduler tries 
again during the next cycle.
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9 Do one of the following:

• Click Apply to save your entry and create the new schedule. 
When the Status screen displays Success, click Close.

• Click Cancel to exit the screen without saving your entries. The 
Feature Schedules window closes.

• Click Back to return to the previous screen. (When you click Back 
you lose anything you entered on the Add screen.)

10 On the first Feature Schedule screen, click one of the following:

• Back: Go back to the previous screen

• Add: Add a new schedule

• Modify: Change an existing schedule

• Delete: Delete an existing schedule

• Reset: Reset the schedule to the default settings

• Close: Close the window

Modifying an Existing 
Schedule 4

The procedure for modifying an existing schedule for an event is the 
same regardless of the event type.

1 From the StorNext Home Page, select Schedule Events from the 
Admin menu. The Feature Schedules screen appears.

2 Select an event type:

• Clean Info

• Clean Versions

• Full Backup

• Partial Backup

• Rebuild Policy

3 Click Configure. The Feature Schedules screen displays the selected 
event type and any existing schedules.

4 Select the schedule you want to change, and then click Modify. 

5 In the Name field, view or change the name for the new schedule.
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6 Select either Days of the Week or Days of the Month. 

• If you selected Days of the Week, view or change the days on 
which you want the event to run. To select multiple days, hold 
down the CTRL key when you select subsequent days.

• If you selected Days of the Month, view or change the calendar 
dates on which you want the event to run. To select multiple 
dates, hold down the CTRL key when you select subsequent 
dates.

7 At the Run Time field, view or change the time of day you want the 
event to begin.

8 At the Start Window field, view or change the window in which you 
want the StorNext Scheduler to start the event. The Scheduler 
attempts to begin the event within the specified Start Window time 
(e.g, 30 minutes). If the event cannot begin at that time, the Scheduler 
tries again during the next cycle.

9 Do one of the following:

• Click Apply to save your changes and modify the new schedule. 
When the Status screen displays Success, click Close.

• Click Cancel to exit the screen without saving your changes. The 
Feature Schedules window closes.

• Click Back to return to the previous screen. (When you click Back 
you lose any changes you made on the Modify screen.)

Deleting an Existing 
Schedule 4

The procedure for deleting an existing schedule for an event is the same 
regardless of the event type. For every event type except Partial Backup 
you must have at least one schedule, so you will not be allowed to delete 
a solitary schedule.

1 From the StorNext Home Page, select Schedule Events from the 
Admin menu. The Feature Schedules screen appears.

2 Select an event type:

• Clean Info

• Clean Versions

• Full Backup

• Partial Backup
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• Rebuild Policy

3 Click Configure. The Feature Schedules screen displays the selected 
event type and any existing schedules.

4 Select the schedule you want to change, and then click Delete. 

5 When the Status screen displays Success, click Close.

6 Do one of the following:

• Click Cancel to exit the screen. The Feature Schedules window 
closes.

• Click Back to return to the previous screen. 

Resetting a Schedule 4 The Reset function deletes ALL existing schedules for an event type and 
creates one schedule that uses default values. The procedure for resetting 
schedules for an event is the same regardless of the event type.

1 From the StorNext Home Page, select Schedule Events from the 
Admin menu. The Feature Schedules screen appears.

2 Select an event type:

• Clean Info

• Clean Versions

• Full Backup

• Partial Backup

• Rebuild Policy

3 Click Configure. The Feature Schedules screen displays the selected 
event type and any existing schedules.

4 Click Reset. 

5 When prompted, confirm that you want to delete all existing 
schedules and create a single schedule that uses default values: click 
Yes to proceed or No to abort.

Caution: After you click Delete you will NOT be asked to 
confirm that you want to delete the schedule. DO 
NOT click Delete unless you are absolutely certain 
you want to delete the schedule. 
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6 Do one of the following:

• Click Cancel to exit the screen. The Feature Schedules window 
closes.

• Click Back to return to the previous screen. 

Setting Up E-mail Notification

The E-mail Notification feature allows you to specify parties who should 
be contacted when system alerts occur. You can specify e-mail recipients, 
alert levels, and information about your e-mail configuration.

Email notification is also an important part of the StorNext backup 
process. When you select the Backup option on the Configure Email 
Address screen (see figure 40 on page 67,) key information about a 
completed backup is emailed to the address you specify. This email 
contains the following important information:

• The required media for restoring from a complete set

• Names of configured storage disks or deduplication storage disks

• Any CVFS configuration files for file systems that are not data 
migration-enabled are appended to the email

Note: Before configuring e-mail notification, make sure your SMTP 
server is configured.
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1 From the StorNext home page, choose E-mail Notification from the 
Admin menu. The Configure E-mail Notification Introduction 
screen appears.

Figure 38  Configure E-mail 
Notification Screen
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2 On the Configure E-mail Notification Introduction screen, review 
your current e-mail settings (if any) and then click Next to continue. 
The Configure SMTP E-mail screen appears.

Figure 39  Configure SMTP E-
mail Screen

3 On the Configure SMTP E-mail screen, enter the fields related to 
your e-mail system configuration:

• SMTP Server: Enter the identification for the server that stores 
and processes your e-mail account information.This might be a 
valid server name or an IP address.

• Authentication: If your e-mail provider requires a password 
upon sign on, select the Password option. Otherwise, select 
None.

• Account: Enter a valid e-mail account for outgoing e-mail 
messages.

• Password: Enter the e-mail account’s sign-on password, if 
required.
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• Sender Address: Enter the e-mail address for the entity sending 
alert messages to recipients.

• Send Test E-mail to: Enter an e-mail address to which you can 
send test messages in order to confirm successful configuration.

4 Click Next to continue. The Configure E-mail Addresses screen 
appears.

Figure 40  Configure E-mail 
Addresses Screen

5 On the Configure E-mail Addresses screen, add e-mail recipients by 
entering the following fields:

• E-mail: Enter the e-mail address of the person who should 
receive e-mail alerts. 

• Backups: Select this option to receive e-mail after a backup has 
occurred on your system.

• Service Tickets: Select this option to receive e-mail when a 
service ticket for your system is generated. Notifications for 
service tickets will be sent for events at the specified alert level 
and higher. You must specify an alert level. 
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• Policy Class: Select this option to receive e-mail about policy 
class. You must specify a policy class.

• Notify Quantum on Service Ticket: Select this option to 
automatically send the Quantum Technical Assistance Center a 
message when a service ticket is generated.

6 Click Add to add to the list of e-mail recipients the e-mail recipient 
whose information you just entered. Or, select a previously added e-
mail recipient from the list and click Delete to remove that recipient.

7 If necessary, add additional e-mail recipients by repeating steps 4 and 
5. Click Next to continue. The Complete E-mail Configuration 
screen appears.

Figure 41  Complete E-mail 
Configuration Screen

8 Review your selections and do one of the following: 

• Click Back to change information you entered, or add or remove 
another e-mail recipient. 

• Click Next to continue. 
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9 When the Status screen informs you that your e-mail notifications 
were successfully processed, click Close. 

Cancelling SNSM Requests

If your system includes StorNext Storage Manager, the Cancel Request 
option (accessible from the SNSM home page’s Admin menu,) allows you 
to cancel a pending mount request that has not yet been executed by the 
system. On the Cancel Request screen you can view and select one or 
more requests, which are listed according to request ID and request type. 

1 From the SNSM home page, choose Cancel Request from the Admin 
menu. The Cancel Request screen appears.

Figure 42  Cancel Request 
Screen

2 Select from the Select Request ID list the pending requests you want 
to cancel. If desired, you can click Select All to select all requests. 

3 Click Apply to continue. 
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4 When the Status screen informs you that the selected requests have 
been successfully cancelled, click OK. The requests you selected are 
now removed from the list on the Cancel Request screen.
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This chapter provides instructions on backup up the StorNext software. 

This chapter covers these topics:

• Types of StorNext Software Backups

• Performing a StorNext Software Backup

• Managing the Backup Policy

Types of StorNext Software Backups

There are two types of StorNext software backup: Full and Partial. By 
default, a full backup runs once a week, and partial backups are 
scheduled to run on all other days of the week that the full backup is not 
run. If you would like to change the backup schedule, see Managing the 
Backup Policy on page 74. 

A Full Backup includes:

• The StorNext database

• Configuration files

• File system metadata dump file (after journal files are applied)

A Partial Backup includes:
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• StorNext database journals

• Configuration files

• File system journal files

 

Setting up Email 
Notification For Backup 5

Before you run a StorNext backup, be sure to set up email notification as 
described in Setting Up E-mail Notification on page 64. 

Email notification is an important part of the StorNext backup process. 
When you select the Backup option on the Configure Email Address 
screen (see figure 40 on page 67,) key information about a completed 
backup is emailed to the address you specify. This email contains the 
following important information:

• The required media for restoring from a complete set

• Names of configured storage disks or deduplication storage disks

• Any CVFS configuration files for file systems that are not data 
migration-enabled are appended to the email

Note: These backups DO NOT back up user data. This procedure 
backs up only StorNext-related system files.
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Performing a StorNext Software Backup

Use the following procedure to manually run a StorNext backup.

1 From the StorNext home page select Run Backup from the Admin 
menu. The Backup StorNext screen appears.

Figure 43  Backup StorNext 
Screen
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2 Select the type of backup you want run (Full or Partial,) and then 
click Next. The Complete Backup Task screen appears.

Figure 44  Complete Backup 
Task Screen

3 Click Next to start the backup.

4 Click Finish when the Status screen displays success.

Managing the Backup Policy

The Backups option on the SNSM home page’s Admin menu allows you 
to manage your backup policy by setting the media type for each copy. 
You can also specify the maximum of file versions to maintain, and also 
indicate where backups reside on your managed file system.
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1 From the SNSM home page, choose Backups from the Admin menu. 
The Backup Policy screen appears.

Figure 45  Backup Policy 
Screen

2 Enter the following information:

• File Copy 1 - 4: For each copy number (1 - 4,) select the media 
type. Only the media types applicable to your configuration are 
selectable.

• Max Backup Sets: If desired, specify the maximum number of 
backup sets you want to create. 

• Drivepool to Use: Select the location where backups should 
reside on your managed file system.

• Checksum Generation: Select this option if you want to generate 
a checksum.

• Checksum Validation: Select this option to enable checksum 
validation. 

• Managed File System to use for Backup: Select the name of the 
file system to use for the backup.

3 Click Apply to save and apply the backup policy.
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4  After the Status screen informs you that the operation was 
performed successfully, click OK.
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This chapter describes how to manage file systems by performing these 
major configuration and administration tasks:

• Working With File Systems

• Managing File System Operations

• Working With Disks

• Working With Stripe Groups

• Working With Affinities

• Using the SNSM File System Functions

• Understanding Dynamic Resource Allocation

• Performing File System Expansion

• Performing Stripe Group Movement

Working With File Systems

This section includes the following file-system related tasks: 

• Adding a File System

• Creating a File System From SNFS
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• Modifying a File System

• Deleting a File System

Adding a File System 6 The following procedure describes how to create an empty file system. 
The number of file systems you can add is limited only by the number of 
disks available for configuration. 

1 From the StorNext home page, choose Add File System from the 
Admin menu. The File System - Introduction screen displays both 
configured file systems and disks available for configuration.

Figure 46  File System - 
Introduction Screen

Note: This section describes how to create, modify, expand, and 
delete a file system and using the GUI. For instructions on 
using the CLI to accomplish the same tasks, see Using The 
Command Line Interface.
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2 Click Next to continue. The Add New File System screen appears.

Figure 47  Add New File 
System Screen

3 On the Add New File System screen, click Browse to enter a mount 
point (directory) for the file system. This allows you to navigate to an 
existing directory or create a new one. The Directory Browser screen 
appears.
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Figure 48  Directory Browser 
Window

4 Select from the Select Directory list an existing directory in which 
you want to create the file system. 

Figure 49  Select Directory 
Window

5 To create a new directory underneath the selected directory, click 
Create Directory and enter the new directory name. Click OK to 
continue. The new directory is shown in the Directory Brower 
Window’s Current Directory Field.

6 Click OK to accept the new directory. The new directory is shown on 
the Add New File System screen.

7 If desired, select the Enable Data Migration option. Select this option 
if you want this file system to be managed with automatic data 
movement between the primary disk storage and secondary storage 
(either disk or tape). If you do not enable this option, this file system 
remains unmanaged and does not move data to the tape library. Be 
sure to select this option if you intend to use the file system as a 
storage disk.
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8 Click Next to proceed from the Add New File System screen. The 
Disk Settings screen appears.

Figure 50  Disk Settings Screen

9 On the Disk Settings screen, type valid values and click Next.

• Block size field: The block size in bytes for the file system. The 
block size is the minimum unit of data accessed from physical 
devices. The default value of 16384 bytes is the recommended 
setting for best overall efficiency.

Caution: Do not select the Enable Data Migration option if 
the file system will be used as a storage disk.
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• Stripe group field: The number of stripe groups for the file 
system. Selecting a value greater than 1 enables customization to 
optimize performance and use StorNext features such as 
dedicated Metadata, Journal and User Data stripe groups.

10 When a message reminds you to select more than one stripe group if 
you want an alternate configuration other than the one that provides 
journal, metadata, and user date, click OK to continue. The 
Customize Stripe Group screen appears.

Note: If the file system you are adding will be used for 
deduplication-enabled storage disks, you must accept the 
default value of 16385 bytes.

Note: Quantum recommends that metadata and journals be on a 
stripe group separate from data. (In some cases, metadata 
and journals should be on separate stripe groups as well.)
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Figure 51  Customize Stripe 
Group Screen

11 Enter values for the Customize Stripe Group screen. 

• Name Field: The name of the stripe group. 

• Select disks list: The disks available to assign to the stripe group. 
You must select at least one disk for each stripe group.

• Label Type: If you plan to create LUNs larger than 2TB, you 
must specify the EFI label type when configuring a file system. 

VTOC labels were used for all operating systems in previous 
StorNext and Xsan releases, and are still required for the SGI IRIX 
operating system, Solaris releases prior to Solaris 10 Update 2, 
and LUNs less than 1TB. 

EFI labels are required if you plan to create LUNs that are larger 
than 2TB. (For Solaris, EFI labels are also required for LUNs with 
a raw capacity greater than 1TB.) EFI labels will not work with 
the IRIX operating system. 

The correct value is automatically selected when you reach the 
Customize Stripe Groups screen, so you can accept the default 
value unless you have a reason to change the label type. 
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For more information about 2TB LUN requirements, see the 
StorNext Installation Guide.

• Label Help: Click this link to display guidelines for determining 
whether to select VTOC or EFI labels. The matrix looks like this:

Figure 52  Label Help Screen

• Stripe breadth drop-down menu: The stripe breadth for the file 
system. The stripe breadth is the number of kilobytes (KB) that is 
read from or written to each disk in the stripe. For a typical 
StorNext installation, 64KB is the recommended setting.
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• Metadata, Journal, and User Data checkboxes: Enable one or 
more of these options (check the boxes) to create a location for 
metadata, journaling or user data.

• To enable metadata to be placed on the stripe group, select 
the Metadata checkbox.

• To enable journaling to be placed on the stripe group, select 
the Journal checkbox.

• To enable user data to be placed on the stripe group, select 
the User Data checkbox. 

12 If you selected multiple stripe groups on the Customize Stripe 
Group screen, repeat Step 11—page 83 for each stripe group.

13 On the Customize Stripe Group screen, type valid values and click 
Next. The Complete File System Task screen appears.

Note: If the file system you are adding will be used for 
deduplication-enabled storage disks, you must accept the 
default value of 64 kilobytes.

Note: Quantum recommends that your user data be on a 
different stripe group than your metadata and journal 
data.
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Figure 53  Complete FIle 
System Task Screen

14 Review your selections. Click Next to complete the task or Back to 
make changes.

15 After the status screen informs you that the file system was 
successfully added, click Next.

Creating a File System 
From SNFS 6

An alternative way to create a file system is to do so from the SNFS home 
page. However, this method is a more advanced task, and requires steps 
that are simplified when you create a file system through the 
Configuration Wizard (or by choosing Add File System from the 
StorNext home page’s Admin menu). For this reason, the preferred 
method of creating a file system is the one described in Adding a File 
System on page 78.

The following steps are required to create a file system from the SNFS 
home page:

1. Add a file system.
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2. Modify the file system’s global settings. 

3. Add disks to the file system. 

4. Add stripe groups for the file system. 

5. Make the file system. 

6. Start the new file system. 

7. Mount the new file system.

8. Add affinities to the new file system.

Each of the above steps is explained in the following procedure. 

1 From the SNFS home page, choose File System from the Config 
menu. The Configure File System screen appears.

Figure 54  Configure File 
System Screen

2 Click Add to continue. The Add File System screen appears. 

3 Type a name and mount point for the new file system and click OK. 
A status screen appears.

4 When the status screen indicates that the file system has been added, 
click Close.

5 Configure global settings for the file system as explained in Making 
Global Changes on page 95.
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6 Add disks to the file system as explained in Adding Disks on 
page 104.

7 Configure stripe groups for the file system as explained in Adding a 
Stripe Group on page 108.

8 Make the file system as described in Making a File System on 
page 101.

9 Start the file system as described in Starting and Stopping the File 
System on page 102

10 Mount the file system as described in Mounting or Unmounting a 
File System on page 103.

11 Add affinities to the file system as described in Modifying an Affinity 
on page 126.

Modifying a File System 6 This section describes how to modify an existing file system’s 
configuration. Changes to an existing file system include adding or 
modifying a stripe group, adding disks, adding affinities, and 
performance tuning.

1 Unmount the file system as described in Mounting or Unmounting a 
File System on page 103.

2 Stop the file system as described in Starting and Stopping the File 
System on page 102.

3 Make the appropriate changes to the file system. For more 
information, refer to:

• Making Global Changes on page 95

Note: Make sure that each stripe group is associated with no 
more than one affinity when using disk-to-disk migration.

Note: When using disk-to-disk relocation you can define a 
maximum of two affinities per file system.

Note: This procedure assumes the file system exists with at least two 
stripe groups.
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• Modifying an Affinity on page 126

• Adding Disks on page 104

• Adding a Stripe Group on page 108

• Modifying a Stripe Group on page 112

4 Start the file system as described in Starting and Stopping the File 
System on page 102.

5 Mount the file system as described in Mounting or Unmounting a 
File System on page 103.

Deleting a File System 6 Use this procedure to delete a managed file system.

1 From the SNFS home page, choose File System from the Config 
menu. The Configure File System screen appears.

2 Select the file system you want to delete, and click Delete.

If you are deleting a managed file system, you are warned that 
deleting this file system will delete all associated data and you will 
not be able to recover it. You are also warned that deleting this 
managed file system restarts the StorNext Storage Manager.

If you are deleting a non-managed system, you are warned that all 
files and directories in the file system will be permanently deleted. 
Click OK to Continue.

3 Click OK to close the warning message window.

4 After the Status screen informs you that the file system was 
successfully deleted, click Close.

Note: If you want to delete an unmanaged file system that contains 
storage disks or deduplication-enabled storage disks, you will 
not be allowed to delete the file system until you first delete all 
of those sdisks or dedup sdisks.
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Managing File System Operations

This section describes tasks that can be performed on an individual basis 
when you administer your file system. Except where noted, tasks can be 
completed in any order, and do not require that other tasks be 
successfully completed. This section includes these topics:

• Disk Device Labeling

• Making Global Changes

• Working with the fsnameservers File

• Making or Unmaking a File System

• Starting and Stopping the File System

• Mounting or Unmounting a File System

Disk Device Labeling 6
Each drive used by SNFS must be labeled. (A new drive must be labeled 
only one time.) You can label a drive from any StorNext server or client 
that has a fibre channel (FC) connection to the drive. 

Selecting a Device to Label, Unlabel, or Probe 6

Use the following procedure to select a disk device for labeling, 
unlabeling, or probing.

1 From the SNFS home page, choose Label Disk Devices from the 
Admin menu. The Label Disk Device screen appears.

Caution: Labeling a disk device will result in a complete loss of data 
on that disk device.

Note: A device whose name is not selectable in the Disk Devices 
list is currently in use by a configured file system.
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Figure 55  Label Disk Device 
Screen

From this screen, you can perform these tasks:

• Select Label Type - Specify VTOC or EFI label types for your 
disks. VTOC labels were used for all operating systems in 
previous StorNext and Xsan releases, and are still required for 
the SGI IRIX operating system, Solaris releases prior to Solaris 10 
Update 2, and LUNs less than 1TB. EFI labels are required if you 
plan to create LUNs that are larger than 2TB. (For Solaris, EFI 
labels are also required for LUNs with a raw capacity greater 
than 1TB.) EFI labels will not work with the IRIX operating 
system. 

• Label - Label any unused devices or relabel any device

• Unlabel - Unlabel any device in use by the file system

• Probe - Pulse a disk’s activity light

2 From the Disk Devices list, select the device you want to label, 
unlabel, or probe, and then click Label.

Caution: If you unlabel a device, all data on that device will 
be lost. Additionally, the unlabeled device will no 
longer be used by a StorNext file system until it is 
relabeled.
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Labeling a Device 6

Use the following procedure to label a disk device.

1 Specify the label type by choosing VTOC or EFI at the Select Label 
Type field. If the disk is less than 1TB in size and you have not 
specified VTOC, a message window cautions you that VTOC is 
recommended.

Figure 56  VTOC Message

2 Click OK to close the message window.

3 Click Label. A message window warns you that the device might 
have a file system on it, and that labeling the device will destroy any 
data.

Figure 57  Labeling Warning
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4 Verify that the disk you are labeling is empty, and then click OK to 
close the message window. The Explorer User Prompt window 
appears.

Figure 58  Explorer User 
Prompt

5 Enter a name for the device, or accept the displayed default name and 
then click OK. A message window warns you all data will be lost if 
you label this device.

Figure 59  Data Loss Warning

6 Click OK to continue and label the device. The Label Disk Devices 
Status window appears.

7 Click Close when the status displays Success. The Label Disk 
Device screen now includes the label you created.

Caution: Quantum recommends that you reboot nodes 
after you label or relabel a disk. Rebooting ensures 
that the system recognizes the labeled or relabeled 
disk.
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Unlabeling a Device 6

Use the following procedure to unlabel a disk device.

1 After selecting from the Disk Devices box the device you want to 
unlabel, click Unlabel. A message warns you that the device will be 
unusable after unlabeling.

Figure 60  Unlabel Warning

2 Click OK to close the warning window and proceed, or click Cancel 
to abort the unlabeling process. If you click OK, a status window 
appears.

3 Click Close when the status displays Success. The Label Disk 
Device screen now shows the device with no label name.

Probing a Device 6

Use the following procedure to probe a disk device.

1 After selecting from the Disk Devices box the device you want to 
probe, click Probe. The Probe Disk Device Status window appears.

2 Click Close when the status displays Success. 

Note: If you decide later to make an unlabeled device usable by 
the StorNext File System, you must first relabel the device. 
The relabeling process is identical to labeling initially, as 
described in Labeling a Device on page 92.

Note: The probe should light the disk or RAID.
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Making Global Changes 6 The global section of the file system configuration file contains general 
parameters that control system performance, components related to the 
file system’s resource consumption, and whether features are enabled or 
disabled. 

For most of these parameters, restarting the File System Manager (FSM) 
causes the modified parameters to take effect. However, the File System 
Block Size and Windows Security parameters require that the file 
system be remade before they take effect. Remaking the file system 
results in data loss, so you should carefully plan the initial configuration 
of these two parameters in order to reduce the number of file system 
remakes. If a parameter change requires a file system remake, the system 
notifies the administrator in the system log.

The global section also contains several parameters that can dramatically 
improve or degrade system performance, so you should exercise caution 
when modifying performance parameters. 

Before making any changes to the file system’s configuration, carefully 
review the cvfs_config(4) man pages or the “CVFS Configuration File” 
help file. 

The following task describes how to modify global configuration settings. 
These settings affect all stripe groups in the file system. 

1 From the SNFS home page, choose Globals from the Config menu. 
The Modify Global Settings screen appears. 
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Figure 61  Modify Global 
Settings Screen

If you are configuring global settings as part of the procedure for 
making a new file system, the list at the top of the screen shows your 
current step in the process. Previous and next steps are hyperlinked, 
so you can click any step to move to that task.

2 In the File Systems drop-down menu, select a file system.

3 In the remaining fields, choose or enter values and options for the file 
system you selected.

• File System Block Size: This value defines the granularity of the file 
system's allocation size. The default setting is 16,384. The block size 
must be specified in powers of 2.

• Inode Cache Size: This value defines the number of inodes that can 
be cached in the SNFS server. The default and minimum setting for 
the cache size is 16.
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• Maximum Log Size: This value defines the maximum number of 
bytes (size) to which a SNFS Server log file can grow. When the log 
file reaches the specified size, it is rolled and a new log is started. In 
this situation, the two log files could use twice the maximum log size 
space specified in this field. The range is from 1 to 256 megabytes.

• Maximum Number of Logs: This value determines the number of 
rolled logs kept. Choices range from 1 to 10. 

• Journal Size: This value controls the size of the file system journal. 
The range is 1 to 256 megabytes. 

• Thread Pool Size: This value defines the number of client pool 
threads to be activated and used by the SNFS server. This setting 
affects system performance. There should be at least two threads per 
client. Increasing the number of threads will improve file system 
response time in operations that affect allocation and metadata 
functions. The range is from 16 to 1024 threads. 

• Migrating File System: Enable this option (check the box) if the data 
on the file system should be migrated to tertiary storage. Migration 
cannot be disabled once it is enabled.

• Global Super User: Enable this option (check the box) to allow a user 
with super-user privileges to assert these privileges on the file 
system.

 

• Windows Security: Enable this option (check the box) to allow all 
Windows clients to use Microsoft Windows native security. If this 
option is enabled, then a Windows administrator may set Windows 
security on all files and directories for any user or group defined on 
the local Windows client or Windows domain.

• Use Physical Memory Only: When this option selected, the file 
system will use only physical memory, not swapped or paged

Note: If the Global Super User option is enabled, super users 
have global access rights on the file system. This selection 
is the same as the maproot=0 directive in the Network File 
System (NFS). 

If the Global Super User option is not enabled, super 
users can modify only files they can access, like any other 
users.
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• Quotas: Select this option to enable enforcing quotas for users and 
groups. 

 

• Inode Expansion Blocks: Use these fields to configure the minimum 
(floor), maximum (ceiling), and increment of the block allocation size 
for a dynamically expanding file. 

• Minimum: This value specifies the minimum number of blocks 
allocated when a file requires additional space

• Maximum: This value specifies the maximum number of blocks 
allocated on subsequent expansion. The range is from 1 to 32768 
blocks.

• Increment: When the allocation space is exhausted, this value 
specifies the increment added to the last allocation size, up to the 
maximum number of file system blocks

• Max Connections: Specify the maximum number of 
simultaneous connections for the file system.

• Reserved Space: This option enables delayed allocations on 
clients. Reserved space is a performance feature that allows 
clients to perform buffered writes on a file without first obtaining 
real allocations from the metadata controller. The allocations are 
later performed when the data is flushed to disk in the 
background by a daemon performing a periodic sync.

If the Reserved Space option is not enabled, slightly more disk 
space can be used at the expense of buffer cache performance, 
which could be adversely affected and cause fragmentation.

• Debug Log Settings: Settings to turn on debug functions for the file 
system server. The log information may be useful if a problem occurs. 
A Quantum Technical Assistance Center representative may ask for 
certain debug options to be activated to analyze a file system or 
hardware problem.

• Disable Debugging: Disables detailed file system debug tracing. 
When debug tracing is enabled, file system performance could be 
significantly reduced.

Note: Quotas are based on actual usage, and are not enforced 
based on space allocated. 
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•  LDAP Configuration

• UNIX File Creation Mode on Windows - Mode bits for UNIX 
files

• UNIX Directory Creation Mode on Windows - Mode bits for 
UNIX directories

• UNIX ID Fabrication on Windows - Allows you to enable or 
disable using fabricated IDs an a per-file system basis. If enabled, 
Windows user IDs are mapped using fabricated IDs.

The default value for enabling fabrication is based on the type of 
StorNext server you are using. On Windows the default is No.

• UNIX Nobody UID on Windows - UNIX user ID to use if no 
other mapping can be found

• UNIX Nobody GID on Windows - UNIX group ID to use if no 
other mapping can be found

4 Click Apply. The Modify Global Setting Status screen appears.

5 After the status screen indicates that the global settings were 
successfully modified, click Close.

Working with the 
fsnameservers File 6

The SNFS fsnameservers file specifies machines serving as File System 
Name Server coordinator(s) to the fsmpm daemon. The File System Name 
Server coordinator is a critical component of the StorNext File System 
Services (FSS). A principal function of the coordinator is to manage 
failover voting in a high-availability configuration. Therefore, it is critical 
to select highly reliable systems as coordinators. Redundancy is provided 
by listing multiple machine entries in the fsnameservers file, one entry 
per line. The first machine listed is the primary coordinator and any 
subsequent machines listed serve as backup coordinators. To create 
redundancy, it is recommended that you list two machines. Typically, the 
selected systems are also configured for FSM services, but this is not a 
requirement.

If the fsnameservers file does not exist, then the file system operates as a 
local file system, requiring both a client and a server. The file system will 
not communicate with any other StorNext File System product on the 
network, thus eliminating the sharing of the FSS over the SAN.
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After you type the IP addresses of two reliable machines on your network 
in the fsnameservers file, copy the fsnameservers file to every machine 
running SNFS. After changing the fsnameservers file, always restart 
(stop and start) all file system services running on the SNFS.

Redundant NICs are supported in the fsnameservers file; simply list both 
NIC addresses in the file.

Making or Unmaking a 
File System 6

Use the following procedures to make or re-make a file system.

Conditions to Make or Re-Make a File System 6

The following are reasons to make or re-make a file system.

• Creating a new file system

• Removing a stripe group from the file system

• Removing a disk from a stripe group

• Changing a stripe group's stripe breadth

Caution: It is extremely important that all copies of /usr/cvfs/config/
fsnameserver file in a SAN be identical. A stale 
configuration on a system that is not in use can cause 
election problems if fsmpm processes are running with 
mismatched fsnameservers.

It is also critical to verify that complete network 
connectivity exists between all systems running SNFS 
(client or server). This is important because all StorNext 
systems participate in the failover process.

Caution: This task destroys all existing data for the selected file 
system and creates a new configuration. Making or re-
making a file system results in a complete loss of user data.

After creating a relation point on a managed file system, 
you must delete and recreate the file system, not just 
remake.
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• Changing the sector count of a disk

Making a File System 6

Use this procedure to make a file system.

1 From the SNFS home page, choose Make File Systems from the 
Admin menu. The Make File System screen appears.

Figure 62  Make File System 
Screen

2 In the File Systems list, select a new or existing file system and click 
Apply. A confirmation screen warns you that all relation points on 
the system will be removed during this process, and prompts if you 
still want to make the selected file system.

3 Click OK. A second confirmation screen warns that all data will be 
lost on the selected file system.

4 Click OK.

5 After the status screen informs you that the task has completed 
successfully, click Close.
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Starting and Stopping the 
File System 6

This task enables you to start or stop a file system. You need to stop a file 
system if you want to take it out of service to make configuration changes 
or perform other administrative tasks. You need to start a file system to 
place it back into service.

1 From the SNFS home page, choose Start/Stop File System from the 
Admin menu. The Start or Stop File System screen appears.

Figure 63  Start or Stop File 
System Screen

2 Do one of the following:

• Select a file system from the Inactive File Systems list and click 
Start.

• The Start Stop File System Status screen appears.

• Select a file system from the Active File Systems list and click 
Stop.

• The Start Stop File System Status screen appears.

3 After the status screen informs you that task has successfully 
completed, click Close.

Note: Unselectable (greyed out) file systems in the Start or Stop 
File System screen require a metadata dump in order to be 
started. (This does not apply for SNFS-only systems.) 
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Mounting or Unmounting 
a File System 6

This task enables you to mount or unmount a file system. You must 
unmount a file system if you want to take it out of service to make 
configuration changes or perform other administrative tasks. You must 
mount a file system to place it back into service.

1 From the SNFS home page, and choose Mount/Unmount from the 
Admin menu. The Mount or Unmount File System screen appears.

Figure 64  Mount or Unmount 
File System Screen

2 Do one of the following:

• Select a file system from the Unmounted File Systems list and 
click Mount. The Mount File System Status screen appears.

• Select a file system from the Mounted File Systems list and click 
Unmount. The Unmount File System Status screen appears.

3 After the status screen informs you that the task has successfully 
completed, click Close.

Note: Before you unmount the file system you must stop the SNSM 
component as described in Starting and Stopping StorNext 
Components on page 51.

Note: The StorNext GUI performs NFS export/unexport on mount/
dismount.
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Working With Disks

A disk:

• can be used as an individual element or as one of many disks in a 
Redundant Array of Inexpensive Disks (RAID). 

• can contain metadata information, journaling, and/or data. 

• can constitute a single stripe group itself, or can be one node of a 
multi-disk stripe group. 

• can be a local hard disk located inside a server (if only a metadata 
disk), or most commonly, used in a RAID visible to all machines in 
the Storage Area Network (SAN) over FC.

The procedures in this section describe how to manage disks by adding, 
deleting, and defragmenting disks. Each disk is assigned to a disk type 
that specifies the number of sectors on the disk. 

• Adding Disks

• Deleting Disks

• Defragmenting a Disk

Adding Disks 6 Use this procedure to add a disk to a selected file system.

1 If the file system is mounted, unmount the file system as described in 
Mounting or Unmounting a File System on page 103.

2 If the file system is started, stop the file system as described in 
Starting and Stopping the File System on page 102.

Note: A disk must have a label before you can add it. For 
information about labeling a disk, see Labeling a Device on 
page 92.
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3 From the SNFS home page, choose Disks from the Config menu. The 
Manage Disks screen appears.

Figure 65  Manage Disks 
Screen

4 From the File Systems drop-down menu, select the file system to 
which you want to add the disk, and then click Add. The Add Disk 
screen appears.

Figure 66  Add Disk Screen
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5 Select from the Available Disks list the disk you want to add to the 
file system. You can select multiple disks by pressing the CTRL key 
and clicking the disk name. Click OK to continue. The Add Disk 
Status screen appears.

6 After the status screen indicates that the disks have been added, click 
Close. The Manage Disks screen (figure 65 on page 105) appears, 
and the disks list includes the disks you just added.

7 Start the file system as described in Making a File System on 
page 101.

8 Mount the file system as described in Mounting or Unmounting a 
File System on page 103.

Deleting Disks 6 Use this procedure to delete a disk from a selected file system.

1 From the SNFS home page, choose Disks from the Config menu. The 
Manage Disks screen (figure 65) appears.

2 Select from the File Systems drop-down menu the file system that 
contains the disk you want to delete.

3 Select from the Disks list the disk you want to delete.

4 Click Delete. A message asks you to confirm that you want to delete 
the disk.

5 Click OK to proceed with the deletion. The Delete Disk status screen 
appears.

Caution: When you add a new disk or stripe group to your SAN, 
often an OS-dependent operation must be run to make the 
added device recognizable by a host. Some of these 
utilities can disrupt access to existing disks, causing access 
hangs or failures. To avoid this, stop all file system 
operations on the affected host before rescanning for the 
new device.

Caution: Deleting a disk used in a stripe group results in a complete 
loss of user data and requires re-making the file system. 
For information on re-making the file system, refer to 
Making or Unmaking a File System on page 100.
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6 After the status screen indicates that the disk has been deleted, click 
Close.

Defragmenting a Disk 6 This procedure describes how to defragment a disk using the 
snfsdefrag utility to relocate SNFS file data into a single, pre-allocated 
extent. Reducing the number of extents in a file improves system 
performance by minimizing disk head movement when I/O occurs. You 
can defragment a single file or multiple files, perform a recursive 
defragment on files in a directory, or defragment the entire file system.

1 Log onto a metadata controller as root. The metadata controller is the 
computer where the StorNext server (not the client) is installed.

2 Do one of the following:

• To defragment a single file or a list of files, type:

/usr/cvfs/bin/snfsdefrag <filename> [filename ....]

• To perform a recursive defragment on files in a directory, type:

/usr/cvfs/bin/snfsdefrag -r <directory_name>

If the directory_name value is equal to the mount point, then the 
entire StorNext file system is defragmented.

Working With Stripe Groups

A stripe group is a logical disk volume in a file system that consists of one 
or more LUNs used to store metadata information, journaling 
information, and user data. Stripe groups are used to create logical 
volumes that can span multiple controllers on an array and even multiple 
arrays for even greater performance. Stripe groups are composed of 
LUNs of the same size and disk class based on your cost and performance 
requirements. (Fibre channel provides the highest performance and duty 
cycle.)

Note: For more information about using the snfsdefrag 
command, refer to the snfsdefrag(1) man pages.
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A stripe group contains definitions about read and write permissions, 
real time I/O constraints, a stripe breadth definition, multi-pathing 
methodology, and an affinity association. A file system can contain 
multiple stripe groups. 

Stripe groups are bound together to create a StorNext file system. When 
data is written into the file system, two critical things happen. 

First, data is separated from metadata. Metadata operations are typically 
small and random, and they require a lot of head movement on disks. 
Data however, tends to be written in large sequential patterns with less 
head movement. By separating data and metadata, thrashing is 
minimized and performance is maximized. 

The second critical thing that can happen when data is written to the file 
system is file steering. Stripe groups can be different sizes and categories 
of disk, so you could have a file system with one stripe group of SATA 
disk intended for proxy files or temporary storage (i.e., less critical data 
on lower duty cycle, slower disk). You might have another larger fibre 
channel stripe group for storing raw content (i.e., high value data, on 
higher duty cycle, higher performance disk). 

Getting data to specific stripe groups is accomplished using affinities, a 
mapping that ties a directory in the file system to a specific stripe group. 
When you write files to a directory, StorNext uses affinities to 
transparently write those files to the desired disk type. This means you 
don't have to have two or more separate file systems (e.g., one for critical 
data and another for temporary data). Instead, you have a single 
namespace for simplified management.

Working with a stripe group consists of these tasks:

• Adding a Stripe Group

• Modifying a Stripe Group

• Deleting a Stripe Group

Adding a Stripe Group 6 Use this procedure to add a stripe group.

1 From the SNFS home page, choose Stripe Groups from the Config 
menu. The Configure Stripe Groups screen appears.
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Figure 67  Configure Stripe 
Group Screen

2 From the File Systems drop-down menu, select the file system to 
which you want to add a stripe group, and then click Add. The Add 
Stripe Group screen appears.
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Figure 68  Add Stripe Group 
Screen

3 Enter the fields on the Add Stripe Group screen.

• Name: The name of the new stripe group.

• Breadth: The breadth size is the number of file system blocks that 
the system reads/writes before moving to the next disk in the 
stripe group. This value should be optimized for the major 
application that uses the disks. The default setting is 64.

• Available Disks: Disks available to the stripe group. To populate 
this list, you must first add disks to the file system by doing the 
following:

1) From the SNFS home page, choose Disks from the Config 
menu.

2) Select the file system in which the disks reside, and then click 
Add.
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3) Add one or more disks.

• Disks in Stripe Group: Disks associated with the new stripe 
group.

• Available Affinities: Affinities associated with existing stripe 
groups that, if selected, would also apply to this stripe group.

• Affinities in Stripe Group: Affinities associated with the new 
stripe group.

• Metadata, Journal, and Exclusive: Enable one or more of these 
options (check the boxes) to create a location for metadata and 
journaling on the stripe group.

• To enable placing metadata and journaling but not user data 
on the new stripe group, select the Metadata, Journal, and 
Exclusive checkboxes. Do not associate an affinity with a 
metadata, journal, or an exclusive stripe group.

• To enable placing only metadata on the new stripe group, 
select both the Metadata and Exclusive checkboxes.

• To enable placing only journaling on the new stripe group, 
select both the Journal and Exclusive checkboxes

• Journaling can be enabled on only one stripe group.

• If the Metadata and/or Journal boxes are not checked on any 
of the stripe groups in this file system, default settings cause 
metadata and journaling to be placed on the first defined 
stripe group. 

• Realtime IO/sec (optional): The number of disk I/O operations 
per second that are available to real-time applications. This is an 
optional setting and can be left blank.

• Realtime MB/sec (optional): The number of megabytes per 
second that are available to real-time applications. This is an 
optional setting and can be left blank.

• Non-realtime IO/sec (optional): The number of disk I/O 
operations per second that are available to non-realtime 
applications. If both Non-realtime IO/sec and Non-realtime MB/
sec Fields are selected, the system uses the lesser of the two 
values. This is an optional setting and can be left blank.
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• Non-realtime MB/sec (optional): The lower threshold (in MB per 
second) that is reserved for non-realtime applications. If both 
Non-realtime MB/sec and Non-realtime IO/sec Fields are 
selected, then the system uses the lesser of the two values. This is 
an optional setting and can be left blank.

4 Click OK.

5 After the status screen indicates that the new stripe group has been 
added, click Close.

Modifying a Stripe Group 6 Use this procedure to modify a stripe group configuration.

1 From the SNFS home page, choose Stripe Groups from the Config 
menu. The Configure Stripe Groups screen appears.

2 Select from the File Systems drop-down menu the file system whose 
stripe group you want to modify.

3 Select from the Stripe Groups list the stripe group you want to 
modify.

4 Click Modify. The Modify Stripe Group screen appears.

Caution: When you add a new disk or stripe group to your SAN, 
often an OS-dependent operation must be run to make the 
added device recognizable by a host. Some of these 
utilities can disrupt access to existing disks, causing access 
hangs or failures. To avoid this, stop all file system 
operations on the affected host before rescanning for the 
new device.
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Figure 69  Modify Stripe Group 
Screen

5 Type valid values for the stripe group.

• Stripe Group: The selected stripe group.

• Available Disks: Disks available to the stripe group. To populate 
this list, you must first add disks to the file system by doing the 
following:

1) From the SNFS home page, choose Disks from the Config 
menu.

2) Select the file system, and then click Add.

3) Add one or more disks.

• Disks in Stripe Group: Disks associated with the stripe group.

• Available Affinities: Affinities associated with existing stripe 
groups that, if selected, would also apply to this stripe group.
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• Affinities in Stripe Group: Affinities associated with the stripe 
group.

• Read-only: Select this option to make the stripe group read only.

• Status: The status of the stripe group, either online or offline.

• Select Up to put the stripe group online.

• Select Down to take the stripe group offline. Data stored in 
the stripe group is unavailable when the status is Down.

• Metadata, Journal, and Exclusive: Enable one or more of these 
options (check the boxes) to create a location for metadata and 
journaling on the stripe group.

• To enable placing metadata and journaling but not user data 
on the new stripe group, select the Metadata, Journal, and 
Exclusive checkboxes. Do not associate an affinity with a 
metadata, journal, or an exclusive stripe group.

• To enable placing only metadata on the new stripe group, 
select both the Metadata and Exclusive checkboxes.

• To enable placing only journaling on the new stripe group, 
select both the Journal and Exclusive checkboxes.

• Realtime IO/sec (optional): The number of disk I/O operations 
per second that are available to real-time applications. This is an 
optional setting and can be left blank.

• Realtime MB/sec (optional): The number of megabytes per 
second that are available to real-time applications. This is an 
optional setting and can be left blank.

• Non-realtime IO/sec (optional): The number of disk I/O 
operations per second that are available to non-realtime 
applications. This is an optional setting and can be left blank.

Note: Journaling can be enabled on only one stripe group. 

If the Metadata and/or Journal checkboxes are not 
checked on any of the stripe groups in this file system, 
default settings cause metadata and journaling to be 
placed on the first defined stripe group. 

If the file system was made, the metadata cannot be 
removed.
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• Non-realtime MB/sec (optional): The lower threshold (in 
megabytes per second) that is reserved for non-realtime 
applications. This is an optional setting and can be left blank.

6 Click OK.

7 After the screen indicates that the stripe group has been modified, 
click Close.

Deleting a Stripe Group 6 Use this procedure to delete a stripe group.

1 From the SNFS home page, choose Stripe Groups from the Config 
menu. The Configure Stripe Group screen (figure 67 on page 109) 
appears.

2 Select from the File Systems drop-down menu the file system that 
contains the stripe group you want to delete.

3 Select from the Stripe Groups list the stripe group you want to 
delete.

4 Click Delete. A confirmation screen prompts you to confirm that you 
want to delete the stripe group.

5 Click OK. The Delete Stripe Group Status screen appears.

6 After the status screen indicates that the stripe group has been 
deleted, click Close.

Working With Affinities

An affinity is a label assigned to one or more stripe groups. An affinity 
enables you to direct data to its associated stripe groups. A file system 
can have one or more affinities associated with it. These associations, 
defined in stripe groups, are made with the affinity key to a directory or 
file. 

Caution: Deleting a stripe group causes a complete loss of data and 
requires re-making the file system. Refer to Making or 
Unmaking a File System on page 100.
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For example, if you create a directory association with Affinity aff1, all 
data written to that directory is written to StripeGroup StripeGroup2, and 
therefore only to disk2. 

If you make an association with Affinity aff2 and a separate directory in 
the file system, all data is directed to StripeGroup StripeGroup3, which 
contains three disks: disk3, disk4, and disk5. All data is written to these 
disks when directed to the associated directory with Affinity aff2.

This section includes the following topics:

• Adding an Affinity

• Adding an Affinity Through SNSM

•

• Modifying an Affinity

• Deleting an Affinity

• File System Configuration Restrictions

Adding an Affinity 6 Use the following procedure to add an affinity to a configured file 
system. 

1 From the StorNext home page, select Add Affinity from the Config 
menu. The Add Affinity Introduction screen appears, showing a list 
of existing configured file systems to which you can add an affinity.
StorNext User’s Guide 116



Chapter 6  Managing the File System
Working With Affinities
Figure 70  Add Affinity 
Introduction Screen

2 Click Next to continue. The Add Affinity screen appears.
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Figure 71  Add Affinity Screen

3 Select the file system to which you want to add the affinity. Enter a 
name for the affinity (up to eight characters long) that begins with a 
letter. 

Click Next to continue. The Select Directory screen appears. 
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Figure 72  Select Directory 
Screen

4 Specify the directory for the new affinity. You can enter a pathname 
directly in the field, or click Browse to select from a list of existing 
directories. If desired, you can also create a new directory after you 
click Browse. 

Click Next to continue. The Assign Affinity screen appears.
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Figure 73  Assign Affinity 
Screen

5  Select from the displayed the list the stripe group to which you want 
to assign the new affinity. If none of the shown stripe groups are 
available, you must exit the procedure and create additional stripe 
groups before proceeding. 

Click Next to continue. The Exclusive Stripe Group screen appears.
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Figure 74  Exclusive Stripe 
Group Screen

6 If desired, you can select a stripe group that will be used exclusively 
for the new affinity’s files. To make a stripe group exclusive, select 
the desired stripe group from the left column (Not Exclusive) and 
click the upper arrow (>) to move the stripe group to the Exclusive 
list. 

Conversely, you can change a previously configured stripe group 
from exclusive by selecting it from the Exclusive column and clicking 
the lower arrow (<) to move it to the Not Exclusive column.

Click Next to continue. The Complete Add Affinity Task screen 
appears.
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Figure 75  Complete Add 
Affinity Task Screen

7 Click Next to continue. After the status screen informs you that the 
affinity was added successfully, click Close.

Adding an Affinity 
Through SNSM 6

Alternatively you can use the following procedure to add an affinity to an 
existing file system through SNSM.

1 If the file system is mounted, unmount the file system as described in 
Mounting or Unmounting a File System on page 103.

2 If the file system is started, stop the file system as described in 
Starting and Stopping the File System on page 102.

3 From the SNFS home page, choose Affinities from the Config menu. 
The Add, Modify, or Delete Affinities screen appears.
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Figure 76  Add, Modify, or 
Delete Affinities Screen

4 From the File Systems drop-down menu, select the file system to 
which you want to add the affinity, and then click Add. The Add 
Affinity screen appears.

Figure 77  Add Affinity Screen

5 Select a Stripe Group with which to associate the affinity, and then 
type a name for the affinity in the Affinity Name Field. Click OK to 
continue.
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The following stripe groups cannot be selected:

• An exclusive stripe group

• A metadata stripe group

• A journal stripe group

• A stripe group on a managed file system with a configured 
affinity

6 After the Status screen informs you that the affinity was successfully 
added, click Close. The Add, Modify, or Delete Affinities screen 
(figure 76 on page 123) appears, showing in the Affinities list the new 
affinity you just added.

7 Start the file system as described in Making a File System on 
page 101.

8 Mount the file system as described in Mounting or Unmounting a 
File System on page 103

Setting the Affinity in a 
Directory 6

When you use SNFS to add an affinity, you must set the affinity in a 
directory on the selected file system. (If you use the Add Affinity Wizard, 
this step is done automatically.)

1 From the SNSM home page, choose Set Affinities from the Admin 
menu. The Set Affinity screen appears.
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Figure 78  Set Affinity Screen

2 Select from the File Systems list the file system on which you want to 
set the new affinity.

3 Select from the Affinities list the affinity to set on the selected file 
system. 

4 Click Apply to continue. The Set Affinity screen appears.

Figure 79  Set Affinity Screen
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5 On the Set Affinity screen, click Browse and select or create the 
directory on the file system to which you want to set the affinity. 
Click OK. 

6 When the status screen informs you that the operation was 
completed successfully, click OK. 

Modifying an Affinity 6 Use this procedure to modify an affinity on a configured file system.

1 If the file system is mounted, unmount the file system as described in 
Mounting or Unmounting a File System on page 103.

2 If the file system is started, stop the file system as described in 
Starting and Stopping the File System on page 102.

3 From the SNFS home page, choose Affinities from the Config menu. 
The Add, Modify, or Delete Affinities screen (figure 76 on page 123) 
appears.

4 Select from the File Systems drop-down menu the file system you 
want to modify.

5 Select from the Affinities list the affinity you want to modify.

6 Click Modify. The Modify Affinity screen appears.

Figure 80  Modify Affinity 
Screen

7 Select the stripe group(s) with which to associate the affinity.

8 Click OK to continue.
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9 After the status screen informs you that the affinity has been 
modified, click Close. The Add, Modify, or Delete Affinities screen 
(figure 76 on page 123) appears, showing the association you just 
created.

10 Start the file system as described in Making a File System on 
page 101.

11 Mount the file system as described in Mounting or Unmounting a 
File System on page 103.

Deleting an Affinity 6 Use this procedure to delete an affinity on a configured file system.

1 If the file system is mounted, unmount the file system as described in 
Mounting or Unmounting a File System on page 103.

2 If the file system is started, stop the file system as described in 
Starting and Stopping the File System on page 102.

3 From the SNFS home page, choose Affinities from the Config menu. 
The Add, Modify, or Delete Affinities screen (figure 76 on page 123) 
appears.

4 Select from the File Systems drop-down menu the file system that 
contains the affinity you want to delete.

5 Select from the Affinity list the affinity you want to delete.

6 Click Delete. A message asks you to confirm that you want to delete 
the affinity.

7 Click Yes to confirm the deletion. The Delete Affinity Status screen 
appears.

8 After the status screen indicates that the affinity has been deleted, 
click Close.

9 Start the file system as described in Making a File System on 
page 101.

Caution: Deleting affinities from a file system configuration after 
the file system has been in use for a while could result in 
abnormal behavior. Contact the Quantum Technical 
Assistance Center before deleting affinities from a file 
system configuration.
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10 Mount the file system as described in Mounting or Unmounting a 
File System on page 103.

File System 
Configuration 
Restrictions 6

When using affinities, the StorNext administrator must adhere to the file 
system configuration restrictions listed below to ensure that data 
management policies execute properly. These restrictions apply only to 
managed file systems, not to non-managed (SNFS-only) installations. 

• Taking into account all managed file systems, you cannot use more 
than two unique affinity names. However, these two affinity names 
can be re-used across file systems. 

• All data stripe groups must have exactly one affinity association, but 
several stripe groups can be associated to the same affinity. This 
restriction does not apply to exclusive metadata or journal stripe 
groups.

• At least one policy class must be created to use the configured 
affinities. 

Performing a Metadata Dump

This procedure replaces any existing metadata dump data for the selected 
file system, and should be run only if the metadata file has been lost or 
corrupted.

Caution: You must designate at least one data stripe group in each 
managed file system as non-exclusive. If you do not make 
this designation, writing to the area of the file system that 
is not associated with any of the affinities will result in an 
out-of-space error.

Deleting affinities from a file system configuration after 
the file system has been in use for a while could result in 
abnormal behavior. Contact the Quantum Technical 
Assistance Center before deleting affinities from a file 
system configuration.
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1 From the SNFS home page, choose Metadata Dump from the Admin 
menu. The Metadata Dump of File System screen appears.

Figure 81  Metadata Dump of 
File System Screen

2 Select the file system on which to perform the metadata dump, and 
then click Apply.

3 After the Status Screen informs you that the metadata dump was 
performed successfully, click Close.

Using the SNSM File System Functions

The StorNext Storage Manager’s File menu contains file system functions 
that enable you to accomplish the following tasks:

• Storing Files

• Changing a File Version

• Recovering a File

• Recovering a Directory

• Retrieving a File
StorNext User’s Guide 129



Chapter 6  Managing the File System
Using the SNSM File System Functions
• Retrieving a Directory

• Freeing Disk Blocks

• Moving Files to New Media

• Modifying a File’s Attributes

These functions are not available if you have only StorNext File System 
and not StorNext Storage Manager.

Storing Files 6 Use this function to expedite storing files to media rather than waiting for 
data to be migrated automatically.

1 From the SNSM home page, choose Store from the File menu. The 
Store Files screen appears.

Figure 82  Store Files Screen

2 Do one of the following:

• Enter in the Enter Individual Filename field the file you want to 
store to media. You must enter the file’s complete pathname.

• Select from the File List one or more filenames to store to media. 
(To expedite filename selection, you can click the Select All 
button to select all files in the list, and then deselect the files you 
don’t want to include. If you change your mind, you can deselect 
all selected files by clicking the Deselect All button.)
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• Click Browse to display the StorNext File Browser window. On 
this window locate and select the files you want to store to 
media, and then click OK. 

3 If desired, click the Properties button to change the default 
parameters that are applied during file storage. The Optional Store 
Parameters screen appears. 

Figure 83  Optional Store 
Parameters Screen

4 On the Optional Store Parameters screen, enter values and then click 
Apply. 

• Number of Copies: Specify the number of copies (1 - 4) to create 
for each file. 

• Truncation: Specify whether file truncation is applied 
immediately to each file, or by policy. 

• Drive Pool Name: Choose the default drive pool from a list of 
available drive pools. (Drive pools must be previously created.)

• Minimum File Size: Specify the minimum size a file must be in 
order to qualify for storage.

• Select Media Type: Specify whether files are stored according to 
the policy’s media type, or on storage disk (SDISK or Dedup 
SDISK). 
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5 On the Store Files screen, click Apply to continue.

6 After the Status screen informs you that the operation was completed 
successfully, click OK.

Changing a File Version 6 Use this function to find alternate versions of a specified file.

1 From the SNSM home page, choose Version from the File menu. The 
Change File Version screen appears.

Figure 84  Change File Version 
Screen

2 Do one of the following:

• Enter in the Enter Individual Filename field the file whose 
version you want to change. You must enter the file’s complete 
pathname.

• Click Browse to display the StorNext File Browser window. On 
this window locate and select the files you want to store to 
media, and then click OK. 

3 Click the Get Versions button to display a list of available alternate 
versions for the file you specified.

4 Select the version you want to use, and then click Apply. 

5 After the Status screen informs you that the operation was completed 
successfully, click OK.
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Recovering a File 6 This function allows you to recover a deleted file. Undeleted files are 
recovered in a truncated state. To return the file back to disk, you must 
use the Retrieve File function as described in Retrieving a File on 
page 135. 

1 From the SNSM home page, choose Recover File from the File menu. 
The Recover Files screen appears.

Figure 85  Recover Files 
Screen

2 Enter in the Enter File Filter field a file filter to help you locate the 
deleted file you want. The filter can include wildcard characters (the 
asterisk *) anywhere in the filter string.

3 Click Browse to locate and select files that have been deleted. The 
StorNext Recoverable Files screen shows a list of all deleted files that 
apply to the filter you entered. The date and time the file was deleted 
is also shown.
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Figure 86  StorNext 
Recoverable Files Screen

4 Select from the list the files you want to undelete. To expedite file 
selection, you can use the Select All or Deselect All buttons. If the 
file list spans more than one screen page, click Next to view the next 
page, or Back to return to the previous page. When you are finished 
selecting files for recovery, click OK. 

5 On the Recover Files screen, verify that the files shown are the ones 
you want to recover. Click the Select All button to include all files. 

6 When you are ready to recover the selected files, click Apply. 

7 After the Status screen informs you that the operation was completed 
successfully, click OK.

Recovering a Directory 6 Use this function to recover a deleted directory. When you restore a 
directory, the deleted files and inodes from the directory and its sub-
directories are recovered, but the files are in a truncated state. To retrieve 
the files you must use the Retrieve Directory function as described in 
Retrieving a Directory on page 136. 

Note: When you use this function, you must first select the file 
system to which you want to restore the deleted directory. 
That file system must be started and mounted.
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1 From the SNSM home page, choose Recover Directory from the File 
menu. The Recover Directory screen appears.

Figure 87  Recover Directory 
Screen

2 Select from the Select File System dropdown list the file system to 
which you want to restore the deleted directory. 

3 Select from the Select Directory list the directory you want to 
recover.

4 If desired, click the Details button to view all files and sub-directories 
that will be restored when the selected directory is recovered. 

5 Click Apply to recover the selected directory.

6 After the Status screen informs you that the operation was completed 
successfully, click OK.

Retrieving a File 6 This function allows you to retrieve an entire file or a portion of the file 
from media to disk. If you retrieve a partial file, you must give the file a 
new name to prevent overwriting the current version. 

1 From the SNSM home page, choose Retrieve File from the File menu. 
The Retrieve Files screen appears.
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Figure 88  Retrieve Files 
Screen

2 Do one of the following:

• Enter in the Enter Individual Filename field the file you want to 
retrieve. You must enter the complete pathname.

• Click Browse to display the StorNext File Browser window. On 
this window locate and select the files you want to store to 
media, and then click OK. On the Retrieve Files screen, verify 
that the files shown are the ones you want to retrieve. 

3 If desired, click the Properties button to view the properties for the 
files you are retrieving. 

4 Click Apply to retrieve the selected files.

5 After the Status screen informs you that the operation was completed 
successfully, click OK.

Retrieving a Directory 6 This function allows you to recursively retrieve (copy) a directory’s files 
and sub-directories from media, and then place them back on disk. 
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1 From the SNSM home page, choose Retrieve Directory from the File 
menu. The Retrieve Directory screen appears.

Figure 89  Retrieve Directory 
Screen

2 Do one of the following:

• Enter in the Enter Directory field the directory from which you 
want to recursively retrieve files and sub-directories. You must 
enter the complete pathname.

• Click Browse to display the Directory Browser window. On this 
window locate and select the directory you want, and then click 
OK. 

3 Click Apply to retrieve the selected files.

4 After the Status screen informs you that the operation was completed 
successfully, click OK.

Freeing Disk Blocks 6 Use this function to free disk blocks by removing one or more files from 
disk. Before you can remove a file from disk, it must first be on media. 
(The file remains on media after you remove it from disk.)
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1 From the SNSM home page, choose Free Disk Blocks from the File 
menu. The Free Disk Blocks screen appears.

Figure 90  Free Disk Blocks 
Screen

2 Do one of the following:

• Enter in the Enter Individual Filename field the file you want to 
remove from disk. You must enter the file’s complete pathname.

• Click Browse to display the StorNext File Browser window. On 
this window locate and select the files you want to remove from 
disk, and then click OK. On the Free Disk Blocks screen, verify 
that the files shown are the ones you want to remove.

3 Click Apply to remove the selected files from disk.

4 After the Status screen informs you that the operation was completed 
successfully, click OK.

Note: If the stub files feature is enabled and the file size is smaller 
than the stub file size you specified when creating the storage 
policy, the stub file remains on the disk. In this situation, you 
might receive a Failure status after you click Apply.
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Moving Files to New 
Media 6

This function enables you to move files from one piece of media to 
another. When you use this function, files on the original media are 
deleted. (That is, this is not a copy function that leaves files on the source 
media and places a copy on the destination media.)

1 From the SNSM home page, choose Move from the File menu. The 
Move FIles to New Media screen appears.

Figure 91  Move Files to New 
Media Screen

2 Do one of the following:

• Enter in the Enter Individual Filename field the file you want to 
move. You must enter the file’s complete pathname.

• Click Browse to display the StorNext File Browser window. On 
this window locate and select the files you want to move, and 
then click OK. On the Move Files to New Media screen, verify 
that the files shown are the ones you want to move.

3 Specify the Media ID and Media Type for the destination media. If 
desired, select the Move to Blank Media option. (When you select 
this option, StorNext searches for blank media on which to move the 
selected files.)

4 Click Apply to move the selected files to new media.

5 After the Status screen informs you that the operation was completed 
successfully, click OK.
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Modifying a File’s 
Attributes 6

With this function you can change a file’s attributes, including the 
associated policy class attributes and number of file copies to save on 
media during storage.

1 From the SNSM home page, choose Attributes from the File menu. 
The Modify File Attributes screen appears.

Figure 92  Modify File Attributes 
Screen

2 Do one of the following:

• Enter in the Select Individual File field the file whose attributes 
you want to modify. You must enter the file’s complete 
pathname.

• Click Browse to display the StorNext File Browser window. On 
this window locate and select the files whose attributes you want 
to modify, and then click OK. 

3 Specify the number of copies to maintain for each selected file (One, 
Two, Three, or Four).

4 Indicate whether to truncate files after storing, during the file cleanup 
process, or not at all.
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5 If the Stub File feature is enabled, indicate how StorNext determines 
the stub file size:

• By Policy: Use the stub file size entered when the storage policy 
was created

• User Set: Change the stub file size by entering the new size (in 
kilobytes) at this field

6 Click Apply to modify attributes for the selected files.

7 After the Status screen informs you that the operation was completed 
successfully, click OK.

Understanding Dynamic Resource Allocation

StorNext provides two Dynamic Resource Allocation tools that allow you 
to make changes to your file system: File System Expansion, and Stripe 
Group Movement. 

About File System 
Expansion 6

StorNext’s File System Expansion feature enables you to dynamically add 
LUNs to a selected file system without interrupting that file system’s 
operation. 

The only disruption that occurs during File System Expansion is a short 
pause of new metadata requests as StorNext updates its internal system 
and clients to be aware of the new overall capacity and physical disk 
resources that are used.

File System Expansion is often done in conjunction with the Stripe Group 
Movement feature. That is, you might want to add new stripe groups 
knowing you’ll want to use those stripe groups for Stripe Group 
Movement.

StorNext provides a File Expansion Wizard to simplify the process. 
Quantum recommends using this wizard for File System Expansion, but 
you can also use the command line interface. (For information about 
using the CLI, see Using the Dynamic Resource Allocation Feature.)
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About Stripe Group 
Movement 6

Stripe Group Movement accomplishes two purposes: moving data files 
between stripe groups, and freeing stripe groups so they can be removed 
from an existing StorNext file system.

Before movement, the stripe group should be in read-only mode (write 
disabled). 

During Stripe Group Movement, you indicate one or more source stripe 
groups from which to move data. StorNext then automatically moves all 
data of the same type (either data or metadata,) from the source stripe 
groups to the remaining stripe groups in the file system. All other stripe 
groups are targets, allowing an even distribution of data across 
remaining disk resources. During movement the file system is left online 
and read/write operations occur normally. 

After all data has been removed from the source stripe group, you must   
mark the stripe group as “down,” which prevents new data from being 
written to the source stripe group. If desired, a system administrator can 
then remove the source stripe group from the StorNext configuration, or 
use the disks in other file systems.

StorNext provides a Movement Wizard to simplify the process. Quantum 
recommends using this wizard for Stripe Group Movement, but you can 
also use the command line interface. (For information about using the 
CLI, see Using the Dynamic Resource Allocation Feature.)

Expansion and 
Movement Steps 6

Here are the steps required for expanding a file system and moving stripe 
groups:

1 Check the file system before you begin. (See Checking the File System 
on page 143.)

2 Expand the file system. (See Performing File System Expansion on 
page 145.)

3 Move data stripe groups or metadata/journal stripe groups. (See 
Performing Stripe Group Movement on page 152.)

Note: After expansion you must perform a metadata dump. The File 
Expansion Wizard includes an option that will do this for you 
automatically, but the process can take longer than if you do 
the metadump manually. 
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4 Mark source stripe groups as down. (See Modifying a Stripe Group 
on page 112.)

Checking the File System

Before you perform either File System Expansion or Stripe Group 
Movement, you must first perform a check on the file system you plan to 
use for these features. This operation could take a significant amount of 
time depending on the size of the file system, so plan accordingly.

Use the following procedure to perform a file system check.

1 From the SNFS home page, choose Check File System from the 
Admin menu. The Check File System screen appears.

Figure 93  Check File System 
Screen

2 Select from the File Systems list the file system you want to check. 
Only file systems eligible for File System Expansion or Stripe Group 
Movement are shown in the list. Next to the file system name, the file 
system’s current state is shown in parentheses: mounted or 
unmounted, and started or stopped.
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3 If desired, select the Check Read Only option if you want to perform 
the file system check in read-only mode.

4 When you are ready to proceed with the check on the selected file 
system, click Apply. The status window informs you that the process 
was initiated. Close this window by clicking Close.

Checks in progress are shown as In Progress under the heading 
Current Status of Check File System. If the move does not appear 
with an In Progress status, click Refresh to update the list.)

5 Also listed under Current Status of Check File System are any 
previously run file system checks. To clear the list of previously 
completed checks (marked Success or Failure,) click Clear. 

6 To view a status summary for any successfully run file system 
checks, click the Success or Failure indicator under the Status 
heading. 

Note: If the file system you select is currently started and 
mounted, the check will be automatically performed in 
read-only mode. In read-only mode on a live file system 
(started and mounted,) you could receive false errors.
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Figure 94  Check File System 
Status Screen

Performing File System Expansion

In practical terms, expanding an existing file system means allocating 
additional storage to that file system. You add additional storage by 
creating a new stripe group in the file system configuration file, and 
assigning new disks to the stripe group.

Here is an overview of the steps required to enable File System 
Expansion:

1. Define new disk LUNs and make them available across the fibre 
channel SAN to the metadata controller and StorNext clients. 

2. Use the StorNext GUI to create a new stripe group from the LUNs.

3. Add the new stripe group to an existing file system. 

After you perform these steps, StorNext automatically updates the 
available file system capacity and presents the expanded file system to 
the StorNext clients. 
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Follow these steps when you are ready to use the File System Expansion 
Wizard:

1 From the SNFS home page, choose Expand File System from the 
Admin menu. The File System Expansion - Introduction screen 
appears, showing a list of file systems available for expansion.

Note: During File System Expansion the file system is shut down. 
After expansion you must perform a new metadata dump 
runs after the file system is updated. For managed file 
systems, the File System Expansion wizard includes an option 
for you to run the metadump automatically, or you can do it 
separately from the wizard.

As a final part of the File System Expansion process, StorNext 
restarts the file system. This restart typically takes less than 
two minutes and is often completed in seconds, but during the 
restart all new read/write requests are paused while 
operations in progress continue normally.

Caution: When you add a new disk or stripe group to your SAN, 
often an OS-dependent operation must be run to make the 
added device recognizable by a host. Some of these 
utilities can disrupt access to existing disks, causing access 
hangs or failures. To avoid this, stop all file system 
operations on the affected host before rescanning for the 
new device.
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Figure 95  File System 
Expansion Introduction Screen

2 Select from the list the file system on which you want to perform File 
System Expansion. Click Next to continue. 

3 A message reminds you that you must check your file system before 
beginning the expansion process. 

Figure 96  Check File System 
Reminder
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Do one of the following:

• If you have not checked the selected file system, click Cancel and 
then run the file system check as described in Checking the File 
System on page 143.

• If you have already checked the selected file system, click OK to 
proceed. The Data Stripe Group Selection screen appears.

Figure 97  Data Stripe Group 
Selection Screen

4 The Data Stripe Group Selection screen shows all currently 
configured stripe groups. Specify the number of data stripe groups 
you want to add to the file system.

5 If you want StorNext to automatically perform a metadata dump 
after file system expansion is finished, select the Perform metadump 
option. (This option appears only for managed file systems.)

If you do not select this option, a message warns you that backups on 
the file system will fail until you perform a metadump. Click OK to 
proceed.
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Figure 98  Metadump Warning

6 On the Data Stripe Group Selection screen, click Next to continue. 
The New Data Stripe Group screen appears.

Note: If you proceed without selecting the Perform metadump 
option, you should manually perform a metadata dump 
after file system expansion is finished to make sure your 
backups do not fail. For information about performing a 
metadata dump, see Performing a Metadata Dump on 
page 128. 
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Figure 99  New Data Stripe 
Group Screen

7 Enter values for the New Stripe Group screen. 

• Name field: The name of the stripe group. 

• Select disks list: The disks available to assign to the stripe group. 
You must select at least one disk for each stripe group.

• Label Type: If you plan to create LUNs larger than 2TB, you 
must specify the EFI label type when configuring a file system. 

VTOC labels were used for all operating systems in previous 
StorNext and Xsan releases, and are still required for the SGI IRIX 
operating system, Solaris releases prior to Solaris 10 Update 2, 
and LUNs less than 1TB. 

EFI labels are required if you plan to create LUNs that are larger 
than 2TB. (For Solaris, EFI labels are also required for LUNs with 
a raw capacity greater than 1TB.) EFI labels will not work with 
the IRIX operating system. 

The correct value is automatically selected on the New Stripe 
Groups screen, so you can accept the default value unless you 
have a reason to change the label type. 
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For more information about 2TB LUN requirements, see the 
StorNext Installation Guide.

• Label Help: Click this link to display guidelines for determining 
whether to select VTOC or EFI labels. (See figure 52 on page 84.)

• Stripe breadth drop-down menu: The stripe breadth for the file 
system. The stripe breadth is the number of kilobytes (KB) that is 
read from or written to each disk in the stripe. For a typical 
StorNext installation, 64KB is the recommended setting.

• Metadata or Data: Specify whether you plan to use the stripe 
group for data or for metadata. 

8 Click Next to continue. If you are entering more than one stripe 
group, your choices are saved and you are ready to make selections 
for the next stripe group. Repeat step 5 for each stripe group you are 
adding.

If you are adding only one stripe group, the Complete File System 
Task screen appears after you click Next.

Figure 100  Complete File 
System Task Screen
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9 Click Next to complete the process. 

10 After the status screen informs you that the expansion was completed 
successfully, click Finish to exit the wizard. 

Performing Stripe Group Movement

The time it takes to complete the Stripe Group Movement process 
depends on the amount of data being moved between source and target 
stripe groups. When moving a data stripe group, the file system 
continues to run during the movement process. StorNext does not block 
any new read/write requests, or block updates to existing files on the 
source stripe group. All operations (including metadata operations) are 
handled normally, but no new writes are allowed to the source stripe 
group, which will be marked read-only. 

Although the Movement Wizard focuses primarily on data movement, 
you can also move metadata stripe groups. You can move a metadata 
stripe group to a new stripe group of the same or greater capacity as the 
original metadata stripe group. However, during metadata stripe group 
movement the file system must be down, and no new read/write 
operations can occur until all metadata has been transferred and the file 
system is restarted. The exact amount of downtime is based on the disk 
size.

For movement purposes, StorNext treats metadata and journal stripe 
groups the same way, so it doesn’t matter whether the stripe group you 
want to move is a metadata stripe group, a journal stripe group, or a 
combined metadata and journal stripe group. The only caveat is that 
stripe groups used for metadata/journal move cannot contain data. 

Note: When moving a metadata stripe group, the Movement Wizard 
shuts down the file system. Depending on the number and 
size of files in your system configuration, metadata movement 
could take a long time, so plan accordingly.

After data movement is complete, you must mark the source 
stripe group as “down.”
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(StorNext has different mechanisms for moving data stripe groups versus 
metadata/journal stripe groups.) 

Launching the Movement 
Wizard 6

Use the following procedure to perform stripe group movement.

1 From the SNFS home page, choose Move Stripe Group from the 
Admin menu. The Move Stripe Group screen appears, showing the 
following information for completed moves and moves in progress: 

• File System: The name of the file system involved in the move

• Type: Specifies whether the move is for a data stripe group or a 
metadata/journal stripe group

• Lun/Stripe Group: The name of the lun/stripe group involved in 
the move

• Start Time: The date and time the move was launched

• Percentage Complete: The current percentage complete status 
for the move

• Status: For current moves the status will be Progress. For 
previously completed moves the status will be either Success or 
Fail.

Note: During Stripe Group Movement, affinities are preserved when 
files are moved from one stripe group to another. 
Consequently, there must be sufficient space on one or more 
destination stripe groups for any affinities on the source stripe 
group. (You must add any affinities from the source stripe 
group to the new stripe group.)
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Figure 101  Move Stripe Group 
Screen

2 To update the percentage complete for a move in progress, click 
Refresh. 

To remove previously completed moves (with either a Success or 
Fail status,) click Clear.

3 To view details about either a previously completed move or a move 
in progress, click the link in the Status column. The status window 
for completed moves shows files skipped and files defragmented. 
The status for moves in progress shows percentage complete.

4 Click Move to launch the Movement Wizard. The Move Stripe 
Group  - Introduction screen appears.
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Figure 102  Move Stripe Group 
Introduction Screen

5 Select the file system for which you want to move stripe groups. Click 
Next to continue. 

6 A message reminds you that you must check your file system before 
beginning the movement process. 

Do one of the following:

• If you have not checked the selected file system, click Cancel and 
then run the file system check as described in Checking the File 
System on page 143.

• If you have already checked the selected file system, click OK to 
proceed. The Move Options screen appears.
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Figure 103  Move Options 
Screen

7 Specify whether to move a data stripe group or a metadata or journal 
stripe group. (You cannot move a stripe group that contains both user 
data and metadata/journal data on the same LUN.) Click Next to 
continue. 

If you are migrating ONLY a metadata/journal stripe group, go to 
step 9—page 158.

If you are migrating a data stripe group, the Data Stripe Group 
Move screen appears. 
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Figure 104  Data Stripe Group 
Move Screen

8 Select the source stripe group from which data will be moved. The 
stripe group you select will be marked as read only, and data from 
the stripe group will be distributed among one or more available 
stripe groups. (This feature does not allow you to specify the 
destination stripe groups.)

If there are no writable destination stripe groups available, you will 
receive a warning message and not be allowed to continue. If you 
receive this message you must first create destination stripe groups 
before you proceed with the move.

Figure 105   No Writable Stripe 
Groups Warning
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Similarly, if StorNext determines that the available destination stripe 
groups are not large enough to accommodate the data on the source 
stripe group, you will receive a warning message and not be allowed 
to continue using the selected source stripe group.

Figure 106  Destination Stripe 
Group Too Small Warning

Click Next to continue. If you are migrating only data stripe groups, 
the Complete Stripe Group Move screen appears. Go to step 12—
page 160. 

9 When you move a metadata/journal stripe group, a message informs 
you that the file system must be stopped during the move. 

Figure 107  Metadata Stripe 
Group Message

10 Click OK to continue. The Metadata/Journal Move screen appears.
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Figure 108  Metadata/Journal 
Move Screen

11 Select from the displayed lists of available LUNs the source (from) 
LUN and the destination (to) LUN. Click Insert to continue. The LUN 
pair are displayed beneath the SOURCE>>DESTINATION heading.

If you made a mistake during selection, you can clear the LUN pair 
by clicking Remove, and then repeat the selection. 

When you are ready to continue with the move, click Next. The 
Complete Stripe Group Move screen appears.
StorNext User’s Guide 159



Chapter 6  Managing the File System
Performing Stripe Group Movement
Figure 109  Complete Stripe 
Group Move Screen

12 On the Complete Stripe Group Move screen, verify the displayed 
information about the move and then click Next to continue. The 
Process Initiated status screen appears.

Note: The figure shows the Complete Stripe Group Move 
screen for a metadata stripe group move. The screen for a 
metadata/journal stripe group move looks similar.
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Figure 110  Process Initiated 
Status Screen

13 After the status screen informs you that the move was initiated 
successfully, click Finish to exit the wizard. 

Completing Metadata 
Stripe Group Movement 6

After the move begins, follow these steps to complete the operation.

1 Check move status by clicking the move’s Status link on the Move 
Stripe Group screen (figure 101 on page 154). 

The status screen for a move in progress shows the process ID, 
current files, and number of files copied. This screen looks similar to 
this:
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Figure 111  Stripe Group Move 
Status Screen

2 When the move status is Success, mark the source stripe group as 
“down” and then restart the file system.

3 If the status is Failed, click the link to determine the cause of failure. 
If desired, retry the move.

Reusing a Stripe Group 
After a Move 6

If you want to remove LUNs and the associated stripe group following a 
successful move, you must follow these steps:

1 Mark the stripe group as “Down” as described in Modifying a Stripe 
Group on page 112.

2 From the command line interface, rename the downed stripe group. 
(You cannot accomplish this step through the GUI.)
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StorNext configures, allocates, and manages all components associated 
with libraries. Resources that can be used for libraries include a wide 
variety of storage drives and media. Once configured, StorNext performs 
automated and manual operations to ensure the libraries resources are 
operating at efficient levels and in stable states. StorNext also offers 
flexibility when maintaining or replacing library components by 
minimizing system downtime.

This chapter describes the following tasks that help you manage your 
library: 

• Adding a Library

• Modifying a Library

• Deleting a Library 

• Auditing a Library 

• Changing the Library State
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Adding a Library

Use the procedure in this section to add libraries to StorNext. StorNext’s 
Storage Manager (SNSM) component supports three library types: 

• SCSI: A SCSI or fibre channel-attached library. 

• Network (ACSLS or DAS): A network-attached library. There are 
two types of network-attached library: ACSLS or DAS. 

• Vault: A library that stores media moved from a robotic library. A 
vault library is used to only store media, and cannot be reconfigured 
after it has been designated as a vault.

When adding a library to StorNext, follow the instructions specific to 
your library type.

Starting the Add Library 
Wizard 7

Use this procedure to launch the Add Library wizard.

1 From the StorNext home page, choose Add Library from the Config 
menu. The Library Introduction screen appears, showing all 
currently configured libraries. 
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Figure 112  Library Introduction 
Screen

2 Click Next. The Library Type screen appears. 
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Figure 113  Library Type 
Screen

3 Select the type of library you have: SCSI, Network, or Vault. (If you 
select Network, choose ACSLS or DAS from the drop-down list.) 

4 Click Next to continue.

5 Follow the procedures for your library type

• Adding a SCSI Library on page 167

• Adding an ACSLS Network Library on page 171

• Adding a DAS Network Library on page 172

• Adding a Vault Library on page 176
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Adding a SCSI Library 7 After you specify SCSI on the Library Type screen and then click Next, 
the Library Name screen appears.

Figure 114  Library Name 
Screen

(If you have no SCSI libraries configured, a message informs you that no 
SCSI devices were detected. If you receive this message, configure the 
library and devices before proceeding.) 
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1 On the Library Name screen, accept the default library name or type 
a name, and then click Next. The Media Types screen appears.

Figure 115  Media Types 
Screen

2 Select a media type from the list, and then click Next. The SCSI 
Device screen appears.
StorNext User’s Guide 168



Chapter 7  Managing Libraries
Adding a Library
Figure 116  SCSI Device 
Screen
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3 Select a SCSI device from the list and click Next. The Complete Add 
Library Task screen appears.

Figure 117  Complete Add 
Library Task Screen

4 Review your selections. When finished, click Next to complete the 
task or Back to make changes.

5 After the status screen informs you that the library was successfully 
added, click Close.
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Adding an ACSLS 
Network Library 7

After you select Network on the Library Type screen and then choose 
ACSLS from the drop-down list, the Library Name screen appears. 

Figure 118  ACSLS Library 
Name Screen

1 Enter the fields on the Library Name screen.

• Library Name: The name of the library. This can be any name 
you choose.

• Host Name: The actual host name or IP address of the ACSLS 
server.

2 Click Next to continue. The Media Types screen (figure 115 on 
page 168) appears.

3 Select a media type from the list and click Next. The Complete Add 
Library Task screen (figure 117 on page 170) appears.

4 Review your selections. Click Next to complete the task, or Back to 
make changes.
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5 After the status screen notifies you that the library was successfully 
added, click Close.

Adding a DAS Network 
Library 7

After you select Network on the Library Introduction screen and then 
choose DAS from the drop-down list, the DAS Configuration screen 
appears.

Figure 119  DAS Configuration 
Screen

1 Do one of the following:

• Select the Failover option, or both the Failover and Dual Aisle 
options, click Next, and proceed to Adding a DAS Network 
Library with Failover on page 173.

• Select only the Dual Aisle option, click Next, and proceed to 
Adding a DAS Network Library with or without Dual Aisle 
Configuration on page 175.
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Adding a DAS Network Library with Failover 7

1 On the Library Name screen, enter valid values and click Next.

Figure 120  DAS Library Name 
Screen

• Library Name: The name of the library. This can be any name 
you choose

• DAS Server Name: The name of the DAS server

• DAS Client Name: The name of the DAS client configured on the 
DAS server

• Standby Server Host Name: Standby server host name 
configured on the network

Note: For more information about failover or dual aisle 
configurations, contact the Quantum Technical Assistance 
Center. Refer to Customer Assistance on page 319 for 
contact information.
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• Standby Server Client Name: Standby server client name 
configured on the network

The Media Types screen appears.

Figure 121  DAS Media Types 
Screen

2 Use the drop-down lists to map the mail boxes (EIF ports) to specific 
media, and then click Next. The Complete Add Library Task screen 
(figure 117 on page 170) appears.

3 Review your selections. Click Next to complete the task, or Back to 
make changes.

4 After a status screen informs you that the library has been 
successfully added, click Close.
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Adding a DAS Network Library with or without Dual Aisle 
Configuration 7

1 On the Library Name screen, enter valid values and click Next.

Figure 122  DAS 2 Library 
Name Screen

• Library Name: The name of the library. This can be any name 
you choose.

• Host Name: The actual host name or IP address of the DAS 
server.

• Client Name: The name of the client for the current 
configuration. The client name is queried by StorNext and 
automatically displayed.

The DAS Media Types screen (figure 121 on page 174) appears.

2 Use the drop-down lists to map the mail boxes (EIF ports) to specific 
media, and then click Next. The Complete Add Library Task screen 
(figure 117 on page 170) appears.

3 Review your selections. Click Next to complete the task, or Back to 
make changes.
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4 After a status screen informs you that the library was successfully 
added, click Close.

Adding a Vault Library 7 After you select Vault on the Library Type screen, the Library Name 
screen appears. 

Figure 123  Vault Library Name 
Screen

1 Type a name for the library (or accept the displayed default name), 
and then click Next. The Complete Add Library Task screen 
(figure 117 on page 170) appears.

2 Review your selections. Click Next to complete the task, or Back to 
make changes.

3 After a status screen informs you that the library was successfully 
added, click Close.
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Modifying a Library 

This task describes how to modify a library by changing its media type. 

1 From the SNSM home page, choose Library > Config Library from 
the Admin menu. The Configure Library screen appears.

Figure 124  Configure Library 
Screen

2 In the Select Library list, select the library you want to modify, and 
then click Modify. The Modify Library screen appropriate to the 
selected library type appears, showing information about the library 
and its associated device.

The following illustration shows the Modify SCSI Library screen. 
The screen for modifying a DAS or ACSLS library looks similar.
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Figure 125  Modify SCSI 
Library Screen

3 According to your needs, move media types from the Unconfigured 
media types list to the Configured media types list, or vice versa. 

To move media, select the desired media type and then click the right 
or left arrow to move the media to the opposite list. (Click the right 
arrow to move the selected media type from the Configured list to 
the Unconfigured list, or the left arrow to move the selected media 
type from the Unconfigured list to the Configured list.)

4 When you are finished moving media to the appropriate list, click 
Apply. The Modify Library Status screen appears. 

5 After the status screen indicates that the library has been modified, 
click Close.

Deleting a Library

Before you delete a library you must do the following:

• Remove ALL media from the library as described in Removing 
Media on page 210.
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• Delete ALL drives associated with the library as described in 
Deleting a Tape Drive on page 190.

1 From the SNSM home page, choose Library > Config Library from 
the Admin menu. The Configure Library screen (figure 124 on 
page 177) appears.

2  Select from the Select Library list the library you want to delete, and 
then click Delete. A message window prompts you to confirm that 
you want to delete the library.

3 Click OK to proceed. The Delete Library Status screen appears.

4 After the status screen indicates that the library has been deleted, 
click Close.

Auditing a Library

Use this procedure to audit a library. An audit is a physical check of each 
library component to verify its integrity and make sure the database and 
library are synchronized. Quantum recommends that you audit the 
library after each restore.

1 From the SNSM home page, choose Library > Audit Library from the 
Admin menu. The Audit Library screen appears.
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Figure 126  Audit Library 
Screen

2 Select from the Select Library list the library you want to audit.

3 If desired, select the Remap Audit option to synchronize the 
StorNext and SNSM databases with the library databases.

4 Click Apply. The library audit launches, and the Library Audit status 
screen appears.

5 After the status screen informs you that the library audit was 
successful, click Close.

Note: Quantum recommends that you select the Remap Audit 
option. If you are using an AML library, the audit could 
take hours or days to complete.

Audits should be run when there are no other processes 
running on the library.
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Changing the Library State

This function allows you to change a library’s logical state to online or 
offline. Logical state means the library could be online, but StorNext treats 
it as offline. 

To physically take a SCSI library offline, use the library’s front panel. To 
take a network library physically offline, use the library's controller 
software.

1 From the SNSM home page, choose Library > Library State from the 
Admin menu. The Change Library State screen appears.

Figure 127  Change Library 
State Screen

2 Select the library whose logical state you want to change. (The 
library’s current state is shown.)

3 Select the new state for the library you selected.

4 Click Apply to change the library’s state.

5 When the Status screen informs you that the library state was 
successfully changed, click OK.

6 If desired, repeat steps 2 - 5 to change the state for additional 
libraries.
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Tape drives provide I/O for a StorNext media library. For a detailed list 
of supported media for the current StorNext release, refer to the StorNext 
Release Notes.

Managing tape drives and disks consists of the following tasks: 

• Working with Tape Drives

• Working with Drive Pools

• Managing Disk Space

• Changing Watermark Parameters

Working with Tape Drives

Working with tape drives involves the following tasks:

• Adding a Tape Drive

• Modifying a Tape Drive

• Deleting a Tape Drive

• Changing a Drive State

• Cleaning a Tape Drive
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Adding a Tape Drive 8 Use this procedure to add tape drives to your libraries. You can add any 
number of connected tape drives to the StorNext system.

1 From the StorNext home page, choose Add Tape Drive from the 
Config menu. (Alternatively, from the SNSM home page, you can 
choose Drive > Config from the Admin menu, and then click Add.)

The Tape Drive Introduction screen appears, listing the number of 
currently configured tape drives and the hardware devices available 
for configuration. 

Figure 128  Tape Drive 
Introduction Screen
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2 Click Next to add a tape drive. The Associated Library screen 
appears.

Figure 129  Associated Library 
Screen

• Configured Libraries list: Select the configured library with 
which to associate the tape drives you are adding.

• Fibre-Channel Attached Drives checkbox: Check this box if you 
have fibre channel-attached tape drives. If you check this box, the 
Match Devices with Slots screen appears. Go to Matching 
Devices with Slots on page 187.

Note: For SCSI direct-attached tapes that are not fibre channel, it 
is not necessary to match the device with the correct slot 
because slot-to-drive matching is automatically 
performed. If StorNext cannot perform slot matching, the 
Match Devices with Slots screen appears.
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3 After you select a configured library on the Associated Library 
screen, click Next. The Hardware Devices screen appears.

Figure 130  Hardware Devices 
Screen

• Hardware Devices list: Select the hardware devices you want to 
add as drives. Drive names are automatically generated in this 
format: <library_dr1>, <library_dr2>

• Enable Compression checkbox: Check this box to allow data 
compression on the tape drives you are adding.
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4 Click Next to continue. The Complete Add Drive Task screen 
appears.

Figure 131  Complete Add 
Drive Task Screen

5 Review your selections. Click Next to complete the task or Back to 
make changes.

6 When the Status screen informs you that the tape drive was 
successfully added, click Next. The Tape Drive Introduction screen 
(figure 128 on page 183) appears.

7 Do one of the following:

• Add more tape drives. Click Next to repeat the Adding a Tape 
Drive procedure (Step 1—page 183).

• When the Status Screen displays Success, click Done. 
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Matching Devices with Slots 8

When you select the Fibre-Channel Attached Drives checkbox on the 
Associated Library screen, the Match Devices with Slots screen appears. 
The system-specific information on this screen varies from configuration 
to configuration.

Figure 132  Match Devices with 
Slots Screen
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1 If you need to see existing drive and slot mappings, click Show 
Mapping Help to display a list of current device mappings. Click 
Close when you are finished viewing the information on the Tape 
Drive Mapping Help screen.

Figure 133  Tape Drive 
Mapping Help Screen

2 On the Match Devices with Slots screen, select from the Device list 
the device you want to configure.

3 Select from the Slot list the slot with which to match the device.

4 Click Insert to add the device/slot combination to the 
Type>>Device>>Slot list.

5 Repeat steps 2 through 4 for each device and slot combination.

Note: In some cases StorNext may not be able to determine the 
device to slot mapping. Limitations include ACSLS and 
DAS libraries.
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Modifying a Tape Drive 8 Use this procedure to modify configured tape drives.

1 From the SNSM home page, choose Drive > Config from the Admin 
menu. The Configure Drives screen appears.

Figure 134  Configure Drives 
Screen

2 Select a drive from the Configured Drive List, and then click 
Modify. The Modify Drive screen appears.

Note: If you want to enable compression on some devices but not 
others in the Type>>Device>>Slot list, you must complete 
this procedure twice: once to enable compression on 
selected devices, and a second time to specify devices 
without compression.
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Figure 135  Modify Drive 
Screen

3 Modify any of the following information:

• Drive Name: The name of the modified drive.

• Dismount Delay: Change the dismount delay time (in seconds).

• Select New Drive Path: The drop-down menu displays available 
drive paths to which the drive can be changed.

• Compression Enabled: Choose Yes to enable, or No to disable 
compression.

4 After making drive modifications, click Apply.

5 After the Status Screen informs you that your modifications were 
made successfully, click Close.

Deleting a Tape Drive 8 Use this procedure to delete a configured tape drive.

1 From the SNSM home page, choose Drive > Config from the Admin 
menu. The Configure Drives screen appears.

2 From the Configured Drive List, select the drive you want to delete, 
and then click Delete. A message prompts you to confirm that you 
want to delete the drive. There is no undo function that will undelete 
the drive if you change your mind, so be absolutely certain you want 
to delete the drive before you continue. 
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Figure 136  Delete Warning 
Window

3 Click OK to close the message window and proceed. 

4 After the Status Screen informs you that the drive has been 
successfully deleted, click Close.

Changing a Drive State 8 The drive state function allows you to change the logical (database) state 
to online or offline.

1  From the SNSM home page, choose Drive > Drive State from the 
Admin menu. The Change Drive State screen appears, showing all 
configured drives and the current state for each drive.

Figure 137  Change Drive State 
Screen

2 Select the drive whose state you want to change.

3 Select the state (Online or Offline) to assign to the selected drive, and 
then click Apply.
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4 After the Status Screen informs you that the drive’s status was 
successfully changed, click Close. The Change Drive State screen 
shows the changed state for the drive you selected.

5 If desired, repeat steps 2 - 4 to change the state for additional tape 
drives.

Cleaning a Tape Drive 8 Use this procedure to manually clean a tape drive.

1 From the SNSM home page, choose Drive > Clean Drive from the 
Admin menu. The Clean Drive screen appears.

Figure 138  Clean Drive Screen

2 Select from the Select Drive List the drive you want to clean, and 
then click Apply. The Clean Drive status screen appears.

3 After the Status screen notifies you that the drive has been cleaned 
successfully, click Close.

Note: To perform this procedure, you must have at least one 
cleaning tape specifically labeled for cleaning. For example, 
CLN_XXX.
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Working with Drive Pools

Drive pools are groups of tape drives allocated for various administrator-
defined storage tasks. Drive pools enable you to delimit storage processes 
based on data type, performance, security, location, or all of these 
variables. Drive pools can reside in a single tape library or span multiple 
tape libraries. 

Working with drive pools involves the following tasks:

• Adding a Drive Pool

• Modifying a Drive Pool

• Deleting a Drive Pool

Adding a Drive Pool 8 Use this procedure to add a drive pool.

1 From the SNSM home page, choose Config Drive Pool from the 
Admin menu. The Configure Drive Pools screen appears.

Note: This procedure requires restarting the Storage Manager 
component.
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Figure 139  Configure Drive 
Pools Screen

2 Click Add to add a new drive pool. The Add New Drive Pool screen 
appears.

Figure 140  Add New Drive 
Pool Screen

3 Enter a name for the new drive pool in the Drive Pool Name field.
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4 Select from the Select Drive IDs list the drives you want to include in 
the new drive pool, and then click Apply. A message window warns 
you that continuing with the task restarts the Storage Manager.

Figure 141  Warning Message 
Window

5 Click OK to close the message window and continue.

6 After the Status screen informs you that the drive pool was 
successfully added, click Close.

Modifying a Drive Pool 8 Use this procedure to modify a drive pool.

1 From the SNSM home page, choose Config Drive Pool from the 
Admin menu. The Configure Drive Pools screen (figure 139 on 
page 194) appears.

2 Select from the Select Drive Pool list the existing drive pool you 
want to change, and then click Modify. The Modify Drive Pool 
screen appears.

Note: This procedure requires restarting the Storage Manager 
component.
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Figure 142  Modify Drive Pool 
Screen

3 Select from the Associated Drives list the drive you want to move to 
the Available Drives list, and then click Remove Left. The drive is 
removed from the Associated Drives list and appears in the 
Available Drives list.

4 If desired, you can also move drives from the Available Drives list to 
the Associated Drives list. To do so, select from the Available Drives 
list the drive you want to move to the Associated Drives list, and 
then click Insert Right. The drive is removed from the Available 
Drives list and appears in the Associated Drives list.

5 Click Apply. A message window warns you that continuing with the 
task restarts the Storage Manager.

Figure 143  Restart Message 
Window

6 Click OK to close the message window and proceed.
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7 After the status screen informs you that your drive pool 
modifications were successful, click Close. 

Deleting a Drive Pool 8 Use this procedure to delete a drive pool. You cannot delete a drive pool 
if there are drives currently associated with it. To disassociate drives from 
the drive pool, see Modifying a Drive Pool on page 195.

1 From the SNSM home page, choose Config Drive Pool from the 
Admin menu. The Configure Drive Pool screen (figure 139 on 
page 194) appears.

2 Select from the Select Drive Pool list the drive pool you want to 
delete, and then click Delete. A message window asks you to confirm 
that you want to delete the drive pool. There is no undo function that 
will undelete the drive pool if you change your mind, so be 
absolutely certain you want to delete the drive pool before 
continuing.

Figure 144  Delete Warning 
Message

3 Click OK to close the message window and continue.

4 After the Status screen informs you that the drive pool was 
successfully deleted, click Close. 

Caution: At least one drive pool must be configured at all times. Do 
not delete the default drive pool.
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Managing Disk Space

This function allows you to apply a storage policy or truncation policy to 
a file system, and to adjust other parameters that help you manage disk 
space.

1 From the SNSM home page, choose Disk Space from the Admin 
menu. The Manage Disk Space screen appears.

Figure 145  Manage Disk 
Space Screen

2 Select from the File Systems list the file system that contains the disks 
whose space you want to manage. 

3 Enter the following fields:

• Storage Policy: Choose this option to apply a storage policy to 
the file system.

OR

• Truncation Policy: Choose this option to apply a truncation 
policy to the file system. 

• Execute at Highest Priority: Choose this option to make your 
storage or truncation policy execute at the highest priority.
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• Stop at Occupied Disk Space: Specify the disk-full percentage at 
which the storage or truncation policy is no longer applied.

• MINTIME Before File Migration: If you chose the Storage Policy 
option, enter the minimum amount of time (in minutes) before a 
file is migrated.

• MINTIME Before File Truncation: If you chose the Truncation 
Policy option, enter the minimum amount of time (in days) 
before a file is truncated.

• Minimum File Size to Truncate: If you chose the Truncation 
Policy option, enter the minimum size (in bytes) a file must be 
before it is eligible for truncation.

4 Click Apply to continue.

5 After the Status screen informs you that the operation was performed 
successfully, click OK.

Changing Watermark Parameters

Watermarks help you determine disk space thresholds for your file 
system. These thresholds determine the point at which StorNext applies 
or stops applying a truncation policy. This function also allows you to 
specify a minimum usage percentage, which is the percentage of 
occupied disk space the nightly truncation policy attempts to achieve.
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1 From the SNSM home page, choose Watermark Parameters from the 
Admin menu. The Change Watermark Parameters screen appears.

Figure 146  Change Watermark 
Parameters Screen

2 Select from the Managed File System(s) dropdown list the file 
system for which you want to set watermark parameters.

3 Enter the following fields:

• Low Watermark %: Enter the percentage of occupied disk space 
a file system must reach before StorNext stops applying the 
truncation policy. 

• High Watermark %: Enter the percentage of occupied disk space 
a file system must reach before StorNext applies a truncation 
policy. 

• Min Use %: Enter the target percentage of occupied disk space 
the nightly truncation policy should attempt to achieve.

4 Click Apply to continue.

5 After the Status screen informs you that the operation was performed 
successfully, click OK.
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In StorNext, data is usually stored on tapes in a media library. For a 
detailed list of supported media, refer to the StorNext Release Notes. 

Managing tape media consists of the following tasks: 

• Adding Media to a Configured Library

• Removing and Moving Media

• Using the SNSM Media Functions

Adding Media to a Configured Library 

The following task describes how to add media to a configured library.

Caution: If you are sharing a library between applications, refer to 
the StorNext Installation Guide. 

Caution: Before continuing with this procedure, make sure there is 
no media in your tape drives.
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1 From the StorNext home page, choose Add Media from the Config 
menu. The Add Media - Introduction screen shows a list of current 
libraries, along with the number of media each library can hold.

Figure 147  Add Media - 
Introduction Screen
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2 Click Next to add media to a configured library. The Associated 
Library screen appears.

Figure 148  Associated Library 
Screen
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3 On the Associated Library screen, select a configured library to 
which you want to add media, and then click Next. The second 
Associated Library screen appears.

Figure 149  Associated Library 
Screen 2

If you selected a media vault on the first Associated Library screen, 
go to Step 1—page 207.

4 On the second Associated Library screen, do one of the following: 

• Specify Mailbox and click Next. 

• Specify Bulk Load and click Next. Go to step 6 on —page 206
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5 When you specify Mailbox on the Associated Library screen, the 
Select Mailbox screen appears. 

Figure 150  Select Mailbox 
Screen

Select a mailbox and click Next.
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6 When the Complete Add Media Task screen appears, review your 
selections. 

Figure 151  Complete Add 
Media Task Screen

Click Next to complete the task or click Back to make changes.

7 After a status screen informs you that media has been successfully 
added, click Finish.
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Adding a Vault 9 Use this procedure to add a vault to the library.

1 When you select a media vault on the Associated Library screen, the 
Select Media Type screen appears.

Figure 152  Select Media Type 
Screen
StorNext User’s Guide 207



Chapter 9  Managing Media
Adding Media to a Configured Library
2 On the Select Media Type screen, select the type of media you want 
to add to the vault. The Add Media IDs screen appears.

Figure 153  Add Media IDs 
Screen

3 On the Add Media IDs screen, do one of the following:

• Enter the name for the new media in the Media Name field. Go 
to Step 5—page 209.

• Select one or more previously entered media IDs from the list, 
and then click Next. Go to Step 6—page 209.
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• Add multiple media labels by clicking the New Media button. 
The Create New Media ID screen appears.

Figure 154  Create New Media 
ID Screen

4 On the Create New Media ID screen, perform the following steps:

1 Enter the new media label name.

2 Enter the number of media IDs you want to generate for the label.

3 Enter a starting value for the new media ID.

4 If you want to create additional media IDs, click Apply and 
repeat steps 1 through 3.

5 When you are finished creating media IDs, click OK to save your 
changes and exit.

The Add Media IDs screen appears again.

5 On the Add Media IDs screen, select one or more media IDs from the 
list, and then click Next to continue. The Complete Add Media Task 
screen (figure 151 on page 206) appears.

6 On the Complete Add Media Task screen, click Next to finish adding 
the media, or Back to make changes. 

7 After the status screen informs you that the media has been 
successfully added, click Finish.

Caution: StorNext will use and overwrite all available tapes, so 
make sure only the library contains only media you want 
StorNext to use.
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Removing and Moving Media

These procedures enable you to remove or move media from a library to 
a different library or vault while preserving the existing data.

• Removing Media

• Moving Media

Removing Media 9 Use this procedure to remove blank media, backup tapes, or cleaning 
media from the StorNext system.

1 From the StorNext home page, choose Remove/Move Media from 
the Admin menu. The Remove or Move Media screen appears.

Figure 155  Remove or Move 
Media Screen

2 Click Remove Media.
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3 Select from the Select Library list the library from which to remove 
the media. If the library has more than one media type, specify the 
type of media you want to remove from the selected library. Click 
Next to continue. The Select Media screen appears.

Figure 156  Select Media 
Screen

4 To remove individual media, enter the media name in the Enter 
Media field and click OK. The Complete Remove/Move Media Task 
screen appears. Go to Step 10—page 213.
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5 To remove multiple media, click Browse. The StorNext Media 
Browser screen appears. 

Figure 157  StorNext Media 
Browser Screen

6 On the StorNext Media Browser screen, select the Media Class to 
remove: Blank, Cleaning, or Backup. The StorNext Media Browser 
screen displays in the Select Media field all the media associated 
with the class you have selected. The Current Media Class field 
shows the media class you just selected.

7 If desired, you can use the Media Filter field to narrow your search of 
your selected media type. For example, to display all media with 01 
in its name, enter *01* (where the asterisks are wild cards 
representing any characters before or after the specified search 
criteria).

8 Select from the Select Media list the specific media you want to 
remove (any number of media from one to all), and then click OK to 
close the StorNext Media Browser screen. The Select Media screen 
reappears, showing the selected media.
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9 Select from the Media List the media you want to remove, and then 
click Next. The Complete Remove/Move Media Task screen 
appears.

Figure 158  Complete Remove/
Move Media Task Screen

10 Review your selections and click Next to apply them or Back to make 
changes. The Remove/Move Media status screen appears.
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11 After the status screen informs you that the media has been 
successfully removed, click Finish. The Library Operator Interface 
(LOI) screen appears.

Figure 159  Library Operator 
Interface Screen

12 The name of the library on which the media resides is displayed. 
Click Eject Media. The Library Operator Interface screen updates 
and indicates the selected library. Available media operations for 
each library are shown.

Figure 160  LOI Eject Screen
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• Select All: Click this button to select all media in the Select 
Media list for removal

• Deselect All: Click this button to deselect all media in the Select 
Media list

• Details: Click this button to view information about selected 
media

• Eject: Click this button to eject (remove) media from the library

• Fail: Click this button to mark selected media as Failed

• Close: Click this button to close the current window

13 For the selected media IDs, click Eject. 

14 Click Close.

Moving Media 9 Use this procedure to move data, blank media, backup tapes, or cleaning 
media to another library.

1 From the StorNext home page, choose Remove/Move Media from 
the Admin menu. The Remove or Move Media screen (figure 155 on 
page 210) appears.

2 Select Move Media.

3 Select from the Select Library list the library from which to remove 
the media. Select from the Media Type list the media type. Click 
Next to continue. The Select Media screen (figure 156 on page 211) 
appears

4 To move individual media, enter a media name in the Enter Media 
field and click OK. The Complete Remove/Move Media Task screen 
(figure 158 on page 213) appears. Go to Step 7—page 216.

5 To move multiple media, click Browse. The StorNext Media Browser 
screen (figure 157 on page 212) appears. 

Note: All of the media operations described may not be available 
for each library.

Note: If you are using a vault library, you must manually move 
the media.
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6 Select a media class. The Select Media list is populated with all 
available media in the class you selected.

7 Select from the Select Media list the media you want to move, and 
then click OK. The Select Media screen reappears, showing your 
selection.

8 Click Next to continue. The Select Destination Library appears.

Figure 161  Select Destination 
Library Screen

9 Select the destination library from the list, and then click Next. The 
Complete Remove/Move Media Task screen (figure 158 on 
page 213) appears.

10 Click Next to continue.
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11 After the status screen informs you that the task was completed 
successfully, click Finish. The Library Operator Interface (LOI) 
screen appears with the source library flagged.

Figure 162  Library Operator 
Interface Screen

12 Eject the media from the source library, and then click the highlighted 
Eject Media button. The LOI Eject screen (figure 160 on page 214) 
appears.

13 Select the media to be moved, and then click Eject. Click Close to 
continue. The LOI screen reappears with the destination library 
flagged.
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14 Move the media to the destination library and click the highlighted 
Enter Media button. The LOI Enter screen appears.

Figure 163  LOI Enter Screen

15 Click Eject to continue, and then click Close. The LOI screen 
reappears without flags or highlights.

16 Click Close to finish.

Using the SNSM Media Functions

The StorNext Storage Manager’s Media menu contains functions that 
enable you to accomplish the following tasks:

• Moving Media Manually.

• Mounting and Dismounting Media.

• Adding Media Types to a Policy Class.

• Removing Media From the Storage Manager.

• Moving Blank Media.
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• Transcribing Media.

• Changing Media Attributes.

• Reclassifying a Media Class Grouping.

• Cleaning Media.

• Cancelling the Eject Media Process.

These functions are not available if you have only StorNext File System 
and not StorNext Storage Manager.

Moving Media Manually 9 Use this function to flag media you plan to move manually from the 
source library to a destination library. After you use this function you 
must manually remove the media from the source library and use the 
Library Operator Interface (LOI) to enter the media into the destination 
library.

1 From the SNSM home page, choose Library > Manual Move from 
the Media menu. The Move Files to New Media screen appears.

Figure 164  Move Files to New 
Media Screen

2 Select from the Source Archive dropdown list the source library that 
contains the media you want to move. 
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3 Click Browse when you are ready to flag specific media for moving 
manually. The Media Browser screen appears.

Figure 165  Media Browser 
Screen

4 On the Media Browser screen, select from the Select Media list the 
media you plan to move manually. If desired, you can reduce the 
number of entries in the media list by entering a filter in the Media 
Filter field. This field accepts the wildcard character (asterisk *). You 
can also select all media by clicking the Select All button.

5 Click OK after you are finished selecting media.

6 Select from the Destination Archive dropdown list the destination 
library to which you plan to manually move the media you just 
selected. 

7 When you are ready to flag the selected media for moving manually, 
click Apply. 

8 When the Status screen informs you that the media have been 
successfully flagged for moving manually, click OK. 
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Mounting and 
Dismounting Media 9

Use the procedures in this section to mount and dismount media in a tape 
drive as needed.

Mounting Media 9

Use the following procedure to mount media.

1 From the SNSM home page, choose Library > Mount from the Media 
menu. The Mount Media screen appears.

Figure 166  Mount Media 
Screen

2 Select from the Archive drop-down menu the archive that contains 
the media you want to mount. The screen updates to show available 
media in the archive you selected.

3 Select from the Media ID list the media you want to mount.

4 If desired, use the Filter field to narrow your search when looking for 
a specific media ID. For example, enter *01 and click the Filter button 
to find all media IDs ending in 01. 

5 Select from the Drive ID drop-down menu the drive in which you 
wish to mount the media.

6 Review your selections and then click Apply.
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7 After the Status screen informs you that the task has completed 
successfully, click Close.

Dismounting Media 9

Use the following procedure to dismount media.

1 From the SNSM home page, choose Library > Dismount from the 
Media menu. The Dismount Media screen appears.

Figure 167  Dismount Media 
Screen

2 Select either a Media or Drive ID from the drop-down menu. 
Depending on which ID you selected, the information in the other 
field automatically populates.

3 Review your selections and click Apply.

4 After the Status screen informs you that the operation was successful, 
click Close.

Adding Media Types to a 
Policy Class 9

Use this function to add media types to add to a policy class. The media 
type you specify must be available in the library before you can add it to a 
policy class.
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1 From the SNSM home page, choose Add from the Media menu. The 
Add Media screen appears.

Figure 168  Add Media Screen

2 Select the media type you want to add to the policy class.

3 Select from the Policy Class dropdown list the policy class to which 
you want to add the media type.

4 Enter in the Number of Media field the number of media (of the 
specified media type) you want to add.

5 Specify the format type: Delay or Immediate.

6 Click Apply when you are ready to add media to the policy class.

7 When the Status screen informs you that the media have been 
successfully added to the policy class, click OK. 

Removing Media From 
the Storage Manager 9

Use this function to remove media from the StorNext Storage Manager. 
When you use this function all files are removed from the selected media, 
and the media is ejected from the library into the EIF (mailbox).
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1 From the SNSM home page, choose Remove from the Media menu. 
The Remove Media From SNSM screen appears.

Figure 169  Remove Media 
From SNSM Screen

2 Select from the Select Media list the media you want to remove. To 
reduce the number of media shown, you can enter a search filter in 
the Enter Filter field. This field accepts the wildcard character 
(asterisk *).

3 Click Apply when you are ready to remove media.

4 When the Status screen informs you that the media were successfully 
removed, click OK. 

Moving Blank Media 9 This function allows you to assign (move) blank media to a policy class. 
Blank media must exist in the library before you can move the media to a 
policy class.
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1 From the SNSM home page, choose Move Blank from the Media 
menu. The Move Blank Media screen appears.

Figure 170  Move Blank Media 
Screen

2 Select from the Select Media list the blank media you want to move. 

3 Select from the Select Policy Classes list the policy class to which you 
want to move the blank media you selected.

4 Click Apply when you are ready to move the selected blank media.

5 When the Status screen informs you that the blank media were 
successfully moved, click OK. 

Transcribing Media 9 You can either transcribe the contents of one media type to another media 
type, or reclaim (defragment) media. During the transcription or 
reclamation process, SNSM uses two drives to transcribe one media to 
another media, file by file.

 

Caution: For SNSM to successfully transcribe one media to another 
media, two drives must be online. If only one drive is 
online, the transcription or reclamation process fails.
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1 From the SNSM home page, choose Transcribe from the Media 
menu. The Transcribe Media screen appears.

Figure 171  Transcribe Media 
Screen

2 Select from the Select Media to Transcribe list one or more media, 
and then click Apply.

3 After the status screen informs you that the media has been 
transcribed, click Close.

If transcription or reclamation starts and all the drives are in use, SNSM 
prioritizes and queues the job. When two drives become available, the 
queued job starts and all active files are transcribed. When transcription 
is complete, SNSM updates the database to reflect the new location of the 
files. 

If the transcription or reclamation process encounters a file that spans 
multiple media, only the portion of the file that exists on the old media is 
transcribed. 

When the transcription or reclamation process is complete, only deleted 
files remain on the source media. To remove the source copy of the 
deleted files, you must clean the media as described in Cleaning Media 
on page 230. After the cleaning process is complete and the source copy 
of the deleted files are removed, the media is available for reuse as blank 
media. 
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Changing Media 
Attributes 9

This function allows you to change the current state of one or more pieces 
of media. You can change the state to one of the following:

• Unsuspect: Indicates that the media is physically sound and not in a 
suspect (potentially damaged or unusable) condition.

• Write Protect: Write protected media cannot be overwritten or have 
data added.

• Write Unprotect: This media can be overwritten or have data added. 

• Available: The media is available for writing or reading.

• Unavailable: The media is not available for writing or reading.

• Unmark: Cancels an “Error” or “Checkout” state and makes the 
media either accessible or available for checkout, respectively.

1 From the SNSM home page, choose Attributes from the Media 
menu. The Change Media Attributes screen appears.

Figure 172  Change Media 
Attributes Screen

2 Specify the new state you want to apply to the media.

3 Select from the Select Media list the media to which you want to 
apply the new state you specified.

4 Click Apply to change the states of the media you selected.
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5 When the Status screen informs you that the media statuses were 
successfully changed, click OK. 

Reclassifying a Media 
Class Grouping 9

A media class grouping is a media management tool that segregates 
media into classes. Membership in a media class grouping is exclusive, so 
media can belong to only one class grouping. Media class groupings are 
restricted to one type of media. 

For example, LTO media cannot belong to a media class grouping that 
contains AIT media. When media is initially imported into the SNSM, it 
enters a media class grouping. Import mapping to media class is 
automatic and driven by media type. 

1 From the SNSM home page, choose Reclassify from the Media 
menu. The Reclassify Media screen appears.

Figure 173  Reclassify Media 
Screen
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2 Select from the Source Media Class list the desired source media 
class, and then click Browse to select the media IDs you want to 
reclassify. The Media Class Browser window appears.

Figure 174  Media Class 
Browser Window

3 Select one or more media from the Select Media list, and then click 
OK to return to the Reclassify Media screen. The IDs for the selected 
media are shown in the Entered Media IDs list.

4 Select from the Destination Media Class list a destination for media 
IDs, and then click Apply. 

The new media class must be associated with the type of media you 
are reclassifying. For example, if you select 3590 BACKUP as your 
source media class, select 3590 DATA as your destination media 
class. 

5 After the Status screen informs you that the operation was successful, 
click Close.

Caution: Your source and destination media types must be the 
same. For example:

Source: F0_3590_DATA

Destination: F0_3590_CLEAN
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Cleaning Media 9 This function allows you to clean a file system, policy class, or media. 
Periodic cleaning helps prevent inactive information from growing to an 
unmanageable size. When you run this function, the StorNext Storage 
Manager removes inactive files that have not been accessed since the 
specified endtime. This process does not affect current file versions on the 
media. 

1 From the SNSM home page, choose Clean from the Media menu. The 
Clean Media screen appears.

Figure 175  Clean Media 
Screen

2 Do one of the following:

• Select from the File System list the file system you want to clean.

• Select from the Media list IDs for specific media you want to 
clean.

• Select from the Policy Class list specific policy classes you want 
to clean.

Caution: Inactive file versions cleaned from the media cannot be 
recovered or used again.
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3 Specify at the Endtime field an ending time for the cleaning process, 
using the format YYYY:MM:DD:hh:mm:ss. For example, enter 
2007:12:06:10:08:00 for an endtime of 10:08 on December 6, 2007. 

4 Click Apply to start the cleaning process.

5 When the Status screen informs you that the operation was 
completed successfully, click OK.

Cancelling the Eject 
Media Process 9

Use this function to cancel the eject process for selected media. The media 
remains in the assigned slots. 

1 From the SNSM home page, choose Library > Library State from the 
Admin menu. The Cancel Eject Process screen appears. 

Figure 176  Cancel Eject 
Process Screen

2 Select from the Media ID list the media for which you want to cancel 
the eject process. If necessary, select a library from the Library list to 
view and select media in that library. To select all media in the Media 
ID list, click the Select All button. 

3 Click Apply to cancel the eject process for the selected media.

4 When the Status screen informs you that the operation was 
successful, click OK.
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StorNext provides the ability to configure storage disks that function and 
operate the same way as physical tape media. Storage disks are external 
devices on UNIX-based file systems that can be used for long term data 
storage. 

When a storage disk is configured, the StorNext Storage Manager moves 
data to storage disks for long-term retention in addition to, or instead of 
tape. This enables users to leverage the specialized third-party 
functionality of appliances or store small files that might take longer to 
retrieve from tape. Many users will still use tape for long- term storage 
and vaulting, but storage disk can be used to create tape-free archives.

Here are a few differences storage disks have over tape media, aside from 
the obvious cost-saving benefit:

• A storage disk either belongs to no policy class, or belongs to a single 
policy class

• A storage disk can store file copies only with the same copy ID

After you create a storage disk, observe the following usage 
recommendations:

• If your file system includes storage disks, avoid using that file system 
for any data other than storage disk stored data.

Note: Before you create a storage disk, the disks you plan to use 
must reside in an existing, mounted file system.
StorNext User’s Guide 232



Chapter 10  Managing Storage Disks
Storage Disk Deduplication
• Use complete and physically dedicated file systems (snfs, local, nfs, 
or other,) for storage disk data, not shared file systems or file systems 
with linked directories.

• If your file system includes storage disks and you accidentally fill it 
with unrelated user data (i.e., non-storage disk data,) call the 
Quantum Technical Assistance Center and ask for a procedure to 
clean up and transcribe data.

Storage Disk Deduplication

StorNext supports storage disk deduplication only on non-managed file 
systems. Deduplication frees disk space by eliminating redundant data. 
The deduplication process does not retain duplicate data, so there is only 
one copy of the data to be stored. (Indexing of all data is retained in case 
that data is required later.) The main benefit of deduplication is that it 
reduces storage capacity requirements because only unique data is 
stored. Without deduplication, offline copies of a file consume as much 
disk space as the original file.

When you create a new storage disk, you will be given the option of 
enabling deduplication. StorNext refers to a storage disk with 
deduplication enabled as a dedup SDISK. If your system configuration 
consists only of storage disks, the same rules that apply to storage disks 
apply to deduplication-enabled storage disks. For example, in a storage 
disk-only configuration the first storage disk must always use file copy 1. 

You can create up to 4 dedup sdisks. (You can have a total of 16 storage 
disks, of which 4 can be dedup sdisks.) 

You must have a minimum of 2GB of RAM for each dedup sdisk you 
plan to use. 

At this time storage disk deduplication is supported only on 32 bit and 64 
bit Linux platforms. 

Note: The 2GB of RAM per dedup sdisk is in addition to the memory 
required for StorNext.
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Adding a Storage Disk

Storage disks are treated the same as media in the system. Before you 
configure a new storage disk, the disk you want to use must be in a file 
system that is already created and mounted.

Use the following procedure to add storage disks. 

1 From the SNSM home page, choose Storage Disk > Config from the 
Admin menu. The Configure Storage Disk screen appears.

Figure 177  Configure Storage 
Disk Screen

Note: When you are creating storage disks, exercise caution before 
enabling the deduplication feature. Once you create a dedup 
SDISK, you cannot change it to a non-enabled storage disk. 
Conversely, you cannot convert a non-enabled storage disk to 
a dedup SDISK. However, you can delete a non-enabled 
storage disk or dedup SDISK and then recreate the storage 
disk with deduplication either enabled or disabled.
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2 Click Add. The Add Storage Disk - Introduction screen appears, 
listing any currently configured storage disks.

Figure 178  Add Storage Disk - 
Introduction Screen
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3 Click Next. The Add Storage Disk screen appears.

Figure 179  Add Storage Disk 
Screen

4 Enter the fields on the Add Storage Disk screen. 

• Storage Disk Name: Enter a name for the storage disk, or accept 
the displayed default name.

• Enable Deduplication: Select this option if you want to enable 
deduplication and create a dedup SDISK. Once deduplication is 
enabled, you cannot disable it after the storage disk has been 
created. Likewise, if deduplication is NOT enabled at this time, 
you cannot enable it later. 

• Select a File System Mount Point: Select a file system mount 
point for the storage disk. If deduplication is enabled, the mount 
point must be on a non-managed StorNext file system.

• Click Browse to Select a Directory for Storage Disk Files: Click 
the Browse button to display the Directory Browser window. On 
this window select or create a directory on which to store storage 
disk files.
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• Copy # Used for all Policy Classes: Select the copy number 
(Copy 1, Copy 2, Copy 3, or Copy 4) for the new storage disk. 
This copy number will be used by all policy classes.

5 Click Next. The Complete Storage Disk screen appears.

Figure 180  Complete Storage 
Disk Screen

6 Review information for the new storage disk. Click Next to complete 
the task or Back to make changes.

7 After the Status screen informs you that the storage disk was 
successfully added, click Finish.

Note: Only copies of the number you choose can be written to 
this disk. For example, if you select copy number 1, only 
files with that copy number can be written to the storage 
disk.
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Modifying a Storage Disk

Use this procedure to modify a previously configured storage disk.

1 From the SNSM home page, choose Storage Disk > Config from the 
Admin menu. The Configure Storage Disk screen (figure 177 on 
page 234) appears.

2 Select a storage disk from the Current Storage Disks list, and then 
click Modify. The Modify Storage Disk screen appears.

Figure 181  Modify Storage 
Disk Screen

3 Modify any of the following information:

Note: For a blank storage disks (i.e., a storage disk that has not 
been written to, and one where no file system files reside,) 
you can modify any of the parameters on the Modify 
Storage Disk screen. If the storage disk has been written 
to, you can change only the number of streams.
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• Mount Point: The file system mount point for the storage disk. 
You can change the mount point only on a blank or unused file 
system. To change the mount point, select an existing mount 
point from the drop-down list, and then click Browse. The 
directory changes in the Mount Point field. (You can modify this 
parameter only for an unused storage disk.)

• Directory: The directory selected for file storage when the 
storage disk was initially created. (You cannot modify this 
setting.)

• # of Streams: The number of streams (1 - 8) I/O streams that can 
concurrently write to the disk.

• Copy: The copy number (1-4) specified when the storage disk 
was created. This copy number will be used by all policy classes. 
(You can modify this parameter only for an unused storage disk.)

4 After making storage disk modifications, click Apply.

5 After the Status Screen informs you that your modifications were 
made successfully, click Close

Deleting a Storage Disk

Use the following procedure to delete a storage disk.

1 From the SNSM home page, choose Storage Disk > Config from the 
Admin menu. The Configure Storage Disk screen (figure 177 on 
page 234) appears.

2 Select the storage disk you want to delete, and then click Delete.

A message will warn you that all data on the disk will be deleted with 
the disk, and ask you to confirm that you want to continue. 

Note: The Deduplication field indicates whether deduplication 
is enabled for the storage disk. This field cannot be 
modified.
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Figure 182  Delete Warning 
Message

3 Click OK.

4 After the Status screen informs you that the storage disk was 
successfully deleted, click Close.

Changing a Storage Disk State

Changing a storage disk’s state means changing the storage disk’s logical 
state to online or offline.

1 From the SNSM home page, choose Storage Disk > State from the 
Admin menu. The Change Storage Disk State screen appears.

Caution: All data on the storage disk will be removed when 
you continue, so proceed with extreme caution. 
There is no “undo” feature that will undelete the 
storage disk if you change your mind, so be 
absolutely certain you want to delete the storage 
disk before you continue.

Note: Deleting a storage disk does not unmount it. After deleting 
you must manually unmount the disk. Alternatively, you can 
use the mounted storage disk to create a new storage disk.
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Figure 183  Change Storage 
Disk State Screen

2 Select the storage disk whose state you want to change.

3 Select the state (Online or Offline) to assign to the selected storage 
disk, and then click Apply.

4 After the Status screen informs you that the storage disk’s status was 
successfully changed, click Close. The Change Storage Disk State 
screen shows the changed state for the storage disk you selected.

5 If desired, repeat steps 2 - 4 to change the state for additional storage 
disks.

Note: The “Online Pending” state applies only to deduplication-
enabled storage disks. This state means a verification 
process is currently in progress. When verification is 
complete, the status automatically changes to “Online.” 
When a storage disk is in the Online Pending state, you 
can retrieve from the storage disk but cannot make 
modifications. Also, no store or delete operations are 
performed on the storage disk. 

When a storage disk is in an Online Pending state, you can 
change the state only to Offline. If you change the state 
from Online Pending to Online, the operation will fail.
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Cleaning a Storage Disk

The cleaning process scans the storage disk and removes inactive files 
that have not been accessed since the endtime, and orphaned file copies 
(i.e., archive copies on the file system disk,). Using this process helps 
prevent the inactive information from growing to an unmanageable size. 

This process does not affect current file versions on the media. 

1 From the SNSM home page, choose Storage Disk > Clean from the 
Admin menu. The Clean Storage Disk screen appears.

Figure 184  Clean Storage Disk 
Screen

2 Select from the Select Storage Disk List the storage disk you want to 
clean, and then click Apply.

3 After the Status screen informs you that the storage disk was 
successfully cleaned, click Close.

Caution: Inactive file versions cleaned from the media cannot be 
recovered or used again.
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Note: When you clean a deduplication-enabled storage disk, 
blocklets are not immediately freed from the associated 
blockpool. The unused blocklets will be freed when the 
weekly clninfo schedule is run. If you want to immediately 
free blocklets, you can run the fsclean -b command from the 
command line.
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11Data Migration Management

This chapter describes how to use StorNext to manage data. This chapter 
covers these topics:

• Policy Classes and Relationships

• Adding a Storage Policy

• Modifying a Policy Class

• Deleting a Policy Class

• Adding Media to a Policy Class

• Applying a Policy Class

This chapter includes procedures executed from the command line. 
Before initially executing any StorNext command line programs, you 
must first source either the .profile or the .cshrc file to update the user 
environment with StorNext environment variables.

If you are running sh, ksh, or bash, type: . /usr/adic/.profile

For all other shells, type: source /usr/adic/.cshrc

Note: Files do not migrate by default policy rules if the time is set in 
the future. Before migrating files, verify that the time settings 
on all of your client and server machines are synchronized.
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Policy Classes and Relationships

A policy class defines how files will be managed in a directory and 
subdirectories. These are the available policy class settings:

• Number of copies to create

• Media type to use when storing data

• Amount of time to store data after data is modified

• If disk-to-disk relocation is enabled, the amount of time (in days) 
before relocating a file

• Amount of time before truncating a file after a file is modified 

Policy classes can be related to one or more directories. In this situation, 
all files in that directory and sub-directories are governed by the policy 
class. The connection between a policy class and a directory is called the 
relation point.

Here are some examples of policy class usage:

• A directory in which to store backups every night is created. This 
directory is seldom accessed after the files are copied over. A policy 
class could be set up to create two tape copies of the files, store one 
copy of the files to AIT media after residing on disk for 10 minutes, 
and then truncate the other set of files immediately after storing the 
other set to tape in order to free up disk space. This policy can be 
associated with a directory such as: /sandsm/dsm1/backup.

• A directory has been created to store all documents that are accessed 
frequently, and if truncated, need to be retrieved quickly. The policy 
class in this case could be set up to create a single tape copy, store the 
files to LTO media 15 minutes after being on disk, and then truncate 
after 60 days of non-use. This policy can be associated with a 
directory such as: /sandsm/dsm1/docs.

Stub Files 11 StorNext includes a licensable Stub File feature. When this feature is 
enabled, third-party applications can gather information about a file by 
reading a portion of the file (called a stub) rather than reading the entire 
file. When you create a policy class you can enable stub file support and 
specify the size of the stub file (in kilobytes). When stub file support is 
enabled, the beginning portion of the file (up to the size you specified) 
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remains on disk after data blocks are freed during policy management or 
space management. 

Disk-to-Disk Relocation11
Disk-to-Disk relocation allows you to move data from one set of disks 
(disk stripe group) to another without affecting the file name space. You 
can perform this procedure only if you have the full StorNext suite. 
(Customers with StorNext File System only cannot perform this 
procedure.)

Before enabling disk-to-disk relocation, you must perform these 
preliminary tasks if you have not already done so:

• Create a new managed file system with no more than two affinities, 
or reconfigure an existing managed file system by adding affinities. 
(For instructions on creating the file system, see Managing the File 
System on page 77.)

• Create a policy class or modify an existing one.

• Create a relation point.

• Determine relocation criteria. 

After you have accomplished these preliminary tasks, you can enable 
disk-to-disk relocation.

Adding a Storage Policy

Use the following procedure to add a new storage policy. When you 
create the policy, you can enable disk-to-disk relocation, stub file support, 
or both features. 

1 From the StorNext home page, choose Add Storage Policy from the 
Config menu. The Storage Policy Introduction screen appears, 
showing any previously configured policy classes.
StorNext User’s Guide 246



Chapter 11  Data Migration Management
Adding a Storage Policy
Figure 185  Storage Policy 
Introduction Screen

2 Click Next to continue. The Policy Class and Directory screen 
appears. 
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Figure 186  Policy Class and 
Directory Screen

3 Select any of the following options:

• Enable Disk-to-Disk: Select this option to activate the Disk-to-
Disk Relocation feature. For more information about Disk-to-
Disk Relocation, see Disk-to-Disk Relocation on page 246.

• Enable Checksum Generation: If enabled, checksums are 
generated and retained (in the database) for files stored by the 
corresponding policy class

• Enable Checksum Validation: If enabled, checksums are 
compared to retained values for the files retrieved by the 
corresponding policy class

• Enable Stub Files: Select this option to enable the Stub Files 
feature. For more information about Stub Files, see Stub Files on 
page 245.
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4 Click Browse. The Directory Browser window appears.

Figure 187  Directory Browser 
Window

5 Select a directory that contains the files you want to migrate, and then 
click OK. The Policy Class and Directory screen (figure 186) 
reappears, showing the directory you specified.

6 Review your selections and click Next. If you enabled the disk-to-
disk relocation feature, the Relocation Policy Selection screen 
appears. 

If you did not enable disk-to-disk relocation, go to step 8—page 251.
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Figure 188  Relocation Policy 
Selection Screen

7 On the Relocation Policy screen, select from the first drop-down list 
the affinity from which to move your data. Select from the second 
drop-down list the affinity to which you want to move the data. 
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8 Click Next to continue. The Store, Truncate, and Relocate Time 
screen appears. 

Figure 189  Store, Truncate, 
and Relocate Times Screen

• Minimum Store Time (Minutes): The minimum amount of time 
a file must remain unaccessed before it is considered a candidate 
for storage

• Minimum Truncation Time (Days): The minimum number of 
days a file must remain unaccessed before it is considered a 
candidate for truncation

• Minimum Relocation Time (Days): The minimum number of 
days a file must remain unaccessed on the primary affinity before 
it is considered a candidate for relocation to a secondary affinity. 
This option does not appear when you select the Enable Stub 
Files option on the Policy Class and Directory screen. 
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• Stub File Size (Kbytes): The desired target size to allocate for the 
file stub. This is the readable portion of the file that remains after 
truncation when the Stub File feature is enabled. This option 
appears only when you selected the stub file option.

After entering values, click Next to continue. The Number of File 
Copies and Media Type screen appears.

Figure 190  Number of File 
Copies and Media Type Screen
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9 Select up to four copies to store for each file, including the primary 
file (File Copy 1). Select the media type for each copy, and then click 
Next. The Complete Storage Policy Task screen appears

Figure 191  Complete Storage 
Policy Task Screen

10 Review the information and click Next to continue, or Back to edit 
your choices.

11 After the Status screen informs you that the procedure completed 
successfully, click Close.

Adding a Policy Class 
Through SNSM Without a 
Relation Point 11

Use this procedure from the SNSM home page to add a policy class 
without a relation point.
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1 From the SNSM home page, choose Policy Classes from the Admin 
menu. The Manage Policy Classes screen appears.

Figure 192  Manage Policy 
Classes Screen

2 Click Add to continue. The Add Policy Class screen appears.

Figure 193  Add Policy Class 
Screen

3 Enter in the Policy Class Name field the name of the new policy 
class.
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4 Click Properties to change the default parameters of the new policy 
class. The Modify Parameters screen appears.

Figure 194  Modify Parameters 
Screen
StorNext User’s Guide 255



Chapter 11  Data Migration Management
Adding a Storage Policy
5 On the Modify Parameters screen, enter both the Standard Options 
and Advanced Options as desired.

• File Copy 1, 2, 3, and 4: The copy number used when storing 
assigned media. The copy number assigned to the media 
determines which copy goes to the media. You must specify 
media for all copies used. You must use at least one copy (Copy 
1), and can use up to four copies. 

• File Age Before Migration: This value determines the minimum 
number of minutes a file must reside unmodified on disk before 
it is considered a candidate for storage on media. 

• File Age Before Truncation: This value determines the minimum 
number of days a file must reside on a disk unaccessed before it 
is considered a candidate for truncation from disk. Truncation 
removes the disk blocks of a stored file, but not the file itself.

• Truncate Immediately After Store: Enable this option (check this 
box) to truncate files immediately after they are stored.

• Max Inactive Versions: The maximum number of inactive 
versions of a file StorNext keeps track of for recovery purposes.

• Drive Pool to Use: Associates the drive pool to use with the 
policy class. If you specify a drive pool, the drive pool name must 
be defined before any data operation can occur.

• Checksum Generation: If this option is enabled, (the box is 
checked), checksums are generated and retained in the database 
for files stored by the corresponding policy class.

• Checksum Validation: If this option is enabled (the box is 
checked), checksums are compared to retained values for the files 
retrieved by the corresponding policy class. The Checksum 
feature consumes additional space in the StorNext database 
whether it is enabled or not. When disabled, this feature 
consumes approximately 2 bytes per stored file; when enabled, 
this feature consumes approximately 18 bytes per stored file. The 
database stores data in files on the host computer, so the increase 
in database size translates to a corresponding increase in disk 
space requirements. The exact amount of space consumed 
(whether the feature is enabled or disabled) may vary.

• Stub Files: Select this option to enable the Stub File feature.

• Stub File Size: When the Stub File feature is enabled, specify the 
target size for the stub file in kilobytes.
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• Minimum Set Store Size (1 to 999 in MB or GB): This value 
determines the minimum size (in megabytes or gigabytes) all 
valid store candidates in the policy class combined must reach 
before they are stored.

• Maximum File Store Age (1 to 720 in hours): This value 
determines the time after which any valid store candidate in the 
policy class is stored.

• Soft Limits: This value represents the soft limit on the number of 
media allocated for the policy class.

• Hard Limits: This value represents the hard limit on the number 
of media allocated for the policy class.

• Auto Store: Use this option to automatically store files for the 
current policy class. If this option is disabled (unchecked), 
Quantum recommends that the files for the policy class be stored 
by scheduled events. To create a scheduled event, click the Add 
button. 

• Add or Delete Schedule: Add or delete a scheduled store event. 
For more information about scheduling, see Scheduling StorNext 
Events on page 56. 

• Enable Disk-To-Disk: Enables the disk-to-disk relocation 
functionality. Before you can enable the disk-to-disk functionality 
on this screen, two affinities (the From and To affinities described 
below) must be created.

• Affinity From: The primary affinity where a file resides.

• Affinity To: The secondary affinity to which the file will 
relocate.

• File Age Before Relocation (in days): This value determines 
the minimum time in days a file must reside unaccessed on 
the primary affinity before being relocated to a secondary 
affinity.

6 After you are finished setting parameters for the policy class, click 
Apply.

7 After the Status screen informs you that the policy class was 
successfully added, click Close.
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Adding a Relation Point 
to a Policy Class 11

After you have added a policy class, you can use this procedure to add a 
relation point to it.

1 From the SNSM home page, choose Relations from the Admin 
menu. The Manage Policy Class Relationships screen appears.

Figure 195  Manage Policy 
Class Relationships Screen

2 Select the policy class for which you wish to create a relation point, 
and then click Add. The Add Relationship screen appears.
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Figure 196  Add Relationship 
Screen

3 Click Browse to view directories to which you can make the 
relationship. The Directory Browser window appears.

Figure 197  Directory Browser 
Window

4 Select from the list a directory to which to add the relationship 
directory. A second Directory Browser window appears, showing 
the directory you selected in the Current Directory field.

5 Click OK. The Add Relationship screen appears, showing the new 
directory.
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6 Click Apply. 

7 After the Status screen informs you that the operation completed 
successfully, click Close.

Modifying a Policy Class

Use the following procedure to modify a policy class.

1 From the SNSM home page, choose Policy Classes from the Admin 
menu. The Manage Policy Classes screen (figure 192) appears.

2 Select from the Select Policy Class list the policy class you want to 
modify, and then click Modify. The Modify Parameters screen 
(figure 194) appears.

3 On the Modify Parameters screen, modify values as desired and then 
click OK.

4 After the status screen informs you that the policy class has been 
successfully modified, click Close.

Deleting a Policy Class

Before you can delete a policy class, you must first delete everything 
associated with that policy class, including media and directories. Also, 
you must clean the media and return it to a system-blank state.

To remove all files in directories associated with the policy class, follow 
these steps:

1. Log on as root.

2. Change directories to the location where the relation resides.

3. Remove all files and directories.
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Use the following procedure to delete a policy class.

1 To remove the relations for the policy class, from the SNSM home 
page choose Relations from the Admin menu. The Manage Policy 
Class Relationships (figure 195) appears.

2 In the list, select a policy class and click Remove. The Remove 
Relationships for... screen appears.

Figure 198  Remove 
Relationships Screen

3 In the Select Directory list, select a directory and click Apply.

4 After the Status screen informs you that the relationship has been 
successfully removed, click Close. 

5 From the SNSM home page, choose Policy Classes from the Admin 
menu. The Manage Policy Classes screen (figure 192) reappears.

6 Select from the Select Policy Class list the policy class you want to 
delete, and then click Delete.

7 After the Status screen informs you that the policy class has been 
successfully deleted, click Close.
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Adding Media to a Policy Class

Use this procedure to add media to a policy class. Before performing this 
procedure, verify that the media was previously added to a library.

1 From the SNSM home page, choose Add from the Media menu. The 
Add Media screen appears.

Figure 199  Add Media Screen

2 Enter appropriate values for the following fields, and then click 
Apply.

• Media Type: Type of media available to add

• Quantity Available: Quantity of media available

• Policy Class list: Select a policy class to which to add the media

• Number of Media: Specify the number of media you are adding

• Format Type: Select the type of media formatting to perform:

• Delay: Select this option if you want the media to be 
formatted when data is first written to the media

• Immediate: Select this option if you want all media to be 
formatted after you click Apply 
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3 After the Status screen informs you that the media has been 
successfully added, click Close.

Applying a Policy Class

After you have created at least one policy class, you can select that policy 
class and apply it immediately. 

1 From the SNSM home page, choose Policy Classes from the Admin 
menu. The Manage Policy Classes screen (figure 192) appears.

2 Select from the Select Policy Class list the policy class you want to 
apply. 

3 Click Run to apply the policy class immediately.

4 After the Status screen informs you that the operation was performed 
successfully, click OK.
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StorNext enables you to generate and view a number of reports that 
provide information about your StorNext system. These reports are 
selectable from the StorNext home page, the SNFS home page, and the 
SNSM home page. 

The following reports are available:

• The Backup Information Report: Provides information about primary 
and secondary backups for the StorNext system.

• The Drive State Information Report: Provides information about the 
drives configured in StorNext, including drive IDs and types, 
archives, usage, errors, and mount data. 

• The File Information Report: Provides file information, including the 
current location of a file, owner, size, and number of copies for the 
file. 

• The Library Information Report: Provides information about 
libraries, including the type and state, associated media associated, 
and imported media classes. 

• The Library Space Used Report: Provides total storage capacity being 
used in all configured libraries. 

• The Media Information Report: Provides media configuration and 
statistics. 

• The Media Class Information Report: Provides information about 
media classes, including the number and type of media in each class. 
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• The Policy Class Information Report: Provides information about 
policy classes in the StorNext system, including media, mintimes, 
hard limits, and cleanup. 

• The Relation Information Report: Provides information about the 
directory-to-policy class relationships in the file system. 

• The Request Information Report: Provides information about 
requests, including the type of request, priority, and current status. 

• The Scheduler Information Report: Provides information about 
StorNext schedules.

• The Storage Disk Information Report: Provides information about the 
configured storage disks on your system. 

SNFS Reports 12

SNFS reports are also accessible from the StorNext home page, the SNFS 
home page, and the SNSM home page. 

The following reports are available:

• The Directory Affinity Report: This report shows the existing 
affinities for a selected directory in the file system. 

• The File System Statistics Report: This report provides file system 
statistics including active clients, space, size, disks, and stripe groups. 

• The Stripe Group Statistics Report: This report provides statistics for 
the stripe group, such as space, affinities, and current statuses.

• The File System Client Report: This report provides statistics for 
StorNext clients, including the number of StorNext SAN clients and 
distributed LAN clients, and client performance.

• The File System LAN Client Report: This report provides information 
about distributed LAN clients, including read and write speed.
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The Backup Information Report

The Backup Information Report provides the following information:

• Date: The date and time the last backup was run

• Type: The type of backup that was run: Full or Partial

• Status: The current status of backup: PASS, STORED, or NOT. 
(NOT means all copies of the backups were not stored to media.)

• Media: The media ID on which the backup was stored

 Use the following procedure to run the Backup Information Report.

1 Choose Backups from the Reports menu. The Backup Information 
Report appears, showing information for the backups. 

Figure 200  Backup Information 
Report

2 Click Close when you are finished viewing the report.
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The Drive State Information Report

The Drive State Information Report provides the following information:

• Drive ID: The drive ID (1, 2, 3, etc.)

• Drive Type: The type of drive being used (such as LTO)

• Device Pathname: The drive’s pathname

• Tape Compression: Indicates whether tape compression is 
currently turned on or off

• Associated Library: The name of the library associated with the 
drive

• State: Indicates whether the drive is currently online or offline

• Status: Indicates the drive’s current status, which is one of these 
conditions:

• FREE: No medium is mounted

• IN USE: Medium is in use

• FAILED: Drive failed

• DELAYED: Drive is in a dismount-delayed state

• CLEANING: Cleaning medium is mounted

• USER MOUNT: Medium was mounted using the GUI’s 
Media > Mount command or the CLI fsmount command

• OTHER: Medium was not mounted directly by the StorNext 
Tertiary Manager, but by other means such as through the 
Media Manager

• Dismount Delay: The time delay (in seconds) before media is 
dismounted

• Assignment: Indicates whether the drive is currently free or 
mounted

• Mount Count: The number of times the tape has been mounted

• Error Count: The number of errors (mostly write errors) a tape 
has incurred
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• Mount State: Indicates whether the drive is currently mounted 
or unmounted

• Mounted Media ID: The ID of the mounted drive

Use the following procedure to run the Drive State Information Report.

1 Choose Drives from the Reports menu. The Drive States Report 
screen appears.

Figure 201  Drive States Report 
Screen
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2 Select from the drives list one or more drives to include in the report, 
and then click Apply. The Drive State Information Report appears 
with state information for the selected drives.

Figure 202  Drive State 
Information Report

3 Click Close when you are finished viewing the report.

The File Information Report

The File Information Report provides the following information:

• Last Modification Timestamp: The timestamp (date) when the file 
was last modified

• Owner (Access): The access permissions assigned to the file owner

• Group (Access): The access permissions that group has to the file: 
Read, Write, Execute (rwx), or all three permissions

• Public Access: Indicates public access permissions

• Policy Class: An associated policy class that manages the file lifecycle

• Size (bytes): The size of the file in bytes

• Checksum: Indicates whether a checksum exists for the file
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• Truncation Immediately After Store: Indicates whether files are 
truncated immediately after a store

• File Location: The media on which the file is stored

• Copies: The number of copies of the file

• Affinity: The affinity with which the file is associated 

• Set Stub Size (KB): If the Stub File feature is enabled, this is the 
target size (in kilobytes) for the stub file

• Actual Stub Length (KB): If the Stub File feature is enabled, this is 
the actual size (in kilobytes) of the stub file

Use the following procedure to run the File Information Report.

1 Choose Files from the Reports menu. The Files Report screen 
appears.

Figure 203  Files Report 
Screen

2 Select the files to include in the report by doing one of the following:
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• In the Enter Individual File field, type a file name. Proceed to 
Step 5—page 272.

• Select multiple files from the Select Files list. (You can click the 
Select All button to select all files in the list, or click Deselect All 
to deselect all selected files.) Proceed to Step 5—page 272.

• Click Browse to select files from a managed directory. 

3 When you click Browse, the StorNext File Browser screen appears. 
In the Select Directory list, select a directory. The selected directory 
appears in the Current Directory field. A list of directories appears in 
the Select Directory list, and a list of files in the Current Directory 
field appears in the Select Files list. 

Figure 204  StorNext File 
Browser Screen

4 Select one or more files from the Select Files list, and then click OK. 
The Files report screen appears with the selected files in the Select 
Files list.
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5 Click Apply to run the report. The File Information Report appears 
with information for the selected files. 

Figure 205  FIle Information 
Report

6 Click Close when you are finished viewing the report.

The Library Information Report

The Library Information Report provides the following information:

• Library Type: The library type, such as SCSI, Network, or Vault

• Current State: Indicates whether the library is online or offline

• Library Mode: Displays two modes:

• Attended: The LOI will be associated with required actions

• Unattended: Fails any actions that require user interaction 

• Media Type: The media type the library uses

• Slot Count: The number of media slots available for the library type

• Current Fill Count: The current number of media slots associated 
with the library
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• Import Media Class: The media type to import

Use the following procedure to run the Library Information Report.

1 Choose Libraries from the Reports menu. The Libraries Report 
screen appears.

Figure 206  Libraries Report 
Screen
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2 Select from the Library List one or more libraries on which to run the 
report, and then click Apply. The Library Information Report 
appears with information about the selected libraries.

Figure 207  Library Information 
Report

3 Click Close when you are finished viewing the report.

The Library Space Used Report

The Library Space Used Report shows the amount (in gigabytes) of 
storage currently used by all configured libraries. 
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Use the following procedure to run the Library Space Used Report.

1 Choose Library Space from the Reports menu. The Library Space 
Used Report appears.

Figure 208  Library Space Used 
Report

2 Click Close when you are finished viewing the report.

The Media Information Report

The Media Information Report provides the following information:

• Copy #: he number next to the media ID in the upper left corner that 
refers to the corresponding copy. (In the illustration, notice the (1) to 
the right of 000091.) If the copy number does not exist, this media has 
not been allocated to a policy class.

• Show Details link: Click this link to view media dead space and files 
on that media. (See figure 212 on page 280.) Depending on the 
number of files on the media, it could take a long time before data 
appears after you click the Show Details link.

• Media Type: The type of media
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• Media Class: The media class designated for the tape

• Policy Class: Indicates whether a policy class is associated with the 
media

• Last Access Time: The date and time when the media was last used

• Media Status: Indicates media status: Available, Unavailable, or In 
Use

• Write Protect: Indicates whether the media is write-protected

• Formatted: Indicates whether the media is formatted

• Import Date: The date the media was added to the library

• Export: This attribute is currently not utilized in StorNext, and 
should remain at status UNMARKED

• # Files: The number of files associated with the media

• Space Used: The amount of space written

• % Used: The percentage of used space

• Space Remaining (bytes): The available space on the media (in bytes)

• Mount Count: The number of times the tape has been mounted

• Move Count: The number of times the tape has been moved

• Suspect Count: Indicates whether the media has any errors. If so, 
errors are marked as suspect

• Current Action: This is currently not utilized in StorNext and should 
remain at status NONE

• Location: The location of the tape

• Current Archive: The current library in which the media is located

• Pending Archive: Indicates whether the media is associated with 
another library

This Detailed Media Information Report (displayed after you click the 
Show Details link) provides the following information:

• Dead Space: The amount of unused space on the media

• File Pathname: The file’s path location

• File Size: The file’s size

• Version: The file’s current version
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• Status: The file’s current status: Active or Inactive 

• Modify/Delete Date: The date the file was last modified or deleted

Use the following procedure to run the Media Information Report.

1 Choose Media from the Reports menu. The Media Report screen 
appears.

Figure 209  Media Report 
Screen

2 Select the media on which to run the report by doing one of the 
following:

• In the Enter Media ID field, type the ID of the media on which to 
run the report. Proceed to Step 5—page 279.

• Select media IDs from the Selected Media ID(s) list. (You can click 
Select All to select all media IDs, or Deselect All to deselected 
selected IDs.) Proceed to Step 5—page 279.

• Click Browse to select media from specific libraries
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3 When you click Browse, the Media Browser screen appears. Select 
from the View by: list a library or media class.

Figure 210  Media Browser 
screen

The selected library or media class appears in the Current Selection 
field, and the media associated with the selected library are shown in 
the Select Media list.

4 In the Select Media list, select one or more media, and then click OK. 
The Media Report screen shows the selected media in the Entered 
Media IDs list.

Note: If you want to limit the media list to a specific selection, 
type the attributes of the media name in the Media Filter 
field to only browse these items. For example, typing *8 
lists all media ending with an 8.
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5 Click Apply to continue. The Media Information Report appears.

Figure 211  Media Information 
Report
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6 If desired, click the Show Details link to view detailed media 
information. The Detailed Media Information Report appears.

Figure 212  Detailed Media 
Information Report

7 Click Close when you are finished viewing the report.

The Media Class Information Report

The Media Class Information Report provides the following 
information:

• Media Type: The type of media (such as LTO)

• Maximum Members: The maximum number of files or backups on a 
tape

• Current Fill Level: The tape’s current filled percentage amount

• Auto-Migrate Fill%: Indicates how full the media class can get before 
being declared “full” 
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Use the following procedure to run the Media Class Information Report.

1 Choose Media Classes from the Reports menu. The Media Class 
Report screen appears.

Figure 213  Media Class Report 
Screen
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2 Select one or more media classes on which to run the report, and then 
click Apply. The Media Class Information Report appears with 
information about the selected media classes.

Figure 214  Media Class 
Information Report

3 Click Close when you are finished viewing the report.
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The Policy Class Information Report

 The Policy Class Information Report provides the following information:

• File Copy (1-4): The number of copies stored for each file. A media 
type for File Copy “N” indicates the copy is to be stored; a value of 
N/A for the media type indicates this copy is not to be stored. File 
Copy 1 (the primary copy) will always have an associated media, and 
will be stored. The maximum number of file copies is four.

• # Media Associated: The number of media associated with the class

• Drive Pool: The name assigned to the pool of associated tape drives

• Minimum Store Time (minutes): The number of minutes after the 
last modification when the file becomes available for storage to tape

• Minimum Trunc Time (days): The number of days after the last 
modification when the files on tape become available for truncation

• Max Inactive Versions: The maximum number of inactive versions 
to keep for a file

• Truncate Immediately After Store: Indicates whether files truncate 
immediately after a store

• Checksum Verification: If enabled, checksums are compared to 
retained values for the files retrieved by the corresponding policy 
class

• Checksum Generation: If enabled, checksums are generated and 
retained in the database for files stored by the corresponding policy 
class

• Minimum Set Store Size (1 to 999 in MB or GB): The minimum size 
that all valid store candidates in the policy class combined must reach 
before they are stored

• Maximum File Store Age (1 to 720 in hours): If any valid store 
candidate in the policy class reaches this value, all valid candidates 
are stored
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• Disk-to-Disk: Indicates whether the disk-to-disk functionality is 
enabled or disabled for the selected policy class

• Affinity From: If disk-to-disk is enabled, the name of the primary 
affinity where a file resides

• Affinity To: If disk-to-disk is enabled, the name of the secondary 
affinity to which the file relocates

• File Age Before Relocation: The age a file must reach before it 
becomes eligible for relocation

• Media Clean Pool: The class name with which the media is 
associated after it is logically blank

• Stub Files: Indicates whether the Stub File feature is enabled or 
disabled for the storage policy

• Stub File Size (KB): If the Stub File feature is enabled, this is the 
target stub file size specified when the storage policy was created or 
modified

• AutoStore: Indicates whether the Autostore feature is enabled or 
disabled. The Autostore option automatically stores files for the 
current policy class. If this feature is disabled, Quantum recommends 
that the files for the policy class be stored by scheduled events (see 
below).

The Schedules section of the report provides the following information 
about the schedule associated with the Policy Class:

• Name: Name of the associated schedule

• Run Days: The days on which the schedule is set to run

• Start Time: The time when the schedule is set to begin running

• Start Window: The timeframe within which the scheduler attempts 
to begin the process. (For example, 30 minutes.) If the process cannot 
begin, it tries again during the next cycle.

• Last Run: The date and time the schedule was last run

• Last Run Status: The last status of the previous schedule

• Media IDs: This section of the report displays the media associated 
with the policy class on which the report was run. This information 
appears only when the Show Media option is selected on the Policy 
Classes Report screen. 
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Use the following procedure to run the Policy Classes report.

1 Choose Policy Classes from the Reports menu. The Policy Classes 
Report screen appears.

Figure 215  Policy Classes 
Report Screen

2 Select from the Select Policy Class list one or more policy classes on 
which to run the report.

3 To also view media associated with these policy classes, select the 
Show Media option.
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4 Click Apply. The Policy Class Information Report appears.

Figure 216  Policy Class 
Information Report

5 Click Close when you are finished viewing the report.

The Relation Information Report

The Relation Information Report shows the pathname of the selected 
directory and the corresponding policy class name for the directory.

Use the following procedure to run the Directory/Policy Class 
Relationship report.

1 Choose Relations from the Reports menu. The Directory/Policy 
Class Relationships Report screen appears.
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Figure 217  Directory/Policy 
Class Relationships Report 
Screen

2 Select from the Select Managed Directories list the directory on 
which the report is run, and then click Apply. The Relation 
Information Report appears.
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Figure 218  Relation 
Information Report

3 Click Close when you are finished viewing the report.

The Request Information Report

Use the following procedure to run the Requests report.

1 Choose Requests from the Reports menu. The Requests Report 
screen appears.
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Figure 219  Request Report 
Screen

2 Select from the Request ID list one or more request IDs on which to 
run the report, and then click Apply. The Request Information 
Report appears.

3 Click Close when you are finished viewing the report.

The Scheduler Information Report

The Scheduler Information Report provides the following information:

• Name: The name of the schedule

• Run Days: The days on which the feature runs

• Start Time: The time when the feature runs
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• Window: If StorNext was down at the time of the scheduled event 
and is restarted during the window time period, the event is 
launched; otherwise it is skipped until the next scheduled time

• Last Run: The time the schedule was last run

Use the following procedure to run the Scheduler report.

1 Choose Scheduler from the Reports menu. The Scheduler Report 
screen appears.

Figure 220  Scheduler Report 
Screen
StorNext User’s Guide 290



Chapter 12  StorNext Reports
The Storage Disk Information Report
2 Select one or more of the schedules on which to report, and then click 
Apply. The Scheduler Information Report appears.

Figure 221  Scheduler 
Information Report

3 Click Close when you are finished viewing the report.

The Storage Disk Information Report

The Storage Disk Information Report provides the following information.

• Name: The name of the storage disk for which the report was run

• Mount Point: The storage disk’s mount point of the storage disk

• Copy #: The copy ID for media on the storage disk
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• # of Streams: The number of streams that can simultaneously access 
the storage disk

• Status: Shows if the storage disk is currently available or offline

• Write Protected: Indicates whether the storage disk is write protected

• Last Access Time: The date and time the storage disk was last 
accessed

• # Files: The number of files on the storage disk

• Space Used: The amount of space consumed on the storage disk

• Space Remain: The amount of space remaining on the storage disk

• State: The storage disk’s current state (e.g., FREE, ONLINE, 
OFFLINE, or ONLINE-PENDING)

• Deduplication: Indicates whether deduplication is enabled for the 
storage disk

• % Savings: If deduplication is enabled, this field reports the 
percentage of space saved by deduplication

• Total Data Stored (MB): If deduplication is enabled, this field shows 
total amount of data stored, in megabytes. (This field does not appear 
when deduplication is disabled.)

• Unique Data Stored (MB): If deduplication is enabled, this field 
shows amount of unique data stored, in megabytes.  (This field does 
not appear when deduplication is disabled.)

Use the following procedure to run the Storage Disks report.

1 Choose Storage Disks from the Reports menu. The Storage Disk 
Report screen appears.
StorNext User’s Guide 292



Chapter 12  StorNext Reports
The Storage Disk Information Report
Figure 222  Storage Disk 
Report Screen

2 Select the disks on which to run the report and click Apply. The 
Storage Disk Information Report appears.

Note: If you enable the Show Files on Storage Disk option, the 
report could be very large and take a long time to run, 
depending on the number of files on the storage disk.
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Figure 223  Storage Disk 
Information Report

3 Click Close when you are finished viewing the report.

The Directory Affinity Report

Use the following procedure to run the Affinities report.

1 Choose SNFS > Affinities from the Reports menu. The Affinities 
Report screen appears.
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Figure 224  Affinities Report 
Screen

2 Do one of the following:

• In the Select Individual Directory text box, type the full path of 
the directory on which the to run the report. Proceed to <Teal 
underline>Step 4.

• Click Browse to select a directory. The Directory Browser screen 
appears. 
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Figure 225  Directory Browser 
Screen

3 On the Directory Browser screen, select the directories on which to 
run the report.

4 Click Apply. The Directory Affinity Information report appears.

Figure 226  Directory Affinity 
Report

5 Click Close when you are finished viewing the report.
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The File System Statistics Report

The File System Statistics Report provides the following information:

• Creation Date: The date and time when the file system was created

• # Active SAN Clients: The number of SAN client machines 
associated with the file system

• File System Block Size: The file system’s block size

• Message Buffer Size: The size of the file system message buffer

• # Disk Devices: The number of disk devices on the file system

• # Stripe Groups: The number of stripe groups on the file system

• Total Space: The file system’s total size

• Available Space: The amount of space still available on the file 
system

• Managed: Indicates whether the file system is managed (Yes) or 
unmanaged (No)
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Use the following procedure to run the File System report.

1 Choose SNFS > Systems from the Reports menu. The File System 
Report screen appears.

Figure 227  File System Report 
Screen
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2 In the Active File Systems list, select one or more active file systems 
on which to run the report, and then click Apply. The File System 
Statistics Report appears, showing statistical data for the selected file 
systems.

Figure 228  File System 
Statistics Report

3 Click Close when you are finished viewing the report.

The Stripe Group Statistics Report

The Stripe Group report provides the following information:

• Total Space: The total space available in the stripe group

• Available Space: The available space that has not been used in the 
stripe group

• Breadth (blocks): The number of contiguous blocks in the stripe 
group

• Affinity: Indicates whether an affinity is associated with the stripe 
group

• Status: Indicates whether the stripe group is currently up or down, 
and whether the data is Metadata, Journal, or Exclusive

• Read: Indicates whether the stripe group is read-enabled

• Write: Indicates whether the stripe group is write-enabled

• Read Method: Indicates whether the read method is assigned to the 
stripe group
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• Disks in Group: The list of disks assigned to the stripe group

Use the following procedure to run the Stripe Groups report.

1 Choose SNFS > Stripe Groups from the Reports menu. The Stripe 
Groups Report screen appears.

Figure 229  Stripe Groups 
Report Screen

2 Select from the Active File Systems menu the file system containing 
the stripe group for which to create the report.
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3 In the Stripe Groups list, select one or more stripe groups on which 
to run the report, and then click Apply. The Stripe Group Statistics 
Report appears.

Figure 230  Stripe Group 
Statistics Report

4 Click Close when you are finished viewing the report.

The File System Client Report

The File System Statistics Report provides the following information:

• File System: The name of the file system supporting the clients.

• Mounted on: The name of the file system mount point.

• # SAN Clients: The total number of physically connected StorNext 
SAN clients.

• # LAN Servers: The total number of distributed LAN servers for the 
indicated file system.

• # LAN Clients: The total number of StorNext distributed LAN 
clients.

• SAN Clients: The names of physically connected SAN clients.
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• Distributed LAN Servers: The names of the distributed LAN servers.

• Distributed LAN Clients: The names of distributed LAN clients.

• LAN Servers: The name of the distributed LAN server for which the 
subsequent details apply.

• Listening IP:Port: The IP address and port number through 
which the distributed LAN server communicates with StorNext.

• TCP Window Size: The TCP window size (in KB) used by the 
distributed LAN server. (Default: 64)

• Transfer Buffer Size: The transfer buffer size (in KB) used by the 
distributed LAN server. A larger buffer may increase 
performance for larger files. (Default: 256)

• Transfer Buffer Count: The number of transfer buffers used by 
the distributed LAN server. This parameter is used only by 
Windows servers and clients. Linux servers pass the value of this 
parameter to Windows clients. (Default: 16)

• Daemon Threads: The maximum number of daemon threads 
used by the distributed LAN server. (Default: 8)

• Luns: The disk name; physical device name; number of sectors; and 
sector size.

Use the following procedure to run the File System Client Statistics 
Report.

1 Choose SNFS > Client from the Reports menu. The File System 
Client Report screen appears.
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Figure 231  File System Client 
Report Screen

2 Select from the Active File Systems list one or more file systems to 
include in the report. Click Apply to continue. The File System 
Client Report appears.
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Figure 232  File System Client 
Report

3 If desired, click Refresh to manually update (refresh) the report data. 
You can also use the Auto Refresh Rate field to specify one of these 
automatic refresh intervals:

• No Refresh

• 5 seconds

• 10 seconds

• 30 seconds

• 1 minute

• 5 minutes

4 Click Close when you are finished viewing the report.
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The File System LAN Client Report

The File System LAN Client Report provides the following information:

• File System Name: The name of the file system that supports the 
indicated distributed LAN server.

• Distributed LAN Server Name: The name of the distributed LAN 
server on the indicated file system.

• Distributed LAN Client Name: The name of the distributed LAN 
client for the indicated file system and distributed LAN server.

• Read: The speed at which the distributed LAN client is currently 
reading data.

• Write: The speed at which the distributed LAN client is currently 
writing data.

Use the following procedure to run the Distributed LAN Client 
Performance Report.

1 Choose SNFS > LAN Client Performance from the Reports menu. 
The File System Distributed LAN Client Statistics Report screen 
appears.
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Figure 233  File System 
Distributed LAN Client Statistics 
Report Screen

2 Select from the Active File Systems list one or more file systems to 
include in the report. Click Apply to continue. The File System LAN 
Client Report appears.
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Figure 234  File System LAN 
Client Report

3 If desired, click Refresh to manually update (refresh) the report data. 
You can also use the Auto Refresh Rate field to specify one of these 
automatic refresh intervals:

• No Refresh

• 5 seconds

• 10 seconds

• 30 seconds

• 1 minute

• 5 minutes

4 Click Close when you are finished viewing the report.
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This chapter describes how to use the StorNext Service Management tools 
to run a health check on your system, create a log that captures the 
current state of your system, or check current system status. This chapter 
contains these topics:

• Using Health Check

• Using State Capture

• Using the System Status Tool

Using Health Check

You can run these health checks on your StorNext system:

• Archive: Verify that all configured archives are online

• Config: Verify that affinities are configured correctly in SNSM for 
managed file systems, and that SNSM-managed file systems are 
identified and configured correctly

• Dedup SDISK: Verifies blockpool data integrity for all blocketized 
storage disks (i.e., deduplication-enabled storage disks). 

• Disk Space: Verify that enough disk space exists for the SNSM 
database tables, logging, and other functions
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• Drive: Verify that all configured drives are online

• Media: Verify that there are enough media available for all policies to 
store all file copies, and that SNSM media are configured correctly

• Policies: Verify that SNSM is keeping up with file system events and 
store candidate processing

Running a Health 
Check 13 Use the following procedure to run a health check. All of the health 

options are linked to specific information about that particular health 
check.

1 From the StorNext home page, choose Health Check from the 
Service menu. The Health Check Tests screen appears.

Figure 235  Health Check Tests 
Screen

2 Select one or more health checks to run, and then click Run.

3 When the Status screen informs you that the check have run 
successfully, click Close.

Viewing the Health Check 
History 13

After running a health check, you can view a five-run history of each 
health check that has been run.
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1 Select a health check from the Health Check Tests screen.

2 Click History. The Health Check History screen appears.

Figure 236  Health Check 
History Screen

3 Do one of the following:

• Select a specific report to view and click Details. 

• Click the Pass or Fail link in the Results column. Proceed to 
Viewing the Health Check Results on page 311.

4 When you click Details on the Health Check History screen, the 
Health Check Results screen appears.
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Figure 237  Health Check 
Results Screen

5  Click Back to view more archives, or close the window when 
finished.

Viewing the Health Check 
Results 13

When viewing the Health Check Tests or the History screen, you can 
check the details of the Last Status of a particular health check. The 
following example shows how to run the last status check from the 
Health Check Tests screen.

1 From the StorNext home page, choose Health Check from the 
Service menu. The Health Check Tests screen (figure 235) appears.

2 Click the Last Status link (Pass or Fail). The Health Check Results 
screen appears, showing the results of the last health check run. This 
screen is the same as the Results screen that appears when you click 
Details on the Health Check History screen. (See figure 237)

3 After you are finished viewing the results, click Close.
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Using State Capture

The StorNext State Capture tool enables you to create a log that captures 
the current state of your system. This log assists Quantum support 
personnel analyze and debug some problems in the storage system. 

When you use the State Capture tool, StorNext creates a log file named 
using the format snapshot-machinehostname-
YYYYMMDDHHMMSS.tar.gz. This file contains a summary report that is 
produced by executing the pse_snapshot command on all component 
config/filelist files. 

If desired, you can download or delete a previously captured file. When 
you are finished using the State Capture tool, you can return to the 
StorNext home page or select another tool or option. 

Capturing the Current 
System State 13

Use the following procedure to access the StorNext State Capture tool.

1 From the StorNext home page, choose Capture State from the 
Service menu. The Capture System State screen appears. Any 
previously captured snapshots are shown.

Figure 238  Capture System 
State Screen
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2 Click Capture. The Capture State Status window is shown. 

3 When the Status window informs you that the capture was 
successful, click Close.

Downloading a Previous 
System Capture 13

After you have created at least one system capture, you can select and 
download one of those .tar.gz files to view. 

1 From the StorNext home page, choose State Capture from the 
Service menu. A list of capture files stored in the directory /usr/adic/
www/logs/capture_state is shown. (This directory is where the files 
are stored on the StorNext server.)

2 Locate the capture file you want to download, and then click the 
corresponding radio button under the Number column beside the 
filename.

3 Click Download. The Download Capture File screen appears.

Figure 239  Download Capture 
File Screen

4 If the download does not start automatically, click the supplied link.

5 Specify whether you want to open or save the capture file. (The file is 
in compressed tar.gz format, so in most cases you will want to save 
the file and then open it with a file decompression utility such as 
WinZip.)
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Deleting a Previous 
System Capture 13

When you are finished viewing and analyzing a capture file, you can 
delete an unwanted file.

1 From the StorNext home page, choose Capture State from the 
Service menu. The Capture System State screen shows a list of 
capture files stored in the directory /usr/adic/www/logs/capture_state.

2 Locate the capture file you want to delete, and then click the radio 
button beside the filename.

3 Click Delete. 

4 When a confirmation screen prompts you to confirm that you want to 
delete the file, click OK to continue.

5 After the status screen informs you that the file was successfully 
deleted, click Close.

Using the System Status Tool

The System Status tool creates a list of RAS tickets that relate to system 
faults or errors. Ticket details provide a summary of the system fault, an 
area for Analysis notes, and contains a Recommended Actions link to 
help you correct the fault. 

Use the following procedure to use the System Status tool.

1 From the StorNext home page, choose System Status from the 
Service menu. The Service - System Status screen appears.
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Figure 240  Service - System 
Status Screen

The Service - System Status screen contains the following 
information:

• Total Number of Tickets: The number of RAS tickets the system 
has generated

• Ticket: The RAS ticket number, displayed in the order in which it 
was created

• State: The ticket’s current status: OPEN or CLOSED

• Priority: The ticket’s priority based on system impact: HIGH, 
MEDIUM, or LOW

• Last Update: The date of the last system status update

• Summary: A short summary of the fault that triggered creating 
the RAS ticket

• Show Tickets: Controls the type of tickets shown in the display 
window: OPEN, CLOSED, or ALL tickets

• Previous and Next: Click these buttons to toggle between ticket 
pages (if there is more than one page of tickets)

• Details: Click this button to view a selected ticket’s details

• Close All: Click this button to close all tickets shown in the 
display window
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• Refresh: Click this button to refresh the display window

2 Highlight the ticket you wish to view, and then click Details. The 
RAS Ticket Details screen appears.

Figure 241  RAS Ticket Details 
Screen

The RAS Ticket Details screen provides the following information:

• Ticket Number: The number of the ticket in the displayed ticket 
list
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• Opened: The date and time the ticket was created

• Status: The current status of the ticket: OPEN or CLOSED

• Priority: The ticket’s priority based on system impact: HIGH, 
MEDIUM, and LOW

• Summaries and Descriptions: Detailed information about the 
ticket, including a Recommended Actions link to help you correct 
the fault or condition

• Analysis: If desired, enter information about the fault or 
condition, such as a recommended action

• Apply Analysis: Click this button to save information entered in 
the Analysis field

• Close Ticket: Click this button after you have corrected the 
condition or fault

• Cancel: Click this button to close the RAS Ticket Details screen
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3 When you click the View Recommended Actions link on the RAS 
TIcket Details screen, the Recommended Actions screen appears. 
This screen provides information and steps to correct the condition or 
fault that generated the RAS ticket. Follow the instructions on the 
Recommended Actions screen to correct the condition or fault.

Figure 242  Recommended 
Actions Screen

4 Click the Close Window link at the bottom of the Recommended 
Actions screen.

5 Click the Close or Cancel button on the RAS Ticket Details screen.
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More information about this product is available on the Customer Service 
Center website at www.quantum.com/csc. The Customer Service Center 
contains a collection of information, including answers to frequently 
asked questions (FAQs). You can also access software, firmware, and 
drivers through this site. 

Quantum Technical Assistance Center

For further assistance, or if training is desired, contact the Quantum 
Technical Assistance Center: 

North America: 1+800-284-5101

UK, France and Germany: 00800 4 QUANTUM

EMEA: +44 1256 848 766

Worldwide Web: www.quantum.com/support

www.quantum.com/support
http://www.quantum.com/csc
http://www.adic.com/csc


Appendix A

AHA Failover

StorNext is designed to be a resilient data management solution. StorNext 
supports operation in degraded mode and provides functionality to 
guarantee data protection in the event of a storage device failure or total 
site outage. For certain environments though, additional protection is 
required to deliver a higher level of availability. To meet these demands, 
StorNext includes MetaData Controller (MDC) failover. 

MDC failover allows a secondary MDC to take over StorNext operations 
in the event a primary MDC fails. Failover is supported for all StorNext 
management operations including client IO requests (File System) and 
data mover operations (Storage Manager). MDCs in a failover pair 
typically run in an active / passive configuration, but both MDCs can be 
configured to run active File System processes. In the event one MDC 
fails, the other continues to perform its current operations, as well as 
those of the failed MDC.

Like all failover solutions, StorNext must provide functionality to prevent 
a damaged or inaccessible MDC from incorrectly processing IO requests 
that should be handled by the active MDC (often referred to as a “split 
brain” scenario). To handle this, StorNext utilizes a special failover 
methodology call STONITH - shoot the other node in the head. STONITH 

Note: Active / Active Storage Manager processes are not currently 
supported in MDC failover.
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shuts down a degraded MDC and then reboots it so that, on recovery, it 
becomes the standby MDC in the event future MDC failover is required.

While other methods of failover are available, such as quorums, 
STONITH is the only widely acknowledged method of reliable failover 
control - especially for software that runs on multiple operating systems. 
Without STONITH, there is the possibility that a damaged MDC could 
continue acting as the primary MDC and attempt to handle client IO 
requests or move data between storage tiers. For shared file systems 
STONITH is especially critical because a MDC controls access for 
multiple hosts reading and writing to a single volume - and potentially 
the same file.

Currently MDC failover is only supported when configured by Quantum 
Solutions Engineering staff.
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Appendix B

BUsing The Command Line
Interface

Quantum recommends using the GUI to complete most StorNext tasks, 
but there may be situations where you need to use the command line 
interface instead. This appendix describes how to use the command line 
interface for the following tasks:

• Labeling Disk Devices

• Modifying Global Settings

• Making a File System

• Starting and Stopping SNFS

• Unmounting or Mounting a File System

• Creating a File System Server

• Adding a File System Client

• Configuring a Stripe Group

• Adding an Affinity

• Creating a Disk-to-Disk Policy Class

• Enabling Stub File Support

• Managing Storage Disks with Deduplication Enabled

• Using the Dynamic Resource Allocation Feature
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Labeling Disk Devices
Labeling Disk Devices

Each drive used by SNFS must be labeled. A new drive only needs to be 
labeled one time. A drive can be labeled from any StorNext server or 
client that has a Fibre Channel (FC) connection to the drive. Use this 
procedure to label a disk device using CLI.

All output examples shown in this appendix differ from the actual 
output, but the structure and information provided is similar. 

1 On a SNFS client, at the system prompt, display a list of connected 
drives. Type: /usr/cvfs/bin/cvlabel -l

The command output is similar to this:

2 Looking at the output information, identify any drives that are 
unused or do not have a recognized Volume Type. For these drives, 
write down their associated device names.

3 Create /usr/cvfs/config/cvlabels by typing the following:

/usr/cvfs/bin/cvlabel -c > /usr/cvfs/config/cvlabels

Caution: The process of disk labeling re-partitions the drives. If you 
select an incorrect drive, you may lose data.

Also, it’s a good practice to save a copy of your labels file. 
If you lose labels (and you using a Linux or Windows 
system,) the Quantum Technical Assistance Center will 
need this copy to help you relabel your devices.
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Modifying Global Settings
The created file displays an entry for disks located by the /usr/cvfs/
bin/cvlabel command.

CvfsDisk_UNKNOWN /dev/sdb # host 4 lun 1 sectors 639570752 ...
CvfsDisk_UNKNOWN /dev/sdc # host 4 lun 2 sectors 639570752 ...
CvfsDisk_UNKNOWN /dev/sdd  # host 4 lun 3 sectors 639570752 ...

4 In the /usr/cvfs/config/cvlabels file, delete any lines that refer to disks 
that will not be labeled or have already been labeled.

5 Edit /usr/cvfs/config/cvlabels file to provide a unique name for each 
drive to be used by SNFS. 

In this example, the UNKNOWN variable in the drive name 
associated with disk device /dev/sdb has been renamed to a numeral 
(in sequence) 0,1,and 2. The disk devices have also been 
alphabetically ordered.

CvfsDisk0 /dev/sdb # host 4 lun 1 sectors 639570752 ...
CvfsDisk1 /dev/sdc # host 4 lun 2 sectors 639570752 ...
CvfsDisk2 /dev/sdd  # host 4 lun 3 sectors 639570752 ...

6 Save the /usr/cvfs/config/cvlabels file. 

7 Use the cvlabel command to label the disks. Type:

/usr/cvfs/bin/cvlabel /usr/cvfs/config/cvlabels

8 For each disk, you are prompted to verify that you want to label each 
disk. Type Y for yes.

Modifying Global Settings

The global section of the file system configuration file contains general 
parameters that control enabling and disabling features, system 
performance, and components related to the file system’s resource 
consumption. 

Caution: Identify any drives that already contain a 
recognized Volume Type. Do not write a label to 
these drives or you may lose data.
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Modifying Global Settings
For most of these parameters, the only thing necessary for the modified 
parameter to take effect is to restart the File System Manager (FSM). 
However, the following parameters require that the file system be fully 
re-initialized (which will result in data loss,) before they take effect:

• FSBlockSize

• WindowsSecurity

If a parameter change requires file system re-initialization, the system 
notifies the administrator in the system log. In order to reduce the 
number of file system remakes, be sure to plan the initial configuration of 
the FSBlockSize and WindowsSecurity parameters carefully. 

The global section also contains several parameters that can dramatically 
improve or degrade system performance. Exercise caution when 
modifying performance parameters. One key performance parameter is 
InodeCacheSize.

Before making any changes to the file system’s configuration, carefully 
review the cvfs_config(4) man pages or the “CVFS Configuration File” 
help file. 

Use this procedure to modify system global settings using CLI.

1 Unmount the file system by typing the following:

unmount <file_system_name>

Where the file system name is the name of the file system where the 
settings are being modified.

2 Stop the file system by typing the following:

/usr/cvfs/bin/cvadmin
snadmin> stop <file_system_name>
snadmin> quit

where snadmin is the prompt shown after invoking the cvadmin 
command.

3 Edit the configuration file by typing the following:

edit /usr/cvfs/config/<file_system_name>.cfg

Note: When the file system is down, file system operations will 
pause and some applications could fail. Plan accordingly 
to minimize disruptions. 
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Making a File System
4 Make the appropriate edits to the configuration file.

5 Restart the file system. Type:

/usr/cvfs/bin/cvadmin
snadmin> start <file_system_name>
snadmin> activate <file_system_name>
snadmin> select 
snadmin> quit

6 Mount the file system by typing the following:

mount -t cvfs <file_system_name> <mount_point>

For example: mount -t cvfs snfs1 /stornext/snfs1

Making a File System

Following are some reasons to make or re-make a file system:

• Creating a new file system

• Removing a stripe group from the file system

• Removing a disk from a stripe group

• Changing a stripe group's stripe breadth

• Changing the sector count of a disk

Use this procedure to make a file system using the CLI.

1 Log on to the machine as root.

Caution: Making or re-making a file system will result in a complete 
loss of user data.

After creating a relation point on a managed file system, 
you must delete and recreate the file system, not just 
remake. For information about deleting a file system, see 
Deleting a File System on page 89. For information about 
creating a file system, see Adding a File System on 
page 78.
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Starting and Stopping SNFS
2 Make sure you are the root user by typing the following:

cd /

3 Unmount the system by typing the following:

umount <mount_point>

where the <mount_point> is where you have mounted the SNFS. 

For example: umount /stornext/snfs1

4 Stop the system by typing the following:

/usr/cvfs/bin/cvadmin
snadmin> stop <file_system_name>

where the <file_system_name> is the name of the file system to be 
stopped.

5 Make the file system by typing the following:

/usr/cvfs/bin/cvmkfs <file_system_name>

6 Start the system by typing the following:

/usr/cvfs/bin/cvadmin
snadmin> start <file_system_name>

7 Mount the system by typing the following:

mount -t cvfs snfs1 /stornext/snfs1

Starting and Stopping SNFS

To start SNFS using the CLI, type the following:

/usr/cvfs/bin/cvadmin
snadmin> select
snadmin> start <file_system_name>
snadmin> activate <file_system_name>

where snadmin is the prompt shown after invoking the cvadmin 
command.

To stop SNFS using the CLI, type the following:
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Unmounting or Mounting a File System
/usr/cvfs/bin/cvadmin
snadmin> select
snadmin> stop <file_system_name>

Unmounting or Mounting a File System

To unmount a file system using the CLI, follow these steps:

1 Change the login user to root. Type:

cd /

2 Unmount the system. Type:

umount <mount_point>

where the <mount_point> is where you are mounting the SNFS. 

For example:

umount /stornext/snfs1

To mount a file system using the CLI, follow these steps:

1 Change the login user to root. Type:

cd /

2 Mount the system, type:

mount -t cvfs <file_system_name> <mount_point>

where the <mount_point> is where you are mounting the SNFS. 

For example:

mount -t cvfs snfs1 /stornext/snfs1
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Creating a File System Server
Creating a File System Server

The follow procedure describes how to create a file system server using 
the CLI. 

Before initially executing any SNFS command line programs, you are 
required to source either the .profile or the .cshrc file. This updates the 
user environment with the SNFS environment variables.

• If you are running sh, ksh, or bash, type:

. /usr/adic/.profile

• For all other shells, type:

source /usr/adic/.cshrc

1 Install StorNext as described in the StorNext Installation Guide. Follow 
the instructions that pertain to your operating system.

2 Create a list of system and FC disks by writing to a file in a format 
recognized by the cvlabel command. Type the following:

/usr/cvfs/bin/cvlabel -c > /usr/cvfs/config/cvlabels

The created file displays an entry for disk located by the /usr/cvfs/bin/
cvlabel command.

CvfsDisk_UNKNOWN /dev/sdb # host 4 lun 1 sectors 639570752 ...
CvfsDisk_UNKNOWN /dev/sdc # host 4 lun 2 sectors 639570752 ...
CvfsDisk_UNKNOWN /dev/sdd  # host 4 lun 3 sectors 639570752 ... 

3 Edit the cvlabels file that has a list of all system and FC disks visible 
on the machine. Edit the file to remove all the system disks and any 
FC disks you do not want labeled, as well as FC disks that are already 
labeled.

Caution: Do not attempt to perform the procedures in this section 
unless you have completed Quantum’s StorNext training 
and are confident you understand all procedures. (You 
may perform these procedures if Professional Services is 
assisting you.)
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Creating a File System Server
4 Label the FC drives by typing the following:

/usr/cvfs/bin/cvlabel /user/cvfs/config/cvlabels

5 Copy the example file system configuration file to the config 
directory by typing the following:

cp /usr/cvfs/examples/example.cfg /usr/cvfs/config/
<file_system_name>.cfg

6 Edit the StorNext configuration file you just created to include the 
desired settings, disks, and stripe groups.

7 Copy the fsnameservers file to the config directory by typing the 
following:

cp /usr/cvfs/examples/fsnameservers.example /usr/cvfs/config/
fsnameservers

8 Edit the fsnameservers file to include the host’s IP address.

9 Copy the example fsmlist file to the config directory by typing the 
following:

cp /usr/cvfs/examples/fsmlist.example /usr/cvfs/config/fsmlist

10 Edit the fsmlist file created in step 9 to include the name of file 
systems you want to start at boot time.

11 Obtain your license.dat from the Quantum Technical Assistance 
Center. For contact information, refer to Quantum Technical 
Assistance Center on page 319.

12 Place the license.dat file in the /usr/cvfs/config directory. 

13 Make the file system by typing the following:

/usr/cvfs/bin/cvmkfs <file_system_name>

14 Reboot the machine.

15 Verify that the labeled drives are available to the file system by 
typing the following:

/usr/cvfs/bin/cvlabel -l

Caution: When you run the cvmkfs command, you will lose 
any data currently on the file system.
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Adding a File System Client
16 Restart the file system. Type:

/usr/cvfs/bin/cvadmin
snadmin> start <file_system_name>
snadmin> activate <file_system_name>
snadmin> select <file_system_name>
snadmin> show
snadmin> who
snadmin> quit

17 Mount the system by typing the following:

mount -t cvfs <file_system_name> <mount_point>

For example: mount -t cvfs snfs1 /stornext/snfs1

Adding a File System Client

Use this procedure to add a file system client using the CLI.

1 Install StorNext as described in the StorNext Installation Guide. Follow 
the instructions that pertain to your operating system.

2 Copy the example fsnameservers file to the config directory by 
typing:

cp /usr/cvfs/examples/fsnameservers.example /usr/cvfs/config/
fsnameservers

3 Edit the /etc/fstab file to mount on boot (for Solaris, edit the /etc/
vfstab file).

4 Reboot the machine.

5 Verify that the system has mounted by typing the following:

df -k

If your machine did not mount on boot, refer to “Resolving 
Installation Problems” in the StorNext Installation Guide.

Caution: The fsnameservers file must be the same on all 
machines. 
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Configuring a Stripe Group
Configuring a Stripe Group

Following is an example of a stripe group configuration in a file system 
configuration file. You can use a text editor to modify any of these 
variables. The values shown might not be representative of typical 
definitions.

[StripeGroup StripeGroup1]
Status UP
Exclusive Yes
MetaData Yes
Journal Yes
Read Enabled
Write Enabled
StripeBreadth 16
MultiPathMethod Rotate
Node fortune1 0

[StripeGroup StripeGroup2]
Status UP
Affinity media1
Read Enabled
Write Enabled
StripeBreadth 16
Rtios 100
Rtmb 100
RtiosReserve 100
RtmbReserve 100
MultiPathMethod Rotate
Node fortune2 0

Caution: Modifying the following variables might result in a 
complete loss of user data and a re-make of the file system:

• Metadata

• StripeBreadth

• Removing a Node
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Adding an Affinity
Adding an Affinity

This procedure lets you set stripe group affinities for assigning file 
locations to a specific file system stripe group. All subsequent allocations 
to a file that have been assigned a valid stripe group affinity will occur on 
the specified stripe group.

Affinities may also be assigned to files and directories using the cvaffinity 
command. For more information about the cvaffinity command, refer to 
the CLI Reference Guide. 

1 Unmount the file system by typing the following:

umount <mount_point>

where the <mount_point> is where you have mounted the SNFS. 

For example: umount /stornext/snfs1

2 Use cvadmin to stop the file system by typing the following:

/usr/cvfs/bin/cvadmin
snadmin> stop <file_system_name>

(where the <file_system_name> is the file system to which the 
affinity will be added.)

snadmin> quit

3 Using a text editor, open the file system configuration file 
(<file_system_name>.cfg), where <file_system_name> is the name of 
the file system.
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Adding an Affinity
4 Locate the stripe group section and select the stripe group to which 
you want to add the affinity.

Following is part of a stripe group configuration with an affinity 
definition:

[StripeGroup StripeGroup2]
Status UP
Affinity aff1
Read Enabled
Write Enabled
StripeBreadth 16
Node disk2 0

StripeGroup StripeGroup3]
Status UP
Affinity aff2
Read Enabled
Write Enabled
StripeBreadth 16
Node disk3 0
Node disk4 1
Node disk5 2

If you create a directory association with Affinity aff1, all data written 
to that directory is written to StripeGroup StripeGroup2, and 
therefore only to Disk disk2. If you make an association with Affinity 
aff2 and a separate directory in the file system, all data is directed to 
StripeGroup StripeGroup3, which contains three disks: disk3, disk4, 
and disk5. All data is written to these disks when directed to the 
associated directory with Affinity aff2.

5 Add the affinity to the selected stripe group with a line entry in this 
format:

 Affinity <affinity_name>

where <affinity_name> is the name of the affinity

Following is an example of a stripe group configuration after an 
affinity was added. The affinity line is the flag for the Data1 stripe 
group.

[StripeGroup Data1]
Status UP
Read Enabled
Write Enabled
Affinity data1_aff
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Creating a Disk-to-Disk Policy Class
StripeBreadth 512
Node CvfsDisk2 0
Node CvfsDisk3 1

6 Save and close the configuration file.

7 Use cvadmin to start the file system by typing the following:

/usr/cvfs/bin/cvadmin
snadmin> start <file_system_name>
snadmin> activate <file_system_name>
snadmin> select <file_system_name>
snadmin> show

8 Mount the file system by typing the following:

mount -t cvfs <file_system_name> <mount_point>

For example: mount -t cvfs snfs1 /stornext/snfs1

9 Create an affinity/directory association by typing the following:

/usr/cvfs/bin/cvmkdir -k <affinity_name> <directory_name>

For example: /usr/cvfs/bin/cvmkdir -k data1_aff /stornext/snfs1/
video_data

This associates all data written to /stornext/snfs1/video_data with 
stripe group Data1 and, therefore, disks CvfsDisk2 and CvfsDisk3.

Creating a Disk-to-Disk Policy Class

Use this procedure to create a disk-to-disk-specific policy class. You must 
have at least two affinities configured to create a disk-to-disk policy class.

Before initially executing any StorNext command line programs, you are 
required to source either the .profile or the .cshrc file. This will update the 
user environment with the StorNext environment variables.

• If you are running sh, ksh, or bash, type:

. /usr/adic/.profile

• For all other shells, type:

source /usr/adic/.cshrc
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Creating a Disk-to-Disk Policy Class
Use the fsaddclass command to create a new policy class by typing the 
following:

/usr/adic/TSM/exec/fsaddclass <policy_class_name> -a 
<default_affinity> <destination_affinity> -i <relocation_time_in_days>

For example: /usr/adic/TSM/exec/fsaddclass dtdclass1 -a Aff1 Aff2 -i 1

The list of affinities includes the same affinities that were defined through 
the GUI. 

If you do not use the -i option (MinRelocTime), the default relocation 
time of seven days is used.

If only one affinity is listed with the -a option, no relocation occurs 
because a destination affinity is not defined. The first affinity listed after 
the -a option is the default affinity.

Modifying a Disk-to-Disk 
Policy Class 2

Use the fsmodclass command to modify an existing policy class by 
typing the following:

/usr/adic/TSM/exec/fsmodclass <policy_class_name> -a 
<default_affinity> <destination_affinity> -i <relocation_time_in_days>

For example: /usr/adic/TSM/exec/fsmodclass dtdclass1 -a Aff1 Aff2 -i 1

Manual Disk-to-Disk 
Relocation 2

Use the fsrelocate command to perform manual disk-to-disk migration. 
You can use this command to relocate a file from the current affinity to 
another affinity, provided it meets these criteria:

• The file must be a non-zero sized file

• The file cannot be truncated

• The file cannot be specifically excluded from relocation via the 
fschfiat command

For example:

/usr/adic/TSM/exec/fsrelocate /stornext/snfs1/data1/file1 -a Aff2

In the previous example, the file /stornext/snfs1/data1/file1 will be 
relocated to affinity Aff2. 
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Enabling Stub File Support
You can also use metacharacters when defining the file name parameter.

For example: 

/usr/adic/TSM/exec/fsrelocate -a Aff2 /stornext/snfs1/relocate/*

Enabling Stub File Support

The following file system commands have been enhanced to support 
StorNext’s Stub File feature: 

• fsaddclass

• fsmodclass

• fschfiat

• fschdiat

Specifically, a -S stubsize option has been added to each command. This 
option allows you to specify the desired file stub size in kilobytes.

The following example illustrates usage for each command:

• fsaddclass class -S 1000

• fsmodclass class -S 1000

• fschfiat -S 1000

Additionally, the following commands remain unchanged, but their 
output now includes the target stub size and actual stub size:

• fsclassinfo: Shows Stub File Size

• fsfileinfo: Shows Stub Size (target stub file size) and Stub Length 
(actual stub file size)
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Managing Storage Disks with Deduplication Enabled
Managing Storage Disks with Deduplication Enabled

Quantum recommends using the StorNext GUI to manage the storage 
disk deduplication feature, but you can use the CLI to add, modify, or 
delete storage disks with deduplication enabled (Dedup Sdisk).

Adding a Dedup Sdisk 2 The fsdiskcfg command now includes a -b option to indicate that the 
storage disk uses blockletized storage to store data. (Blocketized storage 
is how this feature accomplishes space savings.)

For example, you would enter the following command to create a storage 
disk with deduplication enabled:

Input: fsdiskcfg -a -p /apps -b sdisk1

Before you add a dedup storage disk, you can also use the fsdiskcfg 
command’s -b -l options to view a list of available locations where a 
dedup storage disk can be created. The correct syntax is fsdiskcfg -b -l.

(You can also use the fsdiskcfg command’s -l option (without the -b 
option) to view all available location where a standard storage disk can 
be created. The correct syntax is fsdiskcfg -l.)

Modifying a Dedup 
Sdisk 2

You can modify the location for the dedup sdisk, but the dedup sdisk 
must be blank and the new location must be under the same file system.

For example, this is how you would invoke the fsdiskcfg command for 
sdisk1, which was previously created under /apps:

Input: fsdiskcfg -m sdisk1 -p /apps/subdir

Deleting a Dedup Sdisk 2 You can delete a dedup sdisk by using the fsdiskcfg command’s -d 
option.

For example, this is how you would invoke the fsdiskcfg for sdisk1 that 
was previously created:

Input: fsdiskcfg -d sdisk1
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Obtaining Dedup Sdisk 
Information 2

You can obtain information for a dedup sdisk by running the fsmedinfo 
command on the dedup sdisk. 

For example, if you invoke the fsmedinfo command for a dedup sdisk 
named sdisk1, the output looks similar to this:

### fsmedinfo sdisk1

-------------------------------------------------------------------------------
 Media Information Report Tue Feb  6 13:17:32 2007
 Media ID:   ddisk(0)
 Media Type: DDISK
-------------------------------------------------------------------------------
Storage Area: VolSub
Class ID: <system blank> Bytes Used: 4,780,195,840
Last Accessed: 06-feb-2007 12:04:52 Space Remaining: 68,623,007,744
Media Status: AVAIL Percent Used: 6.51
Write Protect: N Suspect Count: 0
Mark Status: UNMARKED Mount Count: 0
Medium Location: SLOT/BIN                  
Formatted: Y
Number of Segments: 0                         
External Location: N/A
Total Blob Bytes: 0
Unique Blob Bytes: 0
Percent Eliminated: 0.00

FS0000 06 1703716962 fsmedinfo completed: Command Successful.

Note: The Space Remaining amount shown does not take into 
account the percentage of redundancy elimination; it shows 
only the physical space remaining on the disk.
StorNext User’s Guide 339



Obtaining Distributed LAN Client Information
Obtaining Distributed LAN Client Information

If your StorNext configuration includes distributed LAN clients, you can 
obtain information through three commands supported by the cvadmin 
command:

• proxy

• proxy long

• proxy who

The proxy Command 2 Use the proxy command to display information about the distributed 
LAN servers for the file system. In particular, the IP address and port 
number on which the distributed LAN server is listening is shown.

This command requires that a file system be selected.

Command usage and output looks similar to this:

snadmin (yy) > proxy
Disk Proxy Server 172.16.82.130 (pmport 49152, pmflags 0x0)
   Listening on 172.16.82.130 port 1036

The proxy long 
Command 2

Use the proxy long command to display the same information about 
distributed LAN servers included in the proxy command output, plus the 
tuning parameters for the distributed LAN server systems and a list of 
the disks available for distributed LAN usage.

This command requires that a file system be selected.

Command usage and output looks similar to this:

snadmin (yy) > proxy long
Disk Proxy Server 172.16.82.130 (pmport 49152, pmflags 0x0)
   Listening on 172.16.82.130 port 1036
     windowsize=1024K sbsize=256K sbcount=32
  CvfsDisk0 on device:PhysicalDrive1 sectors:156214012 sector size: 512
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The proxy who 
Command 2

Use the proxy who command to display the active disk distributed LAN 
connections for the specified host, which can be either a disk distributed 
LAN server or client. Output also includes average I/O statistics for each 
connection. The syntax for this command is proxy who hostname.

Command usage and output looks similar to this (both distributed LAN 
client and distributed LAN server output is shown):

snadmin (yy) > proxy who y
FS 'yy'
  Disk Proxy Client connection from 172.16.82.62
    Remote address 172.16.82.62 port 1052 flags 0x2
      Read 1.2 Mbytes/s, write 0.0 bytes/s

 
snadmin (yy) > proxy who fie
FS 'yy'
  Disk Proxy Server connection to 172.16.82.130
    Remote address 172.16.82.130 port 1036 flags 0x1
      Read 0.0 bytes/s, write 1.2 bytes/s

Using the Dynamic Resource Allocation Feature

Quantum recommends that you perform dynamic resource allocation 
using the StorNext GUI. However, if your operating system does not 
support using the GUI for this feature (or if you are operating in a failover 
environment,) you can accomplish the following tasks from the 
command line: 

• Adding a Stripe Group Without Moving

• Adding and Moving a Data Stripe Group

• Moving a Metadata/Journal Stripe Group
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Checking the File 
System 2 Before you use a Dynamic Resource Allocation feature, Quantum 

strongly recommends running the cvfsck command on the file system 
you will be using. This step could take a considerable amount of time to 
complete, but your file system should be in good condition before you 
attempt to expand it or move stripe groups.

Adding a Stripe Group 
Without Moving 2

Use the following procedure to expand the file system by adding a stripe 
group, and not migrating.

1 Label disks for the new stripe groups you want to add to the file 
system.

2 If your StorNext configuration includes a failover environment, you 
must first shut down any standby FSMs that would start when you 
shut down the primary FSM. The movement procedure will not 
complete successfully unless all FSMs are shut down.

3 (Optional) Run the cvfsck command on the file system. See Checking 
the File System.

4 Add the new stripe groups to the file system.

5 Stop the File System Manager (FSM).

Caution: When you add a new disk or stripe group to your SAN, 
often an OS-dependent operation must be run to make the 
added device recognizable by a host. Some of these 
utilities can disrupt access to existing disks, causing access 
hangs or failures. To avoid this, stop all file system 
operations on the affected host before rescanning for the 
new device.

Caution: If you do not run the cvfsck command to check your file 
system before attempting file system expansion, 
irreparable file system damage could occur. 

Caution: If you do not shut down standby FSMs, file 
system corruption or data loss could occur.
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6 Run the cvupdatefs command. 

7 Restart the FSM.

Adding and Moving a 
Data Stripe Group 2

New functionality has been added to the snfsdefrag utility to support 
operations on multiple stripe groups.

Use the following procedure to add new stripe groups, and then move 
data off of the old stripe group.

1 Label disks for the new stripe groups you want to add to the file 
system.

2 If your StorNext configuration includes a failover environment, you 
must first shut down any standby FSMs that would start when you 
shut down the primary FSM. The move procedure will not complete 
successfully unless all FSMs are shut down.

3 (Optional) Run the cvfsck command on the file system. See Checking 
the File System.

4 Add the new stripe groups to the file system configuration and mark 
the old stripe groups as read-only. (Make sure the old stripe group is 
write disabled.)

5 Stop the File System Manager (FSM) for the desired file system.

6 Run cvupdatefs. 

7 Restart the FSM.

Note: During Stripe Group Movement, affinities are preserved when 
files are moved from one stripe group to another. When you 
create a new stripe group to use with the Stripe Group 
Movement feature, the new stripe group must include 
sufficient space for its affinities. (You must add any affinities 
from the source stripe group to the new stripe group.)

Caution: If you do not shut down standby FSMs, file 
system corruption or data loss could occur.
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8 Run snfsdefrag -G <n> -m 0 -r /filesystemroot

where <n> is the zero-based number of the source stripe group from 
which the move starts, and filesystemroot is the file name of the file 
system tree’s root. You can specify multiple -G options to use 
multiple source stripe groups.

9 Verify that no data remains on the original stripe groups.

10 Edit the file system configuration to mark the old stripe groups as 
“Down.”

11 Stop the FSM.

12 Restart the FSM.

Moving a Metadata/
Journal Stripe Group 2

Metadata movement is performed on a LUN level, meaning you must 
specify the source LUN and the destination LUN. The new sndiskmove 
command that accomplishes metadata movement has two arguments: a 
source and destination LUN. 

After movement is complete, the physical source disk can be removed.

Note: The old stripe groups marked “Down/Readonly” must be 
left in the file system configuration file.

Note: Although a stripe group can consist of multiple disks or LUNs, 
the sndiskmove command moves only a single disk or LUN. 
Consequently, references to “stripe group” in this section refer 
to a single disk or LUN when migrating metadata with 
sndiskmove.
StorNext User’s Guide 344



Using the Dynamic Resource Allocation Feature
Use the following procedure to move a metadata/journal stripe group 
from a source LUN to a destination LUN.

1 Stop the File System Manager (FSM) for the file system.

2 If your StorNext configuration includes a failover environment, you 
must shut down any standby FSMs that would start when you shut 
down the primary FSM. The movement procedure will not complete 
successfully unless all FSMs are shut down.

3 (Optional) Run the cvfsck command on the file system. See Checking 
the File System.

4 Run sndiskmove <source-LUN-label-name> <destination-LUN-label-
name>

where <source-LUN-label-name> is the source stripe group from 
which the move starts, and destination-LUN-label-name is the 
destination stripe group to which you want to move data.

During the move process StorNext appends “.old” to the source 
stripe group name. This is to avoid confusion because the destination 
stripe group is given the same name as the original stripe group. Both 
stripe group names remain in the configuration file.

Caution: The metadata/journal stripe group you want to move 
cannot contain data. 

Sndiskmove treats metadata and journal stripe groups the 
same way, so it doesn’t matter whether the stripe group 
you want to move is a metadata stripe group, a journal 
stripe group, or a combined metadata and journal stripe 
group. The only caveat is that stripe groups used for 
movement cannot contain data.

If you attempt to move a metadata/journal stripe group 
that contains data, data loss could occur.

Caution: If you do not shut down standby FSMs, file 
system corruption or data loss could occur.
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For example:

source-LUN-label-name (the original stripe group name) becomes 
source-LUN-label-name.old

destination-LUN-label-name (the new stripe group name) becomes 
source-LUN-label-name (the same name as the original stripe group)

5 Only if your system includes a standby FSM: After you run 
sndiskmove, rescan the disks on the standby FSM’s host by running 
cvadmin -e ‘disks refresh’. You must run cvadmin -e ‘disks refresh’ on 
all systems on which you have a configured FSM for the file system 
involved in the move.

6 Restart the FSM.

7 Only if your system includes a standby FSM: Restart the standby 
FSM.

Note: When you run sndiskmove, it could take a considerable 
amount of time to copy the data between disks, depending 
on disk size and performance.
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Appendix C

CRAS Messages

RAS messages appear when StorNext encounters an error condition. The 
RAS window shows symptoms of the condition, plus workarounds you 
can try to resolve the condition before calling the Quantum Technical 
Assistance Center.

This appendix shows the different RAS messages you might see. 
Messages are separated into the following categories:

• Media and Drive RAS Messages

• SNFS RAS Messages

• Other RAS Messages

Media and Drive RAS Messages

This section describes RAS messages that might appear as a result of a 
media-related error condition, such as no media detected or media 
format failure.
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Media and Drive RAS Messages
Figure 1  No Media Found RAS
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Media and Drive RAS Messages
Figure 2  Possible Drive/Media 
Mount Discrepancy RAS
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Media and Drive RAS Messages
Figure 3  Tape Drive Alerts RAS 
part 1
StorNext User’s Guide 350



Media and Drive RAS Messages
Figure 4  Tape Drive Alerts RAS 
part 2
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Media and Drive RAS Messages
Figure 5  Tape Drive Alerts RAS 
part 3
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Media and Drive RAS Messages
Figure 6  Drive Reported Drive 
Error RAS
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Media and Drive RAS Messages
Figure 7  Cleaning of Drive 
Failed RAS

Figure 8  Wrong Firmware 
Level/Invalid Drive Type RAS
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Media and Drive RAS Messages
Figure 9  Drive Removed RAS

Figure 10  Tape Drive -
Configuration Failed RAS
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Media and Drive RAS Messages
Figure 11  Tape Drive - 
Reported Media Error RAS

Figure 12  Cleaning Media 
Expired RAS
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Media and Drive RAS Messages
Figure 13  No Cleaning Media 
Available RAS

Figure 14  Media Suspect 
Threshold Count Exceeded 
RAS
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Media and Drive RAS Messages
Figure 15  Media Format 
Failure RAS
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Media and Drive RAS Messages
Figure 16  Invalid Media Label 
Detected RAS
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Media and Drive RAS Messages
Figure 17  Media Not Found 
RAS

Figure 18  Duplicate Physical 
Media Found RAS
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SNFS RAS Messages
Figure 19  Storage Disk Taken 
Offline RAS

SNFS RAS Messages

This section describes RAS messages that might appear as a result of a file 
system-related error condition, such as an I/O error or a missing LUN.
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SNFS RAS Messages
Figure 20  Configuration Not 
Supported RAS

Figure 21  Label Validation 
Failure RAS
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SNFS RAS Messages
Figure 22  Connection Rejected 
RAS

Figure 23  File System Failover 
RAS
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SNFS RAS Messages
Figure 24  I/O Error RAS

Figure 25  Journaling Error 
Detected RAS
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SNFS RAS Messages
Figure 26  SNFS License 
Required RAS

Figure 27  SNFS License 
Failure RAS
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SNFS RAS Messages
Figure 28  LUN Mapping 
Changed RAS

Figure 29  Communication 
Failure RAS
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SNFS RAS Messages
Figure 30  Metadata 
Inconsistency Detected RAS

Figure 31  Bad File System 
Metadata Dump RAS
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SNFS RAS Messages
Figure 32  Metadata Dump 
Failure RAS

Figure 33  File Processing 
Failure RAS
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SNFS RAS Messages
Figure 34  Missing LUNs RAS

Figure 35  Disk Space 
Allocation Failure RAS
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SNFS RAS Messages
Figure 36  System Resource 
Failure RAS

Figure 37  Shutdown Error RAS
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Other RAS Messages
Figure 38  Initialization Failure 
RAS

Other RAS Messages

This section describes RAS messages that might appear as a result of an 
error condition that is not related to media or the file system.
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Other RAS Messages
Figure 39  Checksum Error 
RAS
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Other RAS Messages
Figure 40  Troubleshooting the 
StorNext Software RAS
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Other RAS Messages
Figure 41  Closing Service 
Tickets RAS
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Other RAS Messages
Figure 42  Analyzing Service 
Tickets RAS
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Other RAS Messages
Figure 43  Viewing Service 
Tickets RAS

Figure 44  Vault Failure RAS
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Other RAS Messages
Figure 45  Robotics - Not 
Ready RAS
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Other RAS Messages
Figure 46  Robotics - Move 
Failure RAS
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Other RAS Messages
Figure 47  Robotics - Wrong 
Firmware Level/Invalid Library 
Type RAS
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Other RAS Messages
Figure 48  Backup Failed RAS
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Other RAS Messages
Figure 49  Backup Errors RAS
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Other RAS Messages
Figure 50  Configuration 
Violations RAS
StorNext User’s Guide 382



Other RAS Messages
Figure 51  Invalid Configuration 
RAS

Figure 52  Downloading a 
System State Capture RAS
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Other RAS Messages
Figure 53  Capturing a System 
State RAS
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Glossary

A Affinity   : An association between a relation point in the file system and a 
stripe group. It allows the user to direct data to specific primary 
disks by writing to the affinities associated relation point.

C Clean Media    The operation of logically removing old file versions from a 
piece of media. This is a database    operation that removes 
knowledge of managed files that have been updated or removed. 
A piece of media that contains nothing but removed files will not 
be considered blank until it is cleaned.

Configuration Wizard   A tool for setting up a basic environment for the 
management of data, both on disk and on removable media (tape 
or disk). It appears the first time the administrator connects to the 
browser after installing StorNext.

D Data Storage Manager (DSM)   One of several components that make up 
StorNext. The DSM corresponds to the StorNext File System.

Drive Pool   A grouping of drives for use in storing and retrieving data.

F Fibre Channel (FC)   A high speed data transfer architecture. 

File Transfer Protocol (FTP)   The protocol used on the Internet for 
sending files.
StorNext User’s Guide 385



  
G GUI   Graphical User Interface.

M Managed Directory   A directory that has a policy class 
relationship.

Managed File System   A file system that enables automatic data 
movement managed by StorNext Storage Manager 
between the primary disk and secondary storage (either 
disk or tape).

MediaClass   A grouping of media used for storing or retrieving 
data.

Media Storage Manager (MSM)   The Media Storage Manager is 
responsible for controlling media and archives.

Metadata Server   The system hosting the SNFS and SNSM server 
installation and processes.

P PolicyClass   A set of rules and criteria set up by SNSM  that 
control the movement of data between primary disk to 
secondary storage (either disk or tape).

Q Quantum Technical Assistance Center   The Quantum customer 
help desk.

Quota   This variable enables or disables the enforcement of the 
file system quotas.

R Recover   The process of bringing back to disk a managed file that 
was previously removed from the disk. This can only be 
done if the file had been successfully stored to media. 
Also, the file cannot not exist in the Trash can. (See 
Undelete) File recovery can be done regardless of 
whether the Trash can is enabled, up until the time the 
containing media is cleaned.

Relation Point/Relations   A mapping of a policy class to a 
directory in a managed file system.

Relocation   The process of moving a file from one affinity on a 
file system to another affinity on that file system.

Restore   The process of replacing a file system's contents after 
some sort of disaster. Also known as disaster recovery.
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Retrieve   The process of retrieving data for a file from secondary storage 
(either disk or tape).

RHAS   Red Hat Advanced Server

RHEL   Red Hat Enterprise Linux

S SCSI   Small Computer System Interface. The interface that is used to 
talk to most hardware devices such as tape and libraries.

StorNext   A scalable, high performance, data management solution that 
ensures the long-term safety and recoverability of data in SAN 
environments, while optimizing the use of storage resources. It 
consists of two components, the StorNext Storage Manager 
(SNSM) and the StorNext File System (SNFS).

Storage Area Network (SAN)   A SAN is a dedicated, high-performance 
network whose primary purpose is the transfer of data along FC 
or high-speed Ethernet connections between servers, 
interconnect devices, and storage peripherals.

StorNext File System (SNFS)   One of the two components that make up 
StorNext. SNFS is primarily used to provide Fibre Channel 
connections (but supports other types of connections) in a 
serverless environment which enables clients to access data and 
share files.

StorNext Storage Manager (SNSM)   One of several components that make 
up StorNext. SNSM combines the functionality of two products, 
TSM and MSM to provide high-performance file migration and 
management services, and to manage automated and manual 
media libraries, including library volumes.

Store   The process of copying data for a file to secondary storage (either 
disk or tape).

Stripe Group   A set of similar storage devices that can be maintained as a 
group.

T Tertiary Storage Manager (TSM)   The Tertiary Storage Manager is 
responsible for policy management and controlling data 
movement between primary disk and secondary storage (either 
disk or tape). 

Truncation   The process of freeing date blocks stored to secondary 
storage (either disk or tape). The file name remains visible in the 
file system.
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U Undelete   The process of returning a file from the Trash can to its 
original location on disk. This can      be done only if the 
Trash can is enabled.

Unmanaged File System   A file system that does not have archive 
capability controlled by SNSM.
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